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Zum Geleit

Texterkennung oder auch Optische Zeichenerkennung (OCR) ist ein zentrales Thema der Wissensge-
sellschaft am Beginn des 21. Jahrhunderts. Die Image-Digitalisierung macht heute schon Bücher jeder-
zeit, überall und in kürzester Zeit verfügbar, doch erst über durchsuchbare Volltexte potenzieren sich die 
Möglichkeiten wissenschaftlichen Erkenntnisgewinns.
 Bibliotheken mit bedeutenden historischen Beständen können hier entscheidend zum Entstehen ent-
sprechender virtueller Forschungsumgebungen beitragen. Die Staatsbibliothek zu Berlin – Preußischer 
Kulturbesitz spielt bereits seit Jahren eine wesentliche Rolle beim Auf- und Ausbau der nationalbiblio-
graphischen Verzeichnisse der deutschen Drucke des 16. bis 18. Jahrhunderts (VD16, VD17 und VD18). 
Die Digitalisierung dieser Werke wird über zahlreiche, meist von der Abteilung Historische Drucke 
betreute Projekte entscheidend vorangetrieben. Die Staatsbibliothek setzt den Fokus in besonderem 
Maße auf die Erschließung der Images etwa durch eine tiefgehende Strukturdatenerfassung. Seit einigen 
Jahren engagiert sich die Staatsbibliothek für Einrichtung und Aufbau von Virtuellen Bibliotheken bzw. 
Portalen wie Europeana.eu, das Zentrale Verzeichnis Digitalisierter Drucke oder die World Digital Lib-
rary. Der Präsident der Stiftung Preußischer Kulturbesitz ist Vorstandssprecher der Deutschen Digitalen 
Bibliothek, die 30.000 deutsche Kultur- und Wissenschaftseinrichtungen vernetzen und das nationale 
Kulturerbe über eine gemeinsame Plattform öffentlich zugänglich machen soll.
 Die Staatsbibliothek sieht eine wesentliche Zukunftsaufgabe in der Weiterentwicklung des Ange-
bots digitalisierter Sammlungen hin zu Volltextbibliotheken. Die vorliegende Studie präsentiert die 
Ergebnisse eines zwölfmonatigen Pilotprojekts zur Evaluierung unterschiedlicher Software-Lösungen 
für Fraktur-OCR. Ich freue mich sehr, dass die Deutsche Forschungsgemeinschaft mit ihrer Förderung 
dieses innovative Projekt ermöglicht hat.
 So konnte eine für Software-Anbieter eher periphäre, für die deutschsprachigen Drucke der Frühen 
Neuzeit aber entscheidende Problemstellung in einem intensiven Testprozess analysiert und Möglich-
keiten und Grenzen der OCR-Anwendung bei diesem Material ausgelotet werden. Als Testbestand wur-
de eine vom 16. bis 18. Jahrhundert im protestantischen Bereich massenhaft verbreitete Quellengattung 
ausgewählt, die von den unterschiedlichsten historisch orientierten Disziplinen intensiv beforscht wird 
und als serielle Quelle besonders hohes Potenzial für eine Volltexterschließung aufweist: Die Staats-
bibliothek besitzt eine der umfangreichsten Sammlungen von Funeralschriften (Leichenpredigten und 
andere Trauerschriften), aus der im Projekt ein kleines Testsample mit OCR erschlossen wurde.
 Die Ergebnisse der von der Abteilung Historische Drucke in Zusammenarbeit mit zwei Software-
Anbietern durchgeführten komplexen Testverfahren können nun präsentiert werden. Chancen, Heraus-
forderungen und Aufwände einer gattungsspezifischen OCR-Konversion des anspruchsvollen Materials 
werden umrissen. Erfreulicherweise wird die Publikation durch einen Beitrag von Thomas Stäcker er-
gänzt, der die einschlägigen Projekterfahrungen aus der Herzog August Bibliothek Wolfenbüttel in die 
Studie einbringt. Ich hoffe, dass der so entstandene umfassende Praxisbericht eine wesentliche Hilfe-
stellung bei der Etablierung und Weiterentwicklung automatischer Texterkennungsverfahren für Frak-
turschriften geben kann.

Karl Werner Finger
Ständiger Stellvertreter der Generaldirektorin der Staatsbibliothek zu Berlin PK
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1  http://staatsbibliothek-berlin.de/die-staatsbibliothek/abteilungen/historische-drucke/sammlungen/bestaende/personale-gelegenheitsschriften/ [Stand: 02/2013] 
2  http://staatsbibliothek-berlin.de/die-staatsbibliothek/abteilungen/historische-drucke/aufgaben-profil/projekte/funeralschriften/ [Stand: 02/2013]
3  http://bit.dyndns.biz/ [Stand: 02/2013]
4  http://www.hk-gap.de/ [Stand: 02/2013]
5  http://www.personalschriften.de/datenbanken/thelo.html [Stand: 02/2013]
6  http://www.personalschriften.de/datenbanken/thepro.html [Stand: 02/2013]
7  http://wiki-de.genealogy.net/Kategorie:Krankheitsbezeichnung [Stand: 02/2013]
8  http://www.slideshare.net/mdz-bsb/digitalisierungspraxis-federbusch-ocrpraxistest [Stand: 02/2013] und http://mdzblog.wordpress.com/ [Stand: 02/2013]

1 Einführung
1.1 Projekthintergrund

Seit mehreren Jahren ist die Staatsbibliothek zu Berlin – Preußischer Kulturbesitz (SBB PK) bestrebt, 
ihre herausragende und überregional bedeutende Funeralschriftensammlung1 zu digitalisieren. Über 
eine Imagedigitalisierung hinausgehend sollen auch Volltexte entstehen. Daher wurde 2008 das Pilot-
projekt zum OCR-Einsatz bei der Digitalisierung der Funeralschriften der Staatsbibliothek zu Berlin2 
konzipiert. Im folgenden Jahr sagte die Deutsche Forschungsgemeinschaft eine Förderung für die Dauer 
von 12 Monaten zu. Von Oktober 2010 bis September 2011 setzte eine Projektkraft in der Abteilung 
Historische Drucke dieses Vorhaben um. Ziel war es, die Volltexterfassung mittels optischer Zeichener-
kennung (OCR) an bis zu 2.000 Drucken (maximal 50.000 Seiten) aus dem Bestand der Staatsbibliothek 
zu testen. Diese Anzahl Funeralschriften berücksichtigt einen Ausschnitt aus der mit ca. 15.000 Drucken 
weltweit zweitgrößten Sammlung ihrer Art. Projektinhalt bildeten Testszenarien für zwei grundlegend 
verschiedene Softwarelösungen. Die Produkte wurden auf OCR-Erkennungsqualität sowie Konfigura-
tions- und Optimierungsmöglichkeiten hin untersucht und verglichen. Die Umsetzung einzelner Aufga-
ben erfolgte dabei arbeitsteilig mit den Dienstleistern (zugleich auch Software-Entwicklern). Zur Hand-
habung der Software bestand mit diesen ein kontinuierlicher Informationsaustausch. 

Im Pilotprojekt wurden folgende zwei OCR-Produkte getestet: 

– B.I.T. Bureau Ingénieur Tomasi SARL Toulouse3 – Software: BIT-Alpha
–  Herrmann & Kraemer GmbH und Co-KG Garmisch-Partenkirchen4 – Software: HK-OCR auf 

Basis der ABBYY FineReader Engine 9. 
      
Durch die inhaltliche Ausrichtung des Materials auf Funeralschriften sowie die daraus resultierenden re-
gionalen und zeitlichen Schwerpunkte ergaben sich zudem gattungsspezifische Optimierungsmöglich-
keiten, handelt es sich doch überwiegend um Drucke des 17. und beginnenden 18. Jahrhunderts aus dem 
mitteldeutschen Raum. Beispielhaft entstand eine Wortliste, die Begriffe versammelt, welche häufig in 
Funeralschriften benutzt werden. Darüber hinaus integriert diese Wortbibliothek auch die Thesauri der 
Forschungsstelle für Personalschriften Marburg (THELO5 und THEPRO6) sowie eine Liste historischer 
Krankheitsbezeichnungen des Vereins für Computergenealogie7.
 Im Projekt wurden Möglichkeiten zur automatisierten Volltexterfassung größerer Funeralschriftenbe-
stände getestet. Speziell für die weitere Digitalisierung der Funeralschriften der Staatsbibliothek konn-
ten Erkenntnisse für ein Vorgehen in der Bibliothek selbst gewonnen werden.8 Weitere Etappen auf dem 
Weg zu einer vollständigen digitalen Funeralschriftensammlung werden planbar. Eine Übertragbarkeit 
der Ergebnisse auf zukünftige Massendigitalisierungsprojekte aus dem Bereich der frühneuzeitlichen 
Drucke wird angestrebt.
 Der vorliegende Werkstattbericht schildert sowohl die Ausgangslage, den methodischen Ansatz und 
die Ergebnisse des Softwarevergleichs als auch die erreichte OCR-Optimierung anhand des Beispielma-
terials. Im Einzelnen werden neben Aussagen zur Erkennungsqualität Einschätzungen zur Binarisierung 
(Bildvorbearbeitung und Wandlung in Schwarz/Weiß) und zur Bild-, Wort- und Zeichensegmentierung 
getroffen. Zusätzlich bewertet werden die Nutzung von Zeichen- und Wortbibliotheken sowie vorhan-
dene Trainings- und Validierungsmöglichkeiten. Die Dokumentation der gewählten Parameter und Ein-
stellungen eröffnet Bibliotheken die Möglichkeit der späteren Weiterverwendung von Projektergebnissen. 
 Die Beschreibung von Nutzungsszenarien der untersuchten Softwareprodukte zeigt potentiellen An-
wendern sowohl die Möglichkeiten als auch die generellen Probleme der OCR-Prozesse und des Ma-
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terials selbst. Als wesentliches Projektergebnis ist die Abhängigkeit der Softwarebeurteilung von den 
jeweiligen Anwendungsszenarien zu nennen. Je nach Zielstellung wird eines der beiden Softwarepro-
dukte günstiger erscheinen. Die vorliegende vergleichende Darstellung einzelner Funktionen und Ein-
satzmöglichkeiten soll Interessenten dabei unterstützen, sachbezogen den Einsatz von OCR-Software 
zu planen. Auch wenn die Defizite in der OCR-Erkennungsqualität gegenüber Drucken des 19. Jahrhun-
derts unbestritten sind, ist es möglich, auch die OCR-Konversion ausgewählter frühneuzeitlicher Texte 
sinnvoll durchzuführen und zu optimieren.
 Auch mittels OCR-Konversion entstandene Volltexte eröffnen zusätzliche Suchmöglichkeiten in di-
gitalen Daten. Damit geht die Funktionalität von Digitalisaten über das bloße Lesen der Texte hinaus. 
Stäcker erläutert in seinem Beitrag in Kap. 8.6 ff die verschiedenen Vorstellungen über ausreichende 
Textgenauigkeiten und die daraus resultierenden Nutzungsmöglichkeiten. Neben der direkten Einbin-
dung der entstandenen OCR-Daten bietet sich sowohl die manuelle nutzerseitige Korrektur als auch 
Verbesserung durch nachgelagerte halbautomatische Prozesse (z. B. hinsichtlich der Layouterkennung) 
sowie semantische Auszeichnung an.

     
1.2 Hilfsthesen 

Um die Softwareprodukte nicht nur aufeinander zu beziehen, sondern sie auch ins Umfeld weitergehen-
der Anwender-Erwartungen einzuordnen, wurde während der Projektarbeit von folgenden Annahmen 
ausgegangen:

–  Wesentliche Verarbeitungsschritte der optischen Zeichenerkennung sind auch im bestmögli-
chen Fall regelmäßig von Informationsverlust betroffen. Ein praxisorientierter Ansatz wird sich 
zweckmäßigerweise auf die Betrachtung derjenigen Fehlerquellen konzentrieren, die gegenwärtig 
praktikabel behandelbar oder wenigstens aussichtsreich problematisierbar sind. Dennoch kann es 
während des Softwarevergleichs sinnvoll sein, auch auf Selbstverständlichkeiten wie vorläufig 
hinzunehmende Informationsverluste hinzuweisen und die jeweiligen Lösungsangebote hiernach 
einzuordnen.

–  Erkennungsfehlern (systematischen wie unsystematischen) wird auf zwei prinzipiell unter-
schiedliche Arten begegnet: (a) durch Vorkehrungen zu ihrer Vermeidung und (b) durch nach-
trägliche Korrektur, d. h. Akzeptanz des Fehlers bei Aussicht auf Kompensation. Unabhängig 
davon, wann dieser Unterschied praxisrelevant ist oder nicht, ist es sinnvoll, die betrachteten 
Softwaremerkmale und Lösungsstrategien jeweils einem dieser Typen zuzuordnen. 

–  In manchen Anwendungsfällen sind Informationsverluste einiger Verarbeitungsstufen unschäd-
lich. Auch wenn sich Anwender in der Praxis dessen bewusst sind und gerade hierauf setzen, 
kann eine systematische Nennung der Bedingungen, unter denen Informationsverluste harmlos 
werden können, die Planung von OCR-Vorhaben unterstützen.

–  Auch wenn beide Hersteller ihre Software als integrierte Gesamt-OCR-Lösung konzipiert haben 
und sie primär sogar in eigener Regie als Dienstleister nutzen, könnten Teilschritte identifiziert 
werden, deren Ein- oder Ausgaben eine modularisierte Verwendung nahelegen, z. B. um ein Pro-
dukt speziell nur im Bereich seiner Stärken einzusetzen. Hierauf hinzuweisen lohnt sich auch 
dann, wenn die Import- bzw. Exportschnittstellen in der betrachteten Software noch nicht reali-
siert sind.
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–  Wenn aus Ressourcengründen für Massen-OCR meist allein eine vollautomatische Volltext-
gewinnung ohne manuelle Eingriffe als akzeptabel gesehen wird, wird dabei ein Verlust an 
menschlicher, bei manueller Erfassung intuitiv stets eingehender Objektwahrnehmung in Kauf 
genommen bzw. im besten Fall durch Korrekturverfahren kompensiert. Wenn es gelänge, durch 
Echtzeit-Evaluation von Teilschritt-Ergebnissen wenige effektive Eingriffspunkte für mensch-
liche Justierungen zu erkennen und dafür eine Bedienoberfläche komfortabel auf sehr schnelle 
Eingriffe zu optimieren, dann könnte der bisher vorherrschende Einwand eines ökonomisch 
nicht tragbaren Zeitaufwands hierfür zumindest relativiert werden. Neben der Erkennungsgüte 
könnte dies die Baustelle sein, an der OCR-Arbeitsumgebungen sich in der nächsten Zeit vor-
rangig bewähren müssen. 

  
    
1.3 kurzfassung der Ergebnisse 

Beide Programme bedienen einen ungeteilten Gesamt-OCR-Prozess von Bild-Binarisierung bis zur 
Wortkorrektur und sind im Prinzip für eine auf alte deutschsprachige Drucke abgestimmte Stapelverar-
beitung durch Anwender geeignet. Unabhängig davon bieten beide Hersteller die OCR auch als Dienst-
leistung an. 
 Markant unterscheiden sich beide Softwareprodukte dadurch, dass BIT-Alpha eine Vielfalt detail-
lierter Konfigurationsmöglichkeiten bereitstellt, HK-OCR sich dagegen wegen der eingekapselten 
FineReader-Engine, die viele feste Voreinstellungen mitbringt, auf wenige Konfigurationsmöglichkei-
ten beschränkt. Es wurde gezeigt, dass folgende Möglichkeiten zur anwenderseitigen Optimierung der 
OCR-Erkennungsgüte bestehen:
      

– Effekt von Binarisierungsoptionen: Eine vorlagenspezifische Optimierung der Binarisie-
rungs-  und Segmentierungsparameter kann die OCR-Ergebnisse deutlich verbessern (nur BIT-
Alpha;  HK-OCR ist hier nicht konfigurierbar). 

     
– Effekt von Vorsortierung des Materials und Training eigener Muster: Bei nach Schriftähn-

lichkeit vorsortierten Teilbeständen von Leichenpredigten weniger Druckorte und Jahrzehnte 
des 17. Jahrhunderts war ein Training speziell hierzu passender Muster sinnvoll und erbrachte 
deutlich bessere Ergebnisse als eine OCR mit allgemeinen Fraktur-Mustern.   
   

–  Effekt geeigneter Wörterbücher: Auf die Vorlage abgestimmte Lexika (gattungs- und zeitspe-
zifische Wortformen, angereichert durch passende Titel- und Personendaten aus dem Verbund-
katalog) erhöhen die Erkennungsgüte deutlich, wenn auch aufgrund verschiedener Mechanis-
men (in BIT-Alpha durch Nachkorrektur, in HK-OCR integriert in die Zeichenerkennung).

Für auf Seitenebene mehr oder weniger homogene Schriftbilder sind diese deutlichen Steigerungsef fekte 
unmittelbar nutzbar (beide Programme). Für den häufigen Fall von Seiten ohne einheitliche Schriftart 
(Wechsel von Fraktur zu Antiqua, Wechsel von Sprachen, starke Größenunterschiede) ist gegenwärtig 
keines der beiden Produkte in der Lage, die Stärken einer selektiven Musterzuweisung auch auf Teil-
regionen von Seiten anzuwenden. Eine Kombination separat trainierter Musterbestände ist in BIT-Al-
pha (bzw. dem Mustereditor BIT-Knowledge) begrenzt, in HK-OCR/FineReader bisher nicht möglich; 
HK-OCR bietet stattdessen die Wahl, eine Anwendermustermenge mit den vorgegebenen FineReader-
Mustern zu kombinieren. Analog muss zur lexikalischen Korrektur für jeden Batchlauf ein Wörterbuch 
bzw. eine Sprachengruppe (so der Begriff in der HK-OCR-Oberfläche) festgelegt werden; sprachlich 
gemischte Seiten oder Seitenstapel zwingen daher zur Verwendung eines entsprechend kombinierten 
Wörterbuchs mit den damit verbundenen Kompromissen in der Korrektursicherheit.
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Der Export erfolgt jeweils mindestens in mit Textkoordinaten angereicherten XML-Formaten (BIT-Al-
pha: ALTO, HK-OCR: FineReader-XML) sowie einigen anderen Formaten (BIT-Alpha: PDF, HTML, 
Text; HK-OCR: PDF, RTF und ein gegenüber dem einzelzeichenorientierten FineReader-XML deutlich 
verschlanktes, wortorientiertes XML). Bisher von keinem der beiden Programme geleistet wird eine 
echte Strukturerkennung (angefragt waren formal gliedernde Elemente z. B. Kolumnentitel, Kustoden, 
Bogensignaturen u. a.) oder die Auszeichnung von Named Entities (Personen, Orte, Berufe, Krankhei-
ten) aufgrund vorgegebener Listen oder von Datumsangaben, Bibelstellen etc.9 Entsprechend ist eine 
Ausgabe in semantisch orientierten Formaten wie TEI allenfalls oberflächlich ohne die genannten 
textspezifischen Zusatzinformationen aus den Exporten ableitbar. 
 Jede Software hat Stärken und Schwächen bei der Unterstützung eines zügigen und effektiven Vorge-
hens besonders bei Training und Korrektur/Validierung. Diese Befunde wurden den Herstellern jeweils 
mitgeteilt, zumal manche Schwächen leicht behebbar erscheinen und möglicherweise einfach auf bisher 
unzureichenden eigenen Tests der Hersteller beruhen. Beide Firmen haben zugesagt, die Anmerkungen 
der SBB PK bei der Entwicklung der nächsten Versionen zu berücksichtigen.
 Innerhalb dieser Grenzen können beide Programme von selbst trainierenden oder vorhandene Trai-
ningsergebnisse nachnutzenden Anwendern sinnvoll eingesetzt werden. Im Kapitel 6.5 wird versucht, 
die Vor- und Nachteile jeder Software bezogen auf verschiedene Einsatzszenarien zu nennen. Die da-
bei beschriebenen Kriterien können zugleich als Hilfe zur Prüfung anderer OCR-Lösungen mit heran-
gezogen werden. Als Nebenergebnis der Software-Tests konnten somit auch Anforderungen an Soft-
warekomponenten zur OCR Alter Drucke formuliert werden, die hiermit auch potentiellen Anwendern 
mitgeteilt werden, die nicht zuletzt selbst mit entsprechender Nachfrage die Entwicklungsrichtung der 
nächsten Versionen mitbestimmen werden.      
 Nicht eingehend untersucht wurden Open-Source-Lösungen10. Ein Vergleich mit diesen könnte wei-
tere Optionen erschließen.  
      
 

9 Eine kleine Teilmenge aus dem „Metadatenmodell Funeralschriften (2008)“: 
 http://staatsbibliothek-berlin.de/fileadmin/user_upload/zentrale_Seiten/historische_drucke/pdf/Metadaten_Funeralschriften.pdf [Stand: 02/2013]
10 Ohne weitere Konfigurationen durchgeführte Tests an acht Seiten einer im Projektmaterial befindlichen Funeralschrift mit der Software OCRopus wurden im 

Mai 2012 durchgeführt. Das Ergebnis ist durchwachsen, fällt jedoch gegenüber den im Projekt mit optimierten Einstellungen der getesteten Programme erkann-
ten Seiten klar ab.
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11 Eine ausführliche Beschreibung der Geschichte und des Aufbaus von Leichenpredigten ist zu finden auf der WWW-Seite der Forschungsstelle für Personal-
schriften Marburg: http://www.personalschriften.de/leichenpredigten/aufbau.html [Stand: 02/2013]

2 Materialspezifik der Funeralschriften
2.1 Gattungsspezifische Aspekte
      
Funeralschriften sind personale Gelegenheitsschriften, deren Anfänge in die Mitte des 16. Jahrhunderts 
hineinreichen. Starke Verbreitung fand der Brauch, Leichenpredigten zu drucken, vor allem im protes-
tantischen Deutschland des 17. und beginnenden 18. Jahrhunderts. In dieser Zeit, die stark durch die 
Theologie des Pietismus geprägt wurde, war es üblich, besonders Adelige und Akademiker, aber auch 
Vertreter des wohlhabenden Bürgertums nach ihrem Tode mit diesen Schriften ausführlich zu würdigen. 
Funeralschriften bestehen in der Regel neben der Leichenpredigt aus dem Lebenslauf der Verstorbenen. 
Darüber hinaus enthalten sie oft eine Abdankungsrede (Leichabdankung), ein Programma Academicum, 
ein Epitaph und verschiedene Epicedien (Trostbriefe, Gedichte, Lieder, Musikbeigaben Verwandter und 
Bekannter). Als weitere druckgraphische Ausgestaltung findet man Porträts, Wappen, Ahnentafeln, Em-
bleme, aber auch Darstellungen des Castrum doloris (hölzerner geschmückter Aufbau zur Ehre des 
Toten) und des Leichenzugs.11

 Diese Gebrauchsschriften, deren Ziel es war, neben der Würdigung der Verstorbenen vor allem den 
Hinterbliebenen Trost zu spenden, sind seit mehreren Jahrzehnten Gegenstand multidisziplinärer For-
schung. Mit ihren vielfältigen Informationen bieten sie Einblicke in die damalige Alltagskultur und 
stellen wichtige Quellen für weitergehende Forschungen dar. Scheibe benennt Forschungsinteressen: 
„Neben ihrer Bedeutung für Literaturgeschichte und Predigtforschung bieten die Leichenpredigten dem 
Sozial-, Kultur- und Universitätshistoriker eine Fülle statistisch auswertbarer Daten, dem Kunsthisto-
riker und Heraldiker reiches Material zur Ikonographie und Emblematik, dem Musikwissenschaftler 
eine ganze Reihe von nur hier überlieferten Trauerkompositionen; die teilweise sogar mit Abbildun-
gen versehenen Krankheitsberichte schließlich liefern dem Medizinhistoriker wertvolle Informationen. 
Darüber hinaus aber stellen die Personalschriften ein einzigartiges prosopographisches Nachweisinst-

1 komposition als Epicedium. Ee 705-1592 S. [85]

2 Wappen. Ee 708-85 S. 2
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rument für Genealogie und Biographik dar – eine Qualität, die bereits im frühen 20. Jahrhundert ihre 
besondere Wertschätzung begründete.“12 Derzeit stellen Volltexte von Funeralschriften ein Desiderat 
dar. Ein semantisch ausgezeichneter Volltext könnte die oben genannten Forschungsgebiete sinnvoll be-
fördern; statistische Analysen sowie semantische Netze zu extrahierender Personen rücken in greifbare 
Nähe. 
 
     
2.2 Sammlungsspezifische Aspekte 
      
Im historischen Druckschriftenbestand der Staatsbibliothek zu Berlin befinden sich von jeher eine gro-
ße Anzahl Funeralschriften. In den 30er Jahren des 20. Jahrhunderts gelang es der Bibliothek, vier 
geschlossene Leichenpredigtensammlungen zu erwerben, so dass heute in der Summe von 15.000 
Schriften gesprochen werden kann. Der Bestand wurde um die Leichenpredigten aus der Bibliothek 
des Börries Freiherrn von Münchhausen auf Windischleuba (bei Altenburg/Thüringen) sowie um die 
Wernigeroder und die Bückeburger Sammlung vermehrt. Für das durchgeführte OCR-Projekt war vor 
allem eine vierte vom Antiquariat J. A. Stargardt (Berlin) 1936 vermittelte Leichenpredigtensammlung 
(Signatur Ee 705) von Interesse. Alle weiteren Aussagen beziehen sich vor allem auf diese Sammlung. 
Den Schwerpunkt bilden Funeralschriften (1.700 Nummern), die im mitteldeutschen Raum erschienen 
sind. Dies belegen Erscheinungsorte wie Halle, Magdeburg, Erfurt, Altenburg, Weimar, Wittenberg, 
Zeitz, Merseburg, Zerbst, Jena, Gotha, Leipzig, Dresden, Zwickau, Hannover, Braunschweig, Helm-
stedt, Coburg, Hof, Marburg, Kassel, Hanau, Giessen, Schweinfurt und Frankfurt/Main. Hinzu treten 
ostdeutsche Orte wie Elbing, Küstrin, Königsberg, Stettin, Breslau, Lignitz, Schweidnitz, Groß Glogau 

3 Frontispiz. Ee 705-28 S. [4] 4  Figurengedicht. 3/4 in: Ee 700-1993 S. [16]

12 Scheibe, Michaela zur Sammlung Personaler Gelegenheitsschriften auf: http://staatsbibliothek-berlin.de/die-staatsbibliothek/abteilungen/historische-drucke/ 
sammlungen/bestaende/personale-gelegenheitsschriften/ [Stand: 02/2013]
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und Brieg. Durch die Verbreitung des Pietismus im süddeutschen Raum (z. B. Württemberger Pietismus) 
gibt es auch eine nicht geringe Anzahl von Predigten aus diesem Gebiet. Straßburg, Heidelberg, Ulm, 
Stuttgart und Tübingen sind hier zu nennen. Das breite regionale Spektrum dieser Sammlung belegen 
ferner Erscheinungsorte wie Berlin, Hamburg, Rostock und Basel.

5 Leichenpredigt auf einen Arzt. Leipzig. Ee 705-1196 Titelblatt 6 Leichenpredigt. Lignitz. Ee 705-1404 Titelblatt

8 Leichenpredigt. Basel. Ee 705-820 Titelblatt7 Leichenpredigt. Straßburg. Ee 705-467 Titelblatt

MATERIALSPEZIFIk DER FunERALSCHRIFTEn
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Die zeitliche Abdeckung der genannten Sammlung spiegelt die Blütezeit der Leichenpredigt13 wider. 
So stehen zwei Drittel Schriften des 17. Jahrhunderts einem Drittel des 18. Jahrhunderts gegenüber. 
Dreißig Funeralschriften datieren ins 16. Jahrhundert. Aufgrund einfacher Auswertungen der Volltexte 
unter Hinzuziehung des Thesaurus Professionum der Forschungsstelle für Personalschriften Marburg14 
konnten folgende Personenkreise (in originaler Schreibung) ermittelt werden, die in den Schriften Er-
wähnung finden:

–  Prediger / Pfarrer / Pastor / Seelsorger / Bischoff / Beichtvater / Theologus / Diaconus
–  Lehrer / Rector / Praeceptor
–  General / Hauptmann / Obrister / Leutenant / Soldat / Oberster / Wachmeister / Kriegsmann
– Arzt / Medicus / Medico
–  Poet / Mahler
–  Rath / Cantzler / Bürgermeister / Amptman / Senator
–  Buchhalter / Weber / Zöllner / Pfleger / Wirth

      
Diese Berufsbezeichnungen beziehen sich nicht nur auf die Verstorbenen, sondern auch auf die Ange-
hörigen und Freunde, sofern sie in der Funeralschrift erwähnt wurden. Ein Abgleich der Liste histori-
scher Krankheitsbezeichnungen des Vereins für Computergenealogie15 mit den Texten hinsichtlich der 
genannten Leiden und Todesursachen vermittelt einen ersten Eindruck in die Lebensumstände der Zeit.

Häufigste Krankheiten:
– Hitze
–  Fieber
–  Schlag
–  Biß
–  Brand
–  Flecken
–  Pest
–  Husten  

2.3   Typographische und buchgestalterische Aspekte 
      
Neben inhaltlichen Besonderheiten weisen die Funeralschriften einige typographische und buchhistori-
sche Gattungsspezifika auf. Wie andere Druckschriften der jeweiligen Zeit auch zeichnet sich die Mehr-
zahl der Drucke aus dem 17. Jahrhundert durch ein sehr gedrängtes Druckbild mit übervoll gesetzten 
Seiten aus. Um Papier zu sparen, wurden zudem anfangs kleine Schriften (12 Pkt) verwendet; der Satz-
spiegel weist fast keine Absätze im Text auf (vgl. Abb. 13). Üblicherweise gibt es Titelblätter, die in bis 
zu drei Schriftarten und zusammen zehn verschiedenen Schriftgraden in barocker und ausschweifender 
Weise den Titel nennen (vgl. Abb. 5-8 u. 10-12). Üblich sind hier zunächst stereotype Titelanfänge wie 
„Christliche Leichpredigt/ Bey ...“. Wesentlich direkter und variantenreicher erscheinen sie später (z. B. 
„Tröstende Uranie bey einem zu früh verwelckten Orangen-Zweige, Die ...“ Weimar 1718).
      

13 Als Blütezeit gilt die Zeit vor dem 30jährigen Krieg und die zweite Hälfte des 17. Jahrhunderts.
14 http://www.personalschriften.de/datenbanken/thepro.html [Stand: 02/2013]
15 http://wiki-de.genealogy.net/Kategorie:Krankheitsbezeichnung [Stand: 02/2013]
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9 kupfertitel - Hamburg, 1687. Ee 705-1472 10 Titelblatt mit Titeleinfassung - Berlin, 1615. Ee 705-1161

11 Illustriertes Titelblatt 1. Hälfte 17. Jh. Hamburg, 1610. Ee 705-189 12 Titelblatt 2. Hälfte 17. Jh. Berlin, 1673. Ee 705-1160

MATERIALSPEZIFIk DER FunERALSCHRIFTEn
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Wie bis ins 18. Jahrhundert hinein üblich verwendete man auf den Titelblättern oft Titeleinfassungen 
(vgl. Abb. 6, 8 u. 10), die zunächst aus ornamentalen Motiven über Holzschnitte, später vermehrt über 
Kupferstiche realisiert wurden. Auch Kupfertitel und Frontispize sind zu finden (vgl. Abb. 3 u. 9). Die 
Rückseite des Titelblatts enthält in der Regel eine Widmung, zumeist den Angehörigen und Hauptleid-
tragenden des Verstorbenen zugeeignet; Vorreden können sich anschließen und leiten zur Predigt über.

Den Hauptteil einer Funeralschrift bildet die Leich-
predigt, die zunächst den Leichtext vorstellt und 
in den folgenden Teilen eine Vielzahl Bibelzitate 
enthält, welche in Form von Marginalien am Rand 
wiederholt werden (vgl. Abb. 13). Partiell direkt 
bezeichnet unterscheidet die Predigt Exordium 
(Vorrede, Einleitung in Redesituation), Propositio 
(Einleitung des Redegegenstands) und Consola-
tio (Trostworte). Das Ehrengedächtnis stellt üb-
licherweise die Schilderung des Lebenslaufs dar. 
Häufig wird an dessen Ende eine Schlussvignette 
als Kupferstich gesetzt, die Symbole der Vanitas 
zeigt (Schädel, Urnen; vgl. Abb. 20). Zumeist fin-
den sich Epicedien gesammelt am Ende der Fu-
neralschrift. Sind diese Beiträge bibliographisch 
selbständig erschienen, weisen sie ein eigenes Ti-
telblatt auf. Oftmals sind diese Seiten ungezählt 
und fallen durch eine typographisch abweichende 
Gestaltung auf. Vor allem verschiedene Gedichte 
werden nach Nennung des Beiträgers hintereinan-
der, zuweilen durch horizontale  Linien voneinan-
der getrennt, aufgeführt. An deren Ende erscheint 
eine weitere Schlussvignette.  
 Bis zur Mitte des 17. Jahrhunderts wurde häu-
fig der gesamte Text doppelt gerahmt (Randleisten 
im Inneren des Drucks; vgl. Abb. 14). Anfangs 
waren Blätter und Seiten oft ungezählt, später 
erscheinen die Drucke des 17. Jahrhunderts mit 
Kopfzeilen (Kolumnentitel und Paginierung) in 
diesem Rahmen. Ab der zweiten Jahrhunderthälf-
te findet man durch horizontale Linien abgeteilte 
Kopfzeilen.
 Sind die meisten Funeralschriften anfangs 
eher selten und gleichförmig geschmückt (Abbil-
dung von Sarg und Schädel, wiederholte Verwen-
dung gleicher Schlussvignetten mit Motiven16, die 
in der Ikonographie vergangener Jahrhunderte in 
der Heraldik eine Rolle spielten; vgl. Abb. 19 u. 
21), so zeigen sie ab 1650 deutlich mehr Buch-
schmuck mit vielfältigen Symbolen der Vanitas 
(Putti pusten Seifenblasen, qualmende Töpfe, aus-
geblasene Kerzen; vgl. Abb. 15-18). Dieser über 

Kupferstiche realisierte Buchschmuck der Darstellung von Vergänglichkeit nennt des öfteren auch die 
Initialen des Künstlers. Tragen die Darstellungen im allgemeinen bis zur Mitte des 17. Jahrhunderts 

13 Text mit Marginalien und kolumnentitel. Berlin, 1673. Ee 705-1160 S. 18

 16 Beispielhaft soll der Wilde Mann genannt werden, dessen Darstellung auch als Fabelwesen (Halb Mensch, halb Tier) gedeutet werden kann und häufig in den 
Schlussvignetten des Druckers Runge vorkommt.

14 Text erscheint in umrahmung ohne kolumnentitel. Berlin, 1645. Ee 705-669 S. [8]
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18 Putto mit Schädel u. Seifenblasen als Vanitassymbol. Leipzig, 1705. Ee 705-21 S. 3

eher den Charakter des Buchschmucks, so muss man in der Folgezeit (beispielsweise bei Porträts) zu-
nehmend von Illustrationen sprechen, die einen eigenständigen künstlerischen Beitrag darstellen. Sie 
wurden individuell für spezielle Drucke angefertigt.     
 Erscheinen Anfang des 17. Jahrhunderts Funeralschriften geringen Umfangs vorwiegend im Oktav-
format, so ist ab 1650 und für das 18. Jahrhundert das Quartformat kennzeichnend. Zudem nehmen die 
Schriften an Umfang zu, eine vermehrte Spationierung (Vergrößerung horizontaler Zeichenabstände) 
und Gliederung der Texte ist zu beobachten. Auch größere Schriften kommen zum Einsatz.17 
 Die Entwicklung des Druckbilds, die Verwendung von Buchschmuck und andere typographische 
Besonderheiten im 17. Jahrhundert wurden vor allem anhand der Funeralschriften der Familie Runge 
(Georg, Christoph und ihre Witwen) untersucht. Ihre Drucke sind zahlenmäßig stark und zeitlich konti-
nuierlich im Bestand der SBB vorhanden. 
     

16 Putto mit qualmender urne als Vanitassymbol. Dresden, 1713. Ee 705-6 S. 315 Gleitendes Schiff als Vanitassymbol. Oehringen, 1737. 1 in: Sh 6986

17 Vielfältige Vanitassymbole. Gotha, 1701. Ee 705-44 S. [36]

17 Aussagen zu Buchgewerbe und Druckqualität im 17. Jahrhundert finden sich unter vielfältiger Quellenangabe in KILLIUS 1999, S. 90 ff.

MATERIALSPEZIFIk DER FunERALSCHRIFTEn
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21 Sarg mit Schädel als Vanitassymbol. Berlin, 1666. Ee 705-1590 S. [150]

20 Schädel als Vanitassymbol. Berlin, 1674. Ee 705-1159 S. 40

22 Schlussvignette mit Blumendarstellung. Straßburg, 1699. Ee 705-159 S. [32]

19 Schlussvignette mit Darst. „wilder Mann“. Berlin, 1664. Ee 705-1592 S. 78
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2.4   Orthographische Besonderheiten
      
Besonderheiten in der deutschen Rechtschrei-
bung, die ohnehin für das 17. und 18. Jahrhundert 
nicht einheitlich war und starken Abweichungen 
unterlag, müssen hervorgehoben werden, auch 
wenn sie ein allgemeines Phänomen darstellen 
und nicht auf Funeralschriften beschränkt sind.18 
Bekanntermaßen findet man in den Drucken der 
ersten Hälfte des 17. Jahrhunderts überwiegend 
noch keine Unterscheidung von u und v. So lässt 
sich im Satz feststellen, dass ein gesprochenes „u“ 
am Wortanfang als „v“ gesetzt wird, im Wortin-
nern jedoch als „u“. Am häufigsten fällt diese 
Verwendung beim Wörtchen „vnd“ auf. Auch bei 
Großbuchstaben wird diese Schreibregel ange-
wandt. Zu nennen wären hier Wörter wie „Vnser“ 
oder „Vnterthan“. Differenziert man zunächst in 

der zweiten Jahrhunderthälfte die Kleinbuchsta-
ben „u“ und „v“ konsequent lautbezogen, so dau-
ert es bei den Großbuchstaben einige Jahrzehnte 
länger. Es finden sich reichlich Vorlagen mit dem 
Gebrauch der alten Regel für Großbuchstaben; pa-
rallel werden im Text die Kleinbuchstaben jedoch 
schon eindeutig verwendet (vgl. Abb. 23). 
 In diesem Zusammenhang ist auf die ähnliche 
Problematik bei i/j  zu verweisen, wobei hier das 
große „J“ durchgängig für I oder J in Frakturtexten 
steht. Hingegen kommt es bei den Kleinbuchsta-
ben längere Zeit zu einem gemeinsamen Gebrauch 
von „i“ und „j“ am Wortanfang. Auf einer Seite 
von 1625 beispielsweise findet man in derselben 
Schrift Worte wie „jhrer“,“jhn“ und „in“, „im“, 
„inbrünstiglich“, „ist“ gemeinsam, was auf eine 
Unterscheidung im Gebrauch des langen und kur-

23 Markierter Ausschnitt

24 Markierter Ausschnitt

24 Verwendung von „j“ in „jhr“. Berlin, 1633. an: 50 MA 42058 S. 511

23 Verwendung von „V“ als „u“. Berlin, 1651. 11 in: Ee 1485 Titelblatt

18 Allen Drucken gleich ist die Darstellung der Umlaute durch Vokale mit übergesetztem kleinen „e“. Typisch für lange Zeit ist ebenso die Gliederung der Texte 
durch Virgel; Kommata kommen erst später in der Frakturschrift in Gebrauch. Weitere Merkmale historischer Drucke sind Kustoden und Bogensignaturen, 
Hilfsmittel für den Buchbinder. Vgl. weiterführend: SCHNEIDER und ZIPPEL 2009. Zur Varianz der deutschen Orthografie siehe VOESTE 2008.

MATERIALSPEZIFIk DER FunERALSCHRIFTEn
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zen i in der Schriftsprache hindeutet und so über 
mehrere Jahrzehnte zu beobachten ist bis auch 
hier immer „i“ geschrieben wird, wenn es sich um 
ein solches handelt (vgl. Abb. 24)19.   
 Weitere Auffälligkeiten entstehen durch die 
Verwendung des runden „r“20. Zunächst verwen-
det für die Abkürzung „etc.“, erscheint ein run-
des „r“ gefolgt von einem „c“ und einem Punkt. 
Später verbreitet sich der Satz des runden „r“ bei 
Buchstabenverdopplung (Herr, herrlich, Herrn) 
oder auch im Zusammentreffen mit „t“ (aufgefor-
dert; vgl. auch Abb. 25). Zusätzlich uneindeutig 
können Abbreviaturen (zumeist in Gestalt von Na-
salstrichen) über dem Buchstaben „n“ oder „m“ 
sein.  Überwiegend zeigen diese eine Verdopplung 
an; es gibt aber auch andere Anwendungen wie bei 

„un“; welches zu „und“ aufzulösen ist (vgl. Abb. 
26). In lateinischen Zitaten sind natürlich weitere 
Abbreviaturen anzutreffen, deren Auflösung wort- 
oder wortstammbezogen vorzunehmen ist. Für 
den geübten Leser ist das meist kein Problem; für 
die Anwendung automatischer Verfahren der Tex-
terkennung tritt es erschwerend hinzu.   
 Auch die Groß- und Kleinschreibung soll Er-
wähnung finden, da sie für die Schriftenvielfalt 
eine bedeutende Rolle spielt. So schreibt Kapr sehr 
treffend: „Leider blieb das schnörkelhafte Wesen 
der barocken Schriftformen nicht ohne Einfluss 
auf die deutsche Rechtschreibung. Der Wunsch 
zur Auszeichnung drängte die Schreiber dazu, 
möglichst viele Wörter mit Großbuchstaben zu 
schreiben, die mehr Gelegenheit zu schwungvol-
len Variationen gaben. … Erst begann man GOTT 
und HERR groß zu schreiben, dann folgten Papst, 
Kaiser, Bischof, Kirche, Fürst, und die Ergeben-
heitsfloskeln in den Vorreden der Buchausgaben 
des Barocks taten das übrige zur Überhäufung des 
deutschen Schriftbildes mit Versalien.“21 

27 Titelblatt mit verschnörkelten Versalien, Regenspurg, 1688. Ee 705-1081

28 Titelblatt mit illustrierten Versalien, Delitzsch, 1716. Ee 705-167

19 Vgl. weiterführend HORN 1894
20 „Rundes r; entstanden aus der rechten Hälfte des Unzial-R. Es wurde hinter runde Buchstaben oder als zweites r gesetzt; verlor aber im 19. Jh. an Bedeutung und 

verschwand.“ REHSE 1998 S. 78 
21  KAPR 1959 S. 61

25 Rundes „R“ bei Buchstabenverdopplung u. in „etc.“. 7 in: Ee 1593-2 Titelblatt

26 nasalstrich über „n“ zeigt Verdopplung an. 5 in: Ee 1593-2 S. 72
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So erkennt man an der Entwicklung der Titelblät-
ter der Funeralschriften neben der Neigung zur 
Verwendung möglichst vieler Schriften eine Zu-
nahme verschnörkelter Versalien bis hin zur Ver-
wendung von Barockinitialen (vgl. Abb. 27 u. 28). 
Offenbar war es auch im Text nicht ausreichend, 
Wörter wie GOtt und HErr oder JEsu durch Groß-
schreibung hervorzuheben; meist waren sie auch 
noch in einer größeren Schrift gesetzt (vgl. Abb. 
29). Auch der Satz von Kapitälchen wird für Her-
vorhebungen genutzt. Üblich ist durchaus auch 
die Hervorhebung nur einer Silbe oder gar das 
Setzen eines Fremdworts in zwei Schriften (Wort-
stamm Antiqua, Endung Fraktur; vgl. Abb. 30).

2.5 Verwendung gebrochener Schriften
      
In den hier betrachteten Funeralschriften werden überwiegend gebrochene Schriften für die laufenden 
Texte verwendet. Es handelt sich vornehmlich um verschiedene Arten von Frakturschriften ergänzt um die 
Schwabacher Schrift, die sichtbar für Hervorhebungen (v. a. von Namen) eingesetzt wurde. Ferner finden 
Antiquaschriften für lateinischsprachige Zitate in verschiedenen Graden und Schnitten Verwendung. 
 Die heutige Definition dieser Schriften (oft verkürzt auch nur als Frakturschriften22 bezeichnet) macht 
sich vor allem an den Brechungen der einzelnen Buchstaben fest, hat sie doch ihren Ursprung in der 
gotischen Textura – einer Schrift ohne jegliche Rundungen. Nachdem in der Renaissance vor allem die 
aus ihr entstandene offenere und leichter lesbare Schwabacher Schrift Verbreitung fand, ging man in der 
Mitte des 16. Jahrhunderts dazu über, schlankere Buchstaben mit klarerer Trennung und weniger Ver-
zierungen zu verwenden: die Fraktur war entstanden. Unterschiede zwischen den vorstehend genannten 
Schriften findet man beim Vergleich der Punzen (Innenraum von Buchstaben). Zeigen gotische Schrif-
ten durchweg eckige und schmale Punzen in Form von verschobenen Rechtecken bei den Kleinbuchsta-
ben, so haben Frakturschriften abgerundete Punzen, z. B. beim b, d, o und h. Bei der Schwabacher bilden 
die Punzen der Kleinbuchstaben Oval und Halboval.23 Frakturschriften laufen recht eng, d. h. sie haben 
kleine Wortzwischenräume.
 Ein harmonisches und freundliches Schriftbild entsteht aus der Grauwirkung der Fraktur. Kapr be-
schreibt sie wie folgt: „Das o, das a und alle daraus entwickelten Kleinbuchstaben bestehen aus einem 
geraden und einem geschwungenen Abstrich mit relativ spitzem Fuß. ... geschnäbelte Oberlängen der 
Kleinbuchstaben, und die sogenannten Elefantenrüssel, die den Buchstaben einleitenden Schwünge, 
geben den Versalien A, B, M, N, P, V und W ihren besonderen Ausdruck. [Vgl. Abb. 33 u. 34] Die 
Versalien sind im allgemeinen breit, die Gemeinen jedoch schmal gehalten. Der Gesamteindruck ist 

30 Ein in Antiqua gesetztes Fremdwort hat Fraktur-Suffix

22 Die umfassendere Definition der Fraktur ist belegt in Adelung FRACTUR 1808 bzw. im großen Brockhaus FRAKTUR 1954. 
23 Vgl. REHSE 1998 S. 15-21

29 Häufung von Versalien. Berlin, 1683. 3 in 4° Ee 660 S. 48

29 Markierter Ausschnitt
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schwungvoll und reich bewegt, er entspricht unserer konsonantenreichen deutschen Sprache und ge-
stattet das schnelle Erfassen ihrer verhältnismäßig langen Wörter.“24 „Obwohl die Fraktur viele Aus-
schmückungen erfahren hat, sind die ursprünglichen Federzüge stets erkennbar geblieben. Vier Jahr-
hunderte lang war die Fraktur die am meisten verbreitete Schrift in Deutschland. Nahezu alle Bücher, 
sogar wissenschaftliche, fast alle Tageszeitungen und Zeitschriften, in der Regel aber auch Akzidenzen 
(Geschäfts- und Kleindrucksachen) wurden in Frakturschrift gedruckt“25, wie Rehse weiter ausführt. 
Als besondere Frakturschrift des ausgehenden 17. Jahrhunderts ist die Luthersche Fraktur zu nennen, 
die Kapr charakterisiert: „Die Großbuchstaben sind teilweise mit phantasievollen doch überflüssigen 
Schnörkeln kalligrafisch moduliert. Aber das Hervorstechende bei der Luther-Fraktur ist der Einfluß des 
Stichels, der den geschriebenen Duktus maßvoll korrigiert.“26

      
Von den oben genannten Schriften finden sich vor allem die verschiedensten Frakturschriften in den 
betrachteten Leichenpredigten; Zahlen erscheinen immer als Mediävalzahlen, also mit Ober- und Un-
terlängen. Je nach Entstehungszeit stehen am Anfang eher schmucklose Schriften, die in verschiede-
nen Schriftgraden kombiniert werden. Auszeichnungen finden zunächst fast immer in der Schwabacher 
Schrift statt. Im laufenden Text springen derlei Zitate sofort ins Auge. Im Barock hingegen erscheinen 
viele Frakturschriften, die zunehmend verschnörkelte Versalien, aber schließlich auch verzierte Klein-
buchstaben aufweisen. Auszeichnungen werden nun durch größere und fettere Schriftgrade oder abwei-
chende Frakturschriften erzielt; die Schwabacher Schrift tritt in ihrer Verwendung in den Hintergrund. 
Wie eingangs bereits erwähnt, kommen zunächst kleinere Schriften (12 pt) zum Einsatz. Im ausgehen-
den 17. und beginnenden 18. Jahrhundert hingegen findet man oft 16-pt- oder gar 18-pt-Grundschriften 
auch für längere Texte. Unterbrochen wird das Druckbild im Stile der Zeit durch in Antiqua gesetzte 
Versalien für Namen oder in Antiqua (auch kursiver Antiqua) gesetzte lateinische Zitate. Bibelzitate sind 
auch direkt in hebräischer oder griechischer Schrift wiedergegeben (vgl. Abb. 31). Hervorzuheben sind 
hier ebenfalls die mannigfaltigen Formen und Größen von Initialen, deren Inhalt oft nur im Kontext ge-

lesen und verstanden werden kann (vgl. Abb. 32). 
Das Zusammentreffen all dieser Schriften führt zu 
einer großen Vielfalt, die eine Gruppierung von 
Drucken außer nach ihrem Entstehungszeitraum 
sehr erschwert. Möglichkeiten der Gruppierung 
eröffnen vornehmlich die Großbuchstaben M, I, C 
und U, deren Formen und Elefantenrüssel sich oft 
von Schrift zu Schrift unterscheiden. Allerdings 
ist ihr Auftreten im Verhältnis zu den Kleinbuch-
staben eher selten, so dass längere Textabschnitte 
gelesen werden müssen. Es bleibt abzuwarten, ob 
sich ein solches Vorgehen als praktikabel erweist.
      
      

31 Zitate in griechischer Sprache

32 Initiale, Leipzig, 1691. Ee 705-32 S. 3
 

33 Vorkommende Muster für Versalie A 34 Vorkommende Muster für Versalie M

24 KAPR 1959 S. 49
25 REHSE 1998 S. 21
26 KAPR 1959 S. 59
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2.6 Diversität vorkommender Schrifttypen
 
Eine der Schwierigkeiten bei der OCR Alter Drucke besteht in den verwendeten Typen, die von der spe-
ziell in den FineReader-Modulen bereits gut erschlossenen Frakturschrift des 19. Jahrhunderts deutlich 
abweichen. Es sollte daher versucht werden, zum Material passende Muster zu trainieren. Um die Tests 
unter Laborbedingungen möglichst gut interpretieren zu können, wurde dabei mit einer sehr homoge-
nen Schriftart begonnen. Diese Homogenität zeigte sich in einem Teil der in Königsberg gedruckten 
Funeralschriften des bekannten Dichters Simon Dach. Wurde diese erste aus 112 Drucken bestehende 
Marge fast ausschließlich aus Trauergedichten gebildet, so war eine zweite Schriftgruppe etwas offener 
angelegt. Sie konzentrierte sich aber auch auf denselben Zeitraum, wenige Drucker und zwei dominante 
Schriftgrößen. Jene Marge bestand aus 141 Leichenpredigten, die Schriften mit hoher Ähnlichkeit auf-
wiesen, allerdings auch im deutschsprachigen Fließtext mit etlichen Einsprengseln davon abweichender 
Typen. Um eine schnelle Zuordnung zu erreichen, wurden automatisch und stichprobenartig Teilbild-
Serien erzeugt und visuell in Gruppen aufgeteilt (vgl. Abb. 35 u. 36).

35 überblicksdarstellung zur Schriftgruppenanalyse der Drucke

MATERIALSPEZIFIk DER FunERALSCHRIFTEn
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36 Beispielseiten der ersten Margen
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Versuch der Gruppierung

– nach Merkmalen
Zur Gruppierung, also Clusterung, wurden unter typenkundlicher Beratung bestimmte individuell 
verwendete markante Großbuchstaben als Unterscheidungsmerkmal erwogen, sowie einige weniger 
markante, im Text aber durchgängiger auftretende Kleinbuchstaben. Um für eine effektive OCR noch 
hinreichend große Mengen von Bildern gemeinsam verarbeiten zu können, konnte und brauchte die 
Aufteilung andererseits nicht beliebig weit getrieben zu werden. Eine erste Sortierung innerhalb der 
Drucke aus der Mitte des 17. Jahrhunderts trennte (außer nach Schriftgröße) nach deutlich unterscheid-
baren Formen des kleinen runden „s“ (mit Rüssel wie in Fraktur und Textur oder ohne wie in Schwa-
bacher und Rundgotisch, gleich oder ungleich gewichtete vertikale Hälften usw.; vgl. Abb. 37). Für in 
weiteren Versuchen hinzukommende spätere Drucke eigneten sich etwa der Übergang von Virgeln zu 
Kommata im Satz oder – bei in das späte 18. Jahrhundert hineinreichenden Teilbeständen – eine bereits 
merkliche Annäherung an die schlankere Fraktur des 19. Jahrhunderts als initiales Unterscheidungs-
merkmal für separat zu trainierende Teilbestände. Im letzten Fall (zunehmende Nähe zu Schriften des 
19. Jahrhunderts) spricht viel für den Verzicht auf eigenes Training bei zunehmender Brauchbarkeit der 
in Softwareprodukten (z. B. in der FineReader-Engine) bereits integrierten Muster (Vgl. Kap. 5).

–  alternativ: Gruppierung empirisch
Sobald erste trainierte Muster schon vorliegen, bietet es sich in der Praxis auch an, die Zuordnung von 
Bildern zu einem Musterbestand nicht vorab nach visuellen Merkmalen, sondern nach einem OCR-
Gang empirisch anhand der Ergebnisse zu beurteilen. Im Idealfall liegen für Teile des zu prozessieren-
den Bestands Transkriptionen oder andere Ground-Truth-Daten (manuell erfasste, auch semantisch aus-
gezeichnete fehlerfreie Daten) vor, so dass für diese eine echte Erkennungsrate ermittelt und verglichen 
werden kann. Meist wird solches Referenzmaterial aber fehlen, so dass – mit vorsichtiger Interpretation 
und je nach Güte der vorliegenden Wörterbücher – hilfsweise z. B. der Anteil der sowohl im Lexikon als 
auch in den OCR-Texten enthaltenen Wörter als Indikator dienen kann. Wo dieser Anteil deutlich sinkt, 
sind oft Schriftartwechsel, Sprachwechsel und dergleichen die Ursache; im getesteten Material waren 
z. B. sporadische Seiten mit deutlichem Antiqua-Anteil auf diese Art schnell nachträglich zu erkennen. 
Praktisch sinnvoll wird diese nachträgliche Zuordnung immer dann sein, wenn Rechenzeit für Mehr-
fach-OCR zur Verfügung steht und die Bearbeiter die nachträgliche Auswahl im Vergleich zu einer 
vorherigen Sichtung jeder Seite schneller vornehmen können (Vgl. Kap. 4.5).
      
 

37 Verschiedene kleine „s“ als Gruppierungsmerkmal  

MATERIALSPEZIFIk DER FunERALSCHRIFTEn

36 Beispielseiten der ersten Margen



26 VOLLTExT VIA OCR  –  MöGLICHkEITEn unD GREnZEn

3  Typische OCR-Teilschritte und Einflussgrößen
3.1  Typischer Workflow

Für den Zweck der Darstellung des Softwaretests soll die Verarbeitungsschrittfolge wie folgt vergröbert 
(vgl. Abb. 38) behandelt werden:27

–  Sichtung und Vorsortierung des Bildmaterials;
–  Binarisierung (inkl. vorheriger Bearbeitung des Farb- bzw. Graustufenbilds und Nachbearbeitung  

des bitonalen Bilds);
–  Segmentierung (Layoutanalyse, Blockerkennung, Segmentierung auf Wort- und Zeichenebene);
– OCR (inkl. unmittelbar verbundener Fehlerkorrekturmechanismen);
–  Lexikalische Nachkorrektur28.

      
Neben den Einzelschritten begrenzt nicht zuletzt die stapelweise Verarbeitung an sich die mögliche Er-
kennungsqualität.   
 Dieser Workflow setzt das Vorhandensein einsatzbereiter OCR-Musterbibliotheken voraus. Wenn 
diese nicht oder nicht passend bereitstehen, ist deren Erstellung bzw. Bearbeitung voranzuschicken. Im 
praktischen Softwarevergleich (Vgl. Kap. 4) wird dieser Arbeitsgang separat behandelt. 

  

Eingang:  Bildmaterial
 
Ausgang:  Bildmaterial selektiert nach Eignung, z. B. gruppiert in Margen, die gemeinsame  
    OCR-Läufe zulassen

Unvermeidlich: a)  Das menschliche Vorwissen über Textsorten geht i. d. R. nicht in den OLR-/ 
 OCR-Prozess mit ein.

 b)  Schlechte Vorlagen aufgrund von Druckqualität, Durchdruck, 
  Papierverfärbung, Verschmutzungen und Annotationen müssen in 
  gewissem Maße hingenommen werden.

Potentiell  c) Die Scans schwanken in Bildhelligkeit und -kontrast sowie Randmaßen.
beeinflussbar: d) Innerhalb des OCR-Laufs (Seite, Stapel) kommt es zum Wechsel von 
  Schriftart, Sprache oder typographischen Konventionen.
 e) Ein Finetuning anhand von bestimmten Beispielseiten kann für andere Seiten  

 desselben Stapels nachteilig sein.

  Diese Verluste können oft durch Sichtung und Vorsortierung des Materials, durch  
 eine Vorverarbeitung der Bilder (Randentfernung oder einheitliche 

  Randdarstellung, einheitliche Satzspiegel, Teilung von Margen in rechte/linke  
 Buchseiten usw.) begrenzt werden.

27 Detaillierte Flussdiagramme gibt es in der Literatur zu konkreten OCR-Untersuchungen: einige Abläufe sind vergleichend dargestellt in KÄMMERER 2009. 
Nicht dargestellt sind interne Rückkopplungsmechanismen, wie sie ansatzweise auch in den getesteten Programmen integriert sind (je nach Ergebnis adaptiv 
wiederholte Anwendung von Segmentierungsalgorithmen, Zeichenzuweisungen oder Wortkorrekturschritten).

28 Linguistische Nachkorrektur wird von beiden Programmen nicht angeboten und daher aus der Betrachtung ausgeschlossen.

Stufeninput und -output  
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Vorsortierung des Materials 
bei Stapelverarbeitung

Bildbearbeitung

Bildbearbeitung

Image 
bitonal

Binarisierung

Segmentierung

OCR

Vorbereitung

Nachbearbeitung

Typische OCR-Anwendung

Binarisierung

OCR-
Klassifi kation

Export

OLR:
Layoutanalyse,

Blockerkennung,
Segmentierung

OCR-nahe
Zeichenersetzung
und -kombination

Lexikalische Korrektur
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Lexikalische Korrektur
nach Export
(interaktiv)
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vor Export
(interaktiv)

Lexikalische Korrektur
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(automatisch)

ansatzweise
Strukturerkennung

38 Typischer Workflow
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3.1.2 Bildvorverarbeitung und Binarisierung

Da die zur Zeichenerkennung gespeicherten Muster-Repräsenta-
tionen sich auf Schwarzweiß-Zeichen beziehen, muss die Vorlage 
in ein bitonales Bild gewandelt werden. Vor und/oder nach diesem 
Schritt werden i. d. R. verschiedene Filterungen angewandt wie 
Helligkeits- und Kontrastnormalisierungen, Ausgleich von Dreh-
winkeln, Wölbungen und Verzerrungen („Skew correction“), Aus-
filterung von Verunreinigungen, die anhand ihrer (kleinen) Größe 
oder ihres Abstands zu offensichtlichen Zeichen- und Textregio-
nen erkennbar sind (typisch für altes Papier wie für Mikrofilme), 
Abschneiden von erkennbaren Rändern und Nicht-Text-Bereichen 
usw.

39 Informationsverlust durch Binarisierung

Eingang:  Farb- bzw. Graustufenbild
 +  Steuerdaten:
  potentiell: Bildvorverarbeitungs- und 
  Binarisierungsparameter

Ausgang:  Bitonales, unter Umständen beschnittenes 
  oder gefiltertes Bild

Unvermeidlich: a) Die Vergröberung der Vorlage durch Reduktion der Farb- oder Graustufenin- 
 formation auf ein bit je Pixel führt dazu, dass relative Helligkeitsunterschiede  
 innerhalb des hellen oder dunklen Teils des Zeichenbilds der Erkennung nicht  
 mehr zur Verfügung stehen. Wegen der schon bei wenigen Graustufen 

  exponentiell ansteigenden Anforderungen an Musterrepräsentation, 
  Speicherplatz, Rechenzeit und Muster-Trainingszeit wird dieser erste 
  entscheidende Informationsverlust der OCR noch auf längere Sicht nicht 
  überbrückbar sein.

Potentiell  b) Scan-bedingte Verluste entstehen durch: 
beeinflussbar:  –  ungünstige Farbintensität und Kontrast;
  –  Verzerrungen (Wölbung, Knicke);
  –  Verunreinigungen;   
  – Ränder und graphische Elemente; usw.
  Als wichtigste Abhilfemöglichkeiten sind zu nennen:  
  –  eine Normalisierung im Voraus oder durch die OCR-Software
  –  eine Gruppierung nur der einander vergleichbaren Bilder für eine gemeinsame 
   Verarbeitung (s. o.);
  –  eine Entzerrung im Voraus oder durch die OCR-Software;
  –  eine softwareseitige Layouterkennung;
  –  ein manuelles Schneiden der Bilder;
  –  softwareseitige Filter;
  –  manuelle Filter. 

Stufeninput und -output  

Typische Informationsverluste und Fehlerquellen
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39 Informationsverlust durch Binarisierung

 c) Die Unterschiede zwischen „gleich hellen“ unterschiedlichen Farben gehen  
 verloren. Abhilfe kann durch eine passende Farbfilterung geschaffen werden.

 d) Die Anwender verzichten auf ein Finetuning wegen fehlender oder zu 
  unkomfortabler und zeitaufwendiger Konfigurierbarkeit der Software.
  Abhilfe ist allenfalls möglich durch: 
  –  den Einsatz von gut eingearbeitetem Personal (anwenderseitig),
  –  den Einkauf des Finetunings als Dienstleistung (organisatorisch),
  –  die Optimierung der Software auf leichte und verständliche Konfigura- 

  tions-Interfaces mit übersichtlicher Vorschau der Ergebnisse jeder Parame-
   teränderung (entwicklerseitig).

Wann unschädlich:  Unter günstigen Umständen kann dieser Informationsverlust unbedeutend  
 werden (und im wesentlichen darauf sind die in bestimmten Office-Umge-

  bungen heute gelegentlich erreichbaren hundertprozentigen Erkennungsleis- 
 tungen zurückzuführen): nämlich, wenn z. B. durch hohen und gleichmäßigen

   Kontrast, durch unbeschädigtes Druckbild (keine „brüchigen“ Lettern, keine  
 bedeutungsunterscheidenden Serifen ...) usw. das relevante Drucktypenbild  
 entweder bereits ohnehin in einer nahezu bitonalen Ausprägung vorliegt oder  
 Farb- und Helligkeitsstufen von vornherein nur redundante Information 

  tragen, und wenn ein geschlossener Typenvorrat eine trennscharfe Abbildung  
 auf die Mustermenge erlaubt. In Alten Drucken ist dieser Idealzustand nur in  
 Ausnahmefällen gegeben.

   Fast immer unschädlich bzw. beherrschbar ist der bloße Verlust der 
  Farbinformation gegenüber Graustufen; speziell in Alten Drucken kommen  

 zwar Wechsel zwischen rotem und schwarzem Textdruck vor, aber kaum 
  Situationen, in denen allein die Farb qualität zwischen Vorder- und Hintergrund
  unterscheidet, die Farbintensität aber nicht. 
       

3.1.3 Segmentierung (Layoutanalyse, Blockerkennung, Segmentierung auf  
 Wort- und Zeichenebene)

 
Eingang:  Binärbild
 +  Steuerdaten: 
  potentiell: Segmentierungsparameter wie Abstandsmaße, Mindest- und   

 Höchstgrößen von Zeichen usw.

Ausgang:  Satz einzelner Binärbilder bzw. Koordinaten der Bildregionen

 
Unvermeidlich: a) Wo typographische Merkmale (Zwischenraum zwischen Spalten/Absätzen/ 

 Wörtern/Zeichen, konsistente Linienführung, Zeilenausrichtung usw.) fehlen,  
 können diese Segmente maschinell nicht richtig erkannt werden.

 
Potentiell b) Für menschliche Gestaltwahrnehmung intuitiv bedeutungstragende Layout-
beeinflussbar:  merkmale können nicht in für alle Materialien gleichermaßen gültige 
  Operationalisierungen umgesetzt werden.

TyPISCHE OCR-TEILSCHRITTE unD EInFLuSSGRöSSEn
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 c) Lexikalische und semantische Indikatoren bleiben für die Strukturierung 
  ungenutzt.29

 d) Etwaige in Katalogen oder Datenbanken bereits erfasste Strukturinformatio-
  nen bleiben ebenfalls ungenutzt.

  Weil aus verlorener Strukturinformation regelmäßig eine in der Vorlage nicht  
 gegebene Mehrdeutigkeit der Zeicheninterpretation resultieren kann, bildet  
 diese Stufe den zweiten entscheidenden Informationsverlust der maschinellen  
 OCR. Abhilfe wird hier vor allem entwicklerseitig durch eine konsequente  
 Unterstützung der Hinzuziehung solcher Strukturinformationen möglich sein.  
 Bis dahin kann eine maschinelle Layoutanalyse stets nur Teile der Anforderun-

  gen erfüllen.

Wann unschädlich:  Am wenigsten problematisch ist dieser Verlust in Fällen sehr einfacher 
  Layouts und strukturell möglichst gleichwertiger Zeilen. 
   Manche Strukturinformation wird sich nach der OCR noch aus Merkmalen 
  des gelesenen Texts in Nachkorrekturschritten rekonstruieren lassen. Für eine 
  schon bei der Zeichenerkennung als Musterrestriktion wirksame Vorab-
  Segmentierung bleibt sie aber auch dann ungenutzt.  

  
3.1.4  OCR (inklusive unmittelbar verbundener Fehlerkorrekturmechanismen)

Für die Klassifikation von in bitonaler Form vorliegenden Zeichenbildern gibt es sehr unterschiedliche 
leistungsfähige Verfahren und einen entwickelten Forschungsstand, so dass bei geeignetem Input an 
Bildern und Musterklassen potentiell eine nahezu verlustfreie Zuordnung erreichbar ist. Dabei ist es 
gleich, ob konventionelle Ähnlichkeitsmaße berechnet oder neuronale Netze trainiert, ob eine topolo-
gische Abstraktion des Zeichens oder nur aus dem Bild abgeleitete Kennzahlen für die Klassifikation 
herangezogen werden.30

 Die Abgrenzung des OCR-Schritts von der vorangehenden Segmentierung einerseits und der nach-
folgenden Anwendung erster Zeichenersetzungsregeln andererseits ist unscharf. Ursache dafür ist die 
Klassifikation, die in guter OCR-Software zum Teil adaptiv auf die Segmentierung zurückwirkt (wenn 
etwa ein möglicherweise teilbares Zeichensegment mehrfach gelesen wird und je nach Möglichkeit in 
zwei Segmente geteilt wird oder nicht, oder wenn bestimmte Teilmuster sofort zu einem kombinierten 
Zeichen zusammengesetzt werden). 

 
Eingang:  Bildregionen auf Textblock-, Zeilen- und Einzelzeichenebene
 +  Steuerdaten:    
  Mustersammlung
  potentiell: Wörterbuch
  potentiell: unmittelbar auf Zeichen(-teil)-Ebene ansetzende Ersetzungsregeln
 
Ausgang:  OCR-Text
  Koordinaten der gelesenen Zeichen oder „Wörter“
 +  Evaluationsdaten:
  potentiell: statistische Auswertungen wie Anteil erkannter Buchstaben und  

 Wörter, Konfidenzwerte zur vermuteten Erkennungssicherheit auf Zeichen-  
 und Wortebene usw.; 

  potentiell: beliebige computerlinguistische Auswertungen

29 Zu Möglichkeiten der regelbasierten Dokumentstrukturanalyse nach der OCR vgl. Arbeiten an der Universitäts- und Landesbibliothek Tirol im Rahmen des 
IMPACT-Projekts, s. MÜHLBERGER 2011; der Nutzen der Strukturinformation wird aber auch dort überwiegend für die Nach-OCR-Phase gesehen.

30 Zu Klassifikationsverfahren s. u. a. SCHULZ 2006

Stufeninput und -output 
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Unvermeidlich: a) Es kommt zu falscher Musterzuordnung von beschädigten bzw. verunreinigten 
  Drucktypen, wenn eine hohe Ähnlichkeit zu anderen Zeichen besteht.
 b) Einige Zeichenwerte auf Muster überlappen sich. Das ist der Fall, wenn im  

 gleichen Musterbestand eine Schrift für ein Zeichen X Druckbilder zeigt, die  
 in einer anderen Schrift desselben Musterbestands für ein Zeichen Y stehen.  
 Fehlerhaft ist hier bereits der Zustand der Musterdatei, besonders wenn die  
 Software eine derartige Vermengung schon beim Anlegen der Musterdatei er- 
 zwingt und keine separaten Musterbestände ermöglicht, die später fallweise  
 kombiniert werden können.

 c) Bei Klassifikation eines Zeichens – auch wenn sie durch Vermerk von 
  Konfidenzwerten gewissermaßen „unter Vorbehalt“ geschieht – geht die 
  Information über die Alternativkandidaten und ihre Rangfolge verloren. 
  Dies muss als der dritte wesentliche Informationsverlust heutiger maschineller 
  OCR beachtet werden: er beeinträchtigt von vornherein die Treffsicherheit je- 

 der nachfolgenden lexikalischen Korrektur, die nun unter allen generell 
  möglichen Verwechslungen (im besten Fall sprachbezogen gewichtet) 
  auswählen muss und sich nicht mehr gezielt auf die wenigen am Ort für das  

 konkrete optische Muster allein möglichen Verwechslungen beschränken kann.

Potentiell d) Zeichen, die nicht zur aktuell geladenen Musterbibliothek passen, werden 
beeinflussbar:  nicht erkannt. Eine universelle Mustersammlung (wie z. B. die von FineReader 
  mitgelieferte Fraktur-Bibliothek) bietet zwar einen optimalen Durchschnitt,  

 verschenkt aber potentiell mögliche Erkennungsquoten auf Drucken, in denen 
  eben nicht die ganze Breite der Muster vorkommt und daher zu viele 
  irrelevante optische Muster angewendet werden. Abhilfe ist abhängig davon,  

 ob die Software ein Vorhalten separater „reiner“ Musterbestände zum Zweck  
 fallweiser Kombination überhaupt zulässt.

 e) Zeichen, die in Alphabet- und Sprachdefinitionen nicht vorhergesehen wurden, 
  werden nicht erkannt.

Wann unschädlich:  Echte OCR-Fehler sind im Prinzip nur dann unschädlich, wenn sie durch 
  lexikalische oder linguistische Nachkorrektur rückgängig gemacht werden  

 können. Hierzu sind sehr genaue Annahmen über Regelhaftigkeiten des 
  Ausgangstexts nötig, was zumindest in formalisierten Textsorten oder Texten  

 mit inhaltlich „geschlossenen Welten“ oft gegeben sein kann. Wenn im 
  industriellen Umfeld eine praktisch fehlerfreie OCR durchaus anzutreffen ist,  

 dann i. d. R. unter solchen Umständen. Andererseits ist eine Vermeidung von  
 OCR-Fehlern um so aussichtsreicher, je überschaubarer und trennschärfer der  
 verwendete Drucktypenvorrat ist und je vollständiger und exklusiver er durch  
 Training in die Musterbibliothek eingearbeitet werden konnte.

     
– Zwischenanmerkung – 
Will man eher auf Fehlervermeidung als auf nachträgliche Fehlerkorrektur setzen, muss bis zu dieser 
Stufe das Maximum an Lesetreue erreicht werden. 

TyPISCHE OCR-TEILSCHRITTE unD EInFLuSSGRöSSEn
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3.1.5  Lexikalische und linguistische nachkorrektur 

Jede auf die OCR folgende Fehlerkorrektur versucht, einen bereits eingetretenen Wissensverlust nach-
träglich zu kompensieren. Das ist naturgemäß nur unter Heranziehung von Regularitätshypothesen über 
die Vorlage möglich, die oft heuristisch bleiben müssen und im Einzelfall versagen können. Man wird 
auf diese Weise auch in Fällen „richtiger“ Korrektur i. d. R. nicht wissen können, ob die Korrektur rich-
tig war. Hinzu kommt die Anforderung, dass reale Druckvorlagen den angenommenen Regularitäten 
ihrer Textsorten nicht immer folgen (im einfachsten Fall: Druckfehler oder Schreibvarianten enthalten) 
und auch dann von der OCR treu wiedergegeben werden sollen.31

 Diesen Nachteilen nachträglicher lexikalischer und „linguistischer“ (morphologischer, syntaktischer, 
kontextbezogener usw.) Fehlerkorrektur steht der große Vorteil gegenüber, dass ab dieser Stufe auf 
Textformaten gearbeitet werden kann, d. h. mit der Computerlinguistik die Ressourcen einer ganzen 
Wissenschaft und eine große Vielfalt an Werkzeugen zur Verfügung stehen.32    
  
Es gibt ab dieser Stufe daher zusätzliche Alternativen:

–  Zwischen in OCR-Software integrierten Korrekturverarbeitungsschritten und einer externen 
Bearbeitung durch andere Tools kann gewählt werden.

–  Ein einmal vorliegendes Roh-OCR-Ergebnis kann (nacheinander oder parallel-verzweigend)  
mehrfachen Korrekturschritten zugeführt werden.

Erschwerend kommt bei alten Schriften hinzu, dass die zur Nachkorrektur verwendeten Wörterbücher 
die historische und uneinheitliche Rechtschreibung berücksichtigen müssen; eine gewisse Aufblähung 
mit Schreibvarianten ist daher nicht zu vermeiden.
 Auf echte linguistische Korrekturmöglichkeiten wird hier nicht eingegangen, weil beide untersuchten 
Softwareprodukte diese nicht anbieten.33 Der Übergang ist aber fließend, da auch in die lexikalische 
Korrektur linguistische Komponenten eingehen können, z. B. wenn das Lexikon mit morphologischen 
Ableitungen, abgeleiteten historischen Schreibvarianten oder Kollokationen angereichert werden konnte.
      
Gesichtspunkte zur Beurteilung der lexikalischen korrektur können sein:

–  ob sie vollautomatisch oder (teil-)manuell erfolgt;
–  ob erfasste Wortkoordinaten angepasst werden oder nicht;
–  welche sprachbezogene Zusatzinformation verwendet wird (Worthäufigkeiten? Konfusions-

wahrscheinlichkeiten? Zeichenübergangswahrscheinlichkeiten? usw.);
–  ob diese Zusatzinformation implementiert ist oder vom Nutzer fallbezogen parametriert werden 

kann; usw.34   

31 Hinweis u. a. von Marco Büchler, der als „big challenge“ der OCR nennt: „How can we correct OCR without correcting spelling errors?“  BÜCHLER 2011
32 Detaillierte sprach- und dokumentenspezifische Fehlerprofile wurden - mit dem Ziel der Entwicklung gut bedienbarer Korrekturwerkzeuge - u. a. im IMPACT-

Projekt untersucht, vgl. REFFLE 2011. - Ein am CIS München vorangehendes DFG-Projekt „Domänen- und dokumentenadaptive Verfahren zur Nachkorrektur 
von OCR-Ergebnissen“ versuchte die Leistungsfähigkeit von Korrekturverfahren dadurch zu erhöhen, dass explizit „Domäne, sprachliches Bild des Gesamttexts 
und logischer Kontext von Dokumententeilen bei der Korrektur mitberücksichtigt werden“ (Zu Projektbeschreibung mit Publikationsangaben s. NACHKOR-
REKTUR VON OCR-ERGEBNISSEN). Es ist davon auszugehen, dass das im Anschluss an IMPACT gegründete Kompetenzzentrum einen umfassenden 
Informationszugang zu solchen Möglichkeiten bereitstellt.

33 Diese Thematik wird u. a. behandelt in HAUSER 2007, STROHMAIER 2004.
34 Vgl. SCHULZ 2006, RINGELSTETTER 2003 u. a.
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Eingang:  OCR-Textergebnis
 + Steuerdaten:    
  Wortliste
  potentiell: Gewichte für bestimmte Wörter oder Lexikon-Teilbestände 
  (Vorrang bestimmter Kandidaten vor anderen)
  Parameter für erlaubte Distanz, bis zu der ersetzt werden darf
  potentiell: Gewichte für bestimmte Zeichenersetzungsschritte35

Ausgang:  Textexport
 +  Evaluationsdaten:
  potentiell: Vermerke der vorgenommenen Ersetzungen (Original-Lesart, 
  Kandidaten) im Textexport
  potentiell: beliebige computerlinguistische Auswertungen

Da sich die lexikalische Nachkorrektur weitgehend materialunabhängig und in computerlinguistisch 
zugänglichen Textformaten abspielt, gibt es eine reichhaltige, theoretisch gut durchgearbeitete Literatur 
zu Einflussfaktoren, Fehlersituationen und Korrekturstrategien unter Verwendung verschieden aufberei-
teter Korpora, was hier nicht wissenschaftlich referiert werden kann. 

Exemplarisch soll hier eine Fehlerklassifikation von Christian M. Strohmaier kurz vorgestellt werden, 
die zu praktischen Vorüberlegungen bei der Anlage der verwendeten Wörterbücher beitragen kann, an 
die teils gegensätzliche Anforderungen bestehen. Denn einerseits sollen alle im Original tatsächlich 
vorkommenden Wörter im Lexikon auch enthalten sein (d. h. akzeptiert und nicht fälschlich korrigiert 
werden), andererseits soll das Wörterbuch nicht unnötig viele Wörter enthalten, was zur unnötig ver-
mehrten Akzeptanz auch von OCR-Fehlern führt, die eigentlich korrigiert werden müssten.37

      

35 Die Korrektur von als „häufig“ bekannten Verwechslungen „verbraucht“ dann weniger der zulässigen Distanz, bis zu der die Korrektur stattfinden darf.
36 STROHMAIER 2004
37 Im Idealfall würde auch erkannt, was für Wörter in einem Textkontext überhaupt vorkommen dürfen, und es würden auch nur solche als Korrekturkandidaten 

erscheinen.

TyPISCHE OCR-TEILSCHRITTE unD EInFLuSSGRöSSEn

Stufeninput und -output 

Typische Informationsverluste und Fehlerquellen 
Eine mögliche Fehlerklassifikation36
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Strohmaier gliedert die korrekturfehler in sieben Fehlerklassen auf:
„1. Falscher Freund (false friend). Falsche Freunde sind eine nur schwer aufzuspürende Fehlerklasse. Die Nachkorrek-

tur hat keinen Anlass, an dem vorgefundenen, falschen OCR-Token zu zweifeln, da es lexikalisch ist. Entdeckungs-
strategien sind die Verwendung mehrerer OCR-Engines, die Berücksichtigung von Konfidenzwerten der Wort- bzw. 
Charakter-Erkennung der OCR-Engine selbst und stärkere Gewichtung von Kontextinformationen. Eine Vermei-
dungsstrategie ist die Verkleinerung des Lexikons. Es gilt, je kleiner das Lexikon D ist, desto geringer ist die zu 
erwartende Anzahl falscher Freunde. 

2.   Zu vorsichtig (too cautious). Das korrekte Wort ist Spitzenkandidat der Vorschlagsliste. Allerdings wird die Kor-
rektur nicht ausgeführt, da der Konfidenzwert zu gering ist con f(wocr) < 1. Vermeidungsstrategie ist eine mutigere 
Nachkorrektur, die alle Konfidenzwerte erhöht. Allerdings verhält sich die Fehlerklasse der unglücklichen Korrek-
turen (5) antagonistisch zu dieser Klasse. Die Einstellung des Konfidenzwertes con f muss zwischen diesen beiden 
Klassen austariert werden.  

3.  Falscher kandidat und falsche korrekturgrenze (wrong candidate and threshold). Das richtige Wort ist im 
Lexikon enthalten. Allerdings ist es nicht auf die Position des Spitzenkandidaten der Liste gerankt. Ausserdem sind 
die Konfidenzwerte aller Kandidaten des OCR-Tokens zu niedrig, so dass keine Korrektur vorgenommen wird. Fehlt 
das richtige Wort ganz in der Kandidatenliste, wurde es entweder zu stark von der OCR-Engine verunstaltet oder 
die Grobfilterung für die Kandidatenliste ist mangelhaft. Ansonsten ist die Vermeidungsstrategie eine verbesserte 
Konfidenzwertberechnung, d. h. geeignetere und/oder mehr Faktoren zur Kandidatenbewertung sowie eine bessere 
Kombination dieser Faktoren. 

 
4.  Falscher kandidat (wrong candidate). Die Nachkorrektur erkennt richtig, dass ein Korrekturvorschlag ausgeführt 

werden soll und auch das richtige Wort ist in Lexikon enthalten, jedoch nicht an erster Stelle der Kandidatenliste. 
Auch in diesem Fall sollte die Grobfilterung überprüft werden, wenn das richtige Wort in der Kandidatenliste fehlt. 
Ansonsten ist die Vermeidungsstrategie wie für die vorherige Fehlerklasse (3) eine verbesserte Konfidenzwertbe-
rechnung. 

5.  unglückliche korrektur (infelicitous correction). Korrekturvorschläge, die ausgeführt werden, obwohl das 
Groundtruth-Token nicht im Lexikon war, führen immer zu einem Fehler (worig ∉ D). Der drastischere Fall tritt ein, 
wenn die OCR-Engine das Originaltoken bereits richtig gelesen hat wocr = worig. Dadurch verschlechtert die Nach-
korrektur das Endergebnis. Vermeidungsstrategien sind die Vergrößerung des Korrekturlexikons und eine vorsich-
tigere Berechnung des Konfidenzwertes. Allerdings steigen mit einer Lexikonvergrößerung die potentiellen, false 
friends (1) und mit einer vorsichtigeren Konfidenzwertberechnung die potentiellen Fehler der Klasse too cautious 
(2). 

 
6.  unvermeidbar I (no chance I). Die Nachkorrektur wird [wegen zu niedrigem Konfidenzwert des Ersetzungskandi-

daten] nicht aktiv, obwohl eine Fehlerkennung vorliegt. Da aber das richtige Wort nicht im Lexikon und daher auch 
nicht in der Kandidatenliste ist, ist die Nachkorrektur ohnehin chancenlos. Die einzige Vermeidungsstrategie ist eine 
Vergrößerung des Korrekturlexikons D. 

 
7.  unvermeidbar II (no chance II). Die Nachkorrektur erkennt richtig, dass ein Korrekturvorschlag ausgeführt wer-

den soll und wird [aufgrund des ausreichenden Konfidenzwerts des Ersetzungskandidaten] aktiv. Es besteht jedoch 
keine Chance richtig zu korrigieren, da das originale Wort nicht im Lexikon enthalten ist worig ∉ D. Auch hier ist die 
einzige Vermeidungsstrategie eine Vergrößerung des Korrekturlexikons D.“

  
  und er schließt:     

 „Je größer das Korrekturlexikon desto geringer die Fehleranzahl des gesamten rechten Astes (Klasse (5), (6) und 
(7)), aber desto größer ist auch die Anzahl falscher Freunde, Klasse (1). Dies ist allerdings kein streng funktionaler 
Zusammenhang, sondern eine statistische Gesetzmäßigkeit. Die Fehlerverteilung innerhalb der restlichen Klasse (2), 
(3) und (4) bleibt im statistischen Sinne konstant.“38

38 STROHMAIER 2004, S. 96f.
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Unvermeidlich:  Dass jede der Fehlerklassen 1-7 in automatischer Korrektur vorkommt, dürfte  

 nicht zu verhindern sein, zumal dieselben Fehler auch in einer manuellen 
  Korrektur mit unvollständiger Sachkenntnis auftreten.
  Hinzu kommt, dass zwar die Lagekoordinaten der gelesenen Zeichen(ketten) 
  anhand der Bildvorlage ermittelt wurden, für korrigierte Formen aber nur 
  indirekt, z. B. durch Interpolation, auf Koordinaten geschlossen werden kann.  

 Es wird hier daher geringe Abweichungen geben. 
 
Potentiell   Die Wahrscheinlichkeit des Auftretens aller dieser Fehler ist weitgehend 
beeinflussbar:   steuerbar, wenn auch zum Teil auf gegenseitige Kosten.
  Aus dem Gesagten ergibt sich als Abhilfe: 
  –  die Wahl eines Wörterbuchs optimaler Größe;
  –  gut eingestellte Gewichtungen der Ersetzungskandidaten auf Zeichen- und  

  Wortebene.
  Außerdem sollte beachtet werden:
  –   die Wahl geeigneter Distanzmaße39 zwischen dem als falsch erkannten  

  OCR-Wort und dem Ersetzungskandidaten, anhand derer eine Korrektur 
   vorgenommen oder unterlassen wird. Sprach- und schrifttypisch gewichtete 
   Maße sind hier eindeutig vorzuziehen, da nur sie es ermöglichen, eine im  

  tatsächlichen Schriftbild wahrscheinliche Verwechslung leicht 
   zu machen (z. B. „ni“ > „m“), ohne zugleich auch alle möglichen anderen  

  Ersetzungen mit rechnerisch vergleichbar „niedriger“ Distanz anzustoßen. 
   Die Gewichtungen sollten asymmetrisch (für jede Ersetzungsrichtung 
   separat) zugeteilt werden können.
  – dass verschiedene Teile der eingelesenen Vorlage unterschiedliche Wortbe-
   stände erwarten lassen, d. h. man Situationen einschränken sollte, in denen 
   Textteile nicht gut zum aktuell eingestellten Wörterbuch passen.
  –    dass das Lexikon in zwei Rollen auftritt, die möglicherweise unterschied-
   lich von Unvollständigkeit oder Aufblähung des Wörterbuchs betroffen  

  sein können: (a) als Akzeptor einer OCR-Lesart, (b) als Repertoire für 
   Ersetzungskandidaten.

Wann unschädlich:  Per definitionem können Text-Fehler der maschinellen Nachkorrektur nie  
 unschädlich sein, außer im seltenen Fall anschließender manueller Korrektur  
 mit hoher Aufmerksamkeit und perfekter Kenntnis des Textgegenstands.   
 Dagegen geht bei jedem nachgeschalteten weiteren automatischen Korrektur-

  schritt die Information über die Nähe zur optischen Vorlage verloren und hat  
 keine Restriktionswirkung mehr; die in der Nachkorrektur erst entstandenen  
 Fehler können daher in weiteren Korrekturschritten besonders weit vom 

  Original wegführen.
  Wenig problematisch ist dagegen der Informationsverlust bezüglich der 
  genauen geometrischen Zeichen- und Wortkoordinaten, solange diese Infor-
  mation nicht zum akkuraten Ausschneiden der Bildteile benötigt wird, sondern 
  z. B. zur Hervorhebung einer Fundstelle auf dem Bild dient. Ob hier z. B. bei 
  einer in der Nachkorrektur erfolgten Zerlegung eines falsch zusammen gele-
  senen Worts in zwei Teile die interpolierte Lücke auf dem Bildschirm um 
  wenige Pixel neben der Lücke im Original angezeigt wird, dürfte an der Brauch-
  barkeit der Ortsinformation für die meisten Anwendungsfälle wenig ändern. 

    
39 Einige Distanzmaße werden vorgestellt in der generell als technische Einführung in OCR lesenswerten Arbeit SCHULZ 2006. Üblich sind zum Beispiel die 

Levenshtein-Distanz, die die Anzahl notwendiger Zeichenersetzungen zählt bzw. gewichtet aufsummiert.

TyPISCHE OCR-TEILSCHRITTE unD EInFLuSSGRöSSEn

Diese Fehler einbeziehend, wäre folgende Gruppierung möglich: 
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3.1.6 Semantische Erschließung: Strukturdaten und Named Entities

Auf die im OCR-Zusammenhang besonders interessante semantische Auswertung nicht-textueller 
Merkmale wurde in Abschnitt 3.1.3 bereits eingegangen. 
 Für die semantische Interpretation von bereits auf Textebene vorliegendem Input (Post-OCR) hat 
der Anwender prinzipiell die Wahl, auch außerhalb des jeweiligen OCR-Programms nach geeigneten 
Werkzeugen und Verfahren zu suchen. Im Rahmen des beschriebenen Projekts konnten semantische 
Auszeichnungen innerhalb der Softwareprodukte praktisch nicht realisiert werden; möglich waren eini-
ge automatische statistische Auswertungen durch Anwendung semantischer Entitäten auf die OCR-Ex-
porte. Möglicherweise ist die Erwartung semantischer Auszeichnung aber generell erst dann berechtigt 
an OCR-Software zu stellen, wenn aus dem Bibliotheksbereich selbst abgesicherte und operationalisier-
bare Vorgaben zur semantischen Interpretation konkreter Layout- oder textueller Merkmale angegeben 
werden. Softwarehäuser müssten sich hierzu sehr tief und fundiert mit buchkundlichen Fragen ausein-
andersetzen und scheinen sich aus Aufwands- und vielleicht auch Gewährleistungsgründen zu scheuen, 
selbst weitgehende Annahmen darüber in operationalisierte Definitionen zu gießen, die absehbar immer 
wieder in Einzelfällen oder im nächsten Bilderstapel versagen müssen. Hier „hartcodierte“ Programmie-
rungsleistungen zu bestellen, scheint daher vorläufig keine sinnvolle Option zu sein. Vielleicht ist eine 
arbeitsteilige Lösung denkbar, indem Softwarehäuser vorkonfigurierte Schnittstellen für typische Struk-
turelemente und Named Entities40 programmieren, deren konkrete Erkennungsmerkmale vom Nutzer 
verfeinert werden müssen.41 Wenn das gelänge, könnten Anwender, die ihr Material gut kennen, Infor-
mation gewissermaßen wieder „in die Texte hineintragen“.     
  
  
3.1.7 Einfluss der Verarbeitung ganzer Seiten     
 
Die passgenaue Anwendung der richtigen Spracheinstellungen und Mustersammlungen wird umso an-
spruchsvoller, je kleinteiliger die Regionen werden, die eine verlustfreie Gleichbehandlung noch vertra-
gen. In Alten Drucken stehen lateinische, griechische oder hebräische Wörter in entsprechender Schrift 
inmitten von Fraktur-Kontext. Im deutschsprachigen Satz zieht sich das bis in das einzelne Wort hinein, 
wenn lateinische Wortstämme in Antiqua, deren der deutschen Grammatik entstammenden Flexionssuf-
fixe aber – wie damals häufig üblich – in Fraktur gesetzt sind. Griechische und hebräische Buchstaben 
dienen gelegentlich als bloße Aufzählungszeichen, stehen damit einzeln und sind der jeweiligen Sprache 
oft nur durch semantisches Verständnis ihrer Funktion bzw. nur durch Hinzuziehung distalen Kontexts 
ihrer Schriftfamilie zuzuordnen. Frakturtexte, die keine Zahlen enthalten, könnten aussichtsreicher mit 
anderen („reineren“) Mustersammlungen gelesen werden als Texte, in denen arabische wie römische 
Ziffern an unvorhersehbaren Orten stehen können; umgekehrt könnte oft eine textsorten- und layoutge-
steuerte Erwartung römischer Zahlen deren richtige Erkennung überhaupt erst ermöglichen usw.
 Der vierte wesentliche Informationsverlust der maschinellen OCR ergibt sich daher nicht aus Proble-
men in einem konkreten der oben genannten OCR-Teilschritte, sondern aus der bei Massen-OCR kaum 
vermeidbaren Anwendung pauschalisierender Einstellungen, wenn sie im Verarbeitungsstapel weder 
von Seite zu Seite noch von Textblock zu Textblock oder gar innerhalb einer Zeile bzw. eines Worts fle-
xibel genug gewechselt werden können, um die Potentiale vorhandener Muster- und Sprachinformation 
tatsächlich wirksam werden zu lassen. 

40 Zumindest für named entities können aus der Computerlinguistik formale Kriterien bezogen werden; eine als Anregung lesbare Arbeit ist z. B. GEIERHOS 
2007, wo über den Titel „Grammatik der Menschenbezeichner in biographischen Kontexten“ hinaus auch auf grammatische Merkmale weiterer Entitäten Bezug 
genommen wird.

41 Beispielsweise als „Kolumnentitel“ gelte wahlweise „die erste Zeile“ / „der Text oberhalb der ersten durchgezogenen Linie“ / „die erste Zeile, wenn ihr Abstand 
zur zweiten größer als NN mm ist“; oder: Als „Bibelstellenangabe“ gelte „jede Zeichenkette, die in Antiqua gesetzt ist, zum Regulären Ausdruck X passt und 
sich innerhalb eines Strukturelements Y befindet“ usw.
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Eingang:  Menge an Images    
  Musterbibliothek(en)
  Wortliste(n)
 +  Steuerdaten:    
  Verarbeitungsparameter, Angaben zu Schriftfamilien, Alphabeten und 
  Sprachen, Zielformate, Zielspeicherorte

Ausgang:  Menge an Exportdateien, ggf. in verschiedenen Formaten
 +  Evaluationsdaten:
  Protokolle
  beliebige statistische und computerlinguistische Auswertungen
 

Unvermeidlich:  Da diese Fehlerquellen allein durch die Verarbeitungsorganisation entstehen,  
 sind sie nicht aus sich heraus unvermeidlich, sondern „nur“ in dem Maße, wie 

  der nötige Aufwand zur Zusammenstellung homogener Stapel nicht geleistet  
 werden kann.

Potentiell  Verluste auf den jeweils schlechter zur aktuellen Konfiguration passenden 
beeinflussbar:  Regionen/Seiten
  Abhilfe ist z. B. zu erreichen durch:
  – die Zerlegung von Batches in kleinere;
  –    die Teilung der Seiten vorab in separat zu verarbeitende Images bzw. 
   Image-Regionen;
  –   eine Mehrfachverarbeitung unter verschiedenen Bedingungen und den an- 

  schließenden Versuch, pro Textblock die im Nachhinein günstigste Ausga-
   be zu selektieren.

  Diese Aufteilung kann idealerweise vor dem Batchlauf vorgenommen werden. 
  Wenn das nicht praktikabel ist, könnten Seiten mit unnötig schlechter Erken-
  nung auch nach dem Batchlauf einer Neubearbeitung mit anderen Parametern  

 zugeführt werden. Software könnte dies unterstützen, wenn sie Evaluations- 
 kennwerte zur Ermittlung von zweckmäßiger Stapelaufteilung bereitstellt und  
 Stapelprozesse mit wechselnden Parametern zulässt.

Wann unschädlich:  Im einfachsten Fall verursacht die Gesamtseiten- und Seitenstapel-Verarbei-
  tung dann keine eigenen Fehler, wenn innerhalb der Seiten bzw. des Stapels  

 gar keine inhomogenen Situationen auftreten, die eine Mischung separater  
 Muster- oder Lexikonbestände erfordern.

  Im Fall von inhomogenen Seiten oder Seitenstapeln gilt:
  Bezogen auf die reine Zeichenerkennung können Misch-Musterbibliotheken  

 dann unschädlich sein, wenn die verwendeten Drucktypen der beteiligten  
 Schriftarten ausreichend disjunkt sind, d. h. sich immer nur da überlappen, 

  wo dasselbe Zeichen gelesen werden soll.
  Analog können gemischte Wörterbücher dann unschädlich sein, wenn auf- 

 grund konservativ gewählter Distanzmaße und Konfidenzwerte keine Gefahr  
 besteht, fälschlich „in die falsche Sprache bzw. den falschen Wortbestand 

  hinein“ zu korrigieren.

TyPISCHE OCR-TEILSCHRITTE unD EInFLuSSGRöSSEn

Batchinput und –output  

Typische Informationsverluste und Fehlerquellen 
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3.2  Zusammenfassung

Wenn man im Vorgriff auf die im nächsten Kapitel folgende Beschreibung der Software auch die Hilfs-
objekte (Parameter-, Muster- und Wörterbuchdateien) heranzieht, mit denen die einzelnen Schritte de-
terminiert werden, dann könnten die typischen Fehlerquellen und die wichtigsten vom Anwender zu 
beachtenden qualitätsbestimmenden Faktoren wie folgt in Abb. 40 dargestellt werden:

40 Workflow und beeinflussende Faktoren sowie resultierende Fehlerquellen

Vorsortierung des Materials 
bei Stapelverarbeitung

Varianzen der 
Vorlageneigenschaften

Bildbearbeitung Verlust von Farb- oder 
Graustufeninformation

Bildbearbeitung

Image 
bitonal

Binarisierung

Segmentierung

OCR

Vorbereitung

Nachbearbeitung

Typische OCR-Anwendung Typische Informationsverluste

Binarisierung Vergröberung der Vorlage

Verlust von
Strukturinformation

Erhöhung der Mehrdeutigkeit 
der Zeicheninterpretation

Unvollständige bzw.
unpassende Musterbibliothek

Falsche Musterzuordnung/
Nichterkennen von Zeichen 

Unpassende Alphabet-
und Sprachdefi nitionen

Information über Alternativ-
kandidaten geht verloren

Unpassendes, unvollständiges
Wörterbuch

Sehr umfangreiches
Wörterbuch

Gefahr falscher 
Korrekturen steigt

OCR-
Klassifi kation

Export

OLR:
Layoutanalyse,

Blockerkennung,
Segmentierung

OCR-nahe
Zeichenersetzung
und -kombination

Lexikalische Korrektur
vor Export

(automatisch)

Lexikalische Korrektur
nach Export
(interaktiv)

Lexikalische Korrektur
vor Export
(interaktiv)

Lexikalische Korrektur
nach Export

(automatisch)

ansatzweise
Strukturerkennung

Nachkorrektur begrenzt
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4  Praktischer Softwaretest und -vergleich I: Die Programme
4.1  übersicht über Parameter- und Hilfsdateien jedes Produkts

Der wesentliche Teil des Pilotprojekts bestand in der Untersuchung, wie ein Anwender mit Hilfe der 
jeweiligen Software zu den bestmöglichen Bedingungen eines OCR-Laufs gelangt. Dabei war der Fra-
ge nachzugehen, wie nachnutzbar diese sind, z. B. durch Fixierung erreichter Optimierungen in Para-
meter- bzw. Konfigurationsdateien bzw. in als Dateien speicherbaren Muster- und Wortbibliotheken. 
Entsprechend nimmt die Erstellung bzw. Beschaffung dieser Parameter- und Hilfsdateien einen großen 
Teil der (menschlichen) Bearbeitungszeit ein, ehe die eigentliche OCR-Produktion dann automatisch im 
Stapelbetrieb läuft und vorwiegend Rechenzeit beansprucht. 
 Zum besseren Verständnis der folgenden einzelschrittbezogenen Details folgt hier zunächst ein Über-
blick über die Speichermodelle der jeweiligen Software.

Beteiligt sind pro OCR-Lauf zwei bis vier Parameterdateien, die in BIT-Alpha explizit als Datei geladen 
werden müssen und teilweise überlappende Funktionen haben:

– eine Konfigurationsdatei „.bda“ für Binarisierungs- und Segmentierungsparameter, optional 
auch für Musterbibliothek und Sequenzen;43

– soweit Muster nicht in „.bda“ bereitgestellt werden: ein separates Speicherformat „.bit“ für die 
Musterbibliothek, optional auch für Sequenzen (s. u.);

–  soweit Sequenzen nicht in „.bda“ oder „.bit“ bereitgestellt werden: ein separates Speicherfor-
mat „.seq“ für Ersetzungsregeln (Sequenzen) zur sofortigen und lexikonunabhängigen Kombi-
nation bestimmter Zeichen(teile);

–  eine Datei „.lx2“ für Wortbibliothek und Parameter der lexikalischen Nachkorrektur.

41 Parameter- und Hilfsdateien BIT-Alpha

(a) BIT-Alpha42
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Für die Muster und Sequenzen kann während jeder BIT-Alpha-Sitzung neu entschieden werden, in 
welchem der alternativen Formate sie abgelegt werden; so würde auch eine Übertragung von Mustern 
zwischen bda- und bit- bzw. von Sequenzen zwischen bda-, bit- und seq-Dateien stattfinden.

Abgesehen von impliziten Programmkonfigurationsdateien44 nutzt HK-OCR pro OCR-Lauf vier eigent-
liche Parameterdateien:

–  drei Dateitypen zur Wahl einer eigenen „Sprachengruppe“: eine Wörterbuchdatei „.amd“, eine 
Base Language Datei „.blan“ und eine Text Language Datei „.lan“; hier können Wortlisten 
importiert und Listen erlaubter Zeichen bearbeitet werden. Zu diesen Dateitypen muss nur das 
Verzeichnis eingegeben werden (Reiter „Weitere“ im Einstellungsbereich von HK-OCR), dann 
kann im Reiter „Einstellungen“ die Auswahl einer „Sprachengruppe“ erfolgen.

–  eine Musterdatei „.ptn“, die explizit als Datei ausgewählt und geladen wird.
Hinzu kann je Einzelbild eine sogenannte (während einer früheren OCR angelegte) FR-Image-Datei 
kommen, die Vollbild- und Layout-Informationen enthält und die Einzelseitenlizenz verkörpert. Liegt 
diese FR-Image-Datei für das zu lesende Bild nicht vor, dann wird sie bei der OCR automatisch ange-
legt; wenn sie bereits im Bildstapelverzeichnis vorliegt, dann ist eine erneute OCR auch ohne weiteren 
ABBYY-Lizenzverbrauch möglich.45   

42 Parameter- und Hilfsdateien Hk-OCR/FREngine 9 

42 Alle folgenden Anmerkungen beziehen sich auf die im Projekt getesteten Versionen; zuletzt BIT-Alpha 2.0.38.594.
43 Zur Funktionsweise bei Zeichenkombinationen s. 4.3.3
44  HK-OCR verwaltet ohne Benutzereingriff im Programmverzeichnis und im Nutzer-Anwendungsverzeichnis je eine XML-Konfigurationsdatei, wo aktuelle 

Programm-(Session-)Einstellungen gespeichert werden, die aber im gegenwärtigen Design nicht zur Speicherung oder gar Änderung verschiedener später wähl-
barer Profileinstellungen vorgesehen sind, sondern lediglich – ähnlich wie bei Registry-Einträgen – beim Neustart einige Pfade und Optionen der letzten Sitzung 
wieder bereitstellen.

45  Das Lizenzmodell basiert auf der seitenweisen Abrechnung, wobei auch Images Lizenzen verbrauchen, die keine Texte enthalten (z. B. Leerseiten). Die Prozes-
sierung übergroßer Seiten (Folianten) mit viel Text benötigt unter Umständen zwei Lizenzen.

(b) Hk-OCR / FREngine 9 
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Für alle diese Hilfs- und Parameterdateien gilt, dass sie bisher in proprietären Binärformaten vorlie-
gen. Für eine effektive Protokollierung, den Vergleich und die auszugsweise Übernahme von einzelnen 
Parametern, Mustermengen, Ersetzungsregeln oder Wortbeständen wäre es wünschenswert, dass diese 
Dateien jeweils

– auch außerhalb eines OCR-Prozesses mindestens passiv auslesbar sind;
–  insbesondere miteinander verglichen werden können („In welchen Parametern haben sich OCR-

Lauf A und OCR-Lauf B unterschieden?“);
–  eine leichte Übernahme von (Teil-)Inhalten einer Konfigurationsdatei in eine andere ermögli-

chen (Ersatz, Kombination usw.). 
Hierzu eignen sich naturgemäß am besten konventionelle offene Textformate wie Config- bzw. INI-
Dateien, auch XML, die sowohl von Menschen als auch maschinell gelesen und bearbeitet werden 
können, die jederzeit mit Standardtextfiltern auswertbar sind und die somit auch von einem beliebigen 
einbettenden Workflow aus verwaltet werden können.     

4.2  Start der OCR-Verarbeitungskette in der Benutzeroberfläche

Die OCR einer Einzelseite startet selbsttätig,
– wenn die bda-Konfigurationsdatei ein gespei-

chertes Image enthält, und zwar bereits beim 
Öffnen der bda-Datei46 oder

–  beim Laden eines Bilds („File > Load 
Image“)47.     
 

In der Ansicht (Layer) „OCR“ wird angezeigt, ob 
und (durch Farben unterschieden) mit welcher Si-
cherheit BIT-Alpha die Zeichen erkannt hat. 
 Der Batch-Lauf wird (nach Öffnen/Laden der 
Konfigurationsdateien und/oder Einstellung aller 
gewünschten Parameter) angestoßen im Menü 
„File > Batch process ...“, wo Quell- und Ziel-
verzeichnisse sowie die Exportformate eingestellt 
werden können, per Button „OK“.

Nachdem die Grundeinstellungen eingerichtet sind (einmalige Angabe von Pfaden im Reiter „Weite-
re“ im Einstellungsbereich von HK-OCR48), wird für den aktuellen Lauf der Bild-Quellordner gewählt 
(„Bild öffnen > Ordner wählen > Ordner wählen ...“) und werden in den Reitern „Einstellungen“ und 
„Export“ die aktuell gewünschten Einstellungen vorgenommen. 
 Danach kann die OCR einer Einzelseite gestartet werden durch „OCR starten > aktuelles Bild lesen“. 
Ein Batch-Lauf wird analog ausgelöst durch „OCR starten > alle Bilder lesen“.
 

43 Arbeitsbeginn mit BIT-Alpha

46 In der getesteten Version von BIT-Alpha war das automatische Abspeichern des letzten Images Standardverhalten und nicht ganz glücklich, da jedes neue Öffnen 
einer bda-Datei dann aufgrund des damit automatisch beginnenden OCR-Laufs viel Zeit verbraucht. Verhindert werden konnte die Speicherung des je aktuellen 
Bilds durch explizites Entfernen („Page > Remove“) vor dem Speichern der bda-Datei.

47  Auch dies hat Nachteile: ein Bearbeiter könnte z. B. nach dem „Laden“ des Bilds noch Einstellungen vornehmen wollen, ehe die OCR beginnt.
48 Wird über verschiedene Profile (ohne Administrationsrechte) auf die Software zugegriffen, ist darauf zu achten, dass in den profilbezogenen Anwendungsdaten 

eine vollständige alle Pfade enthaltende Konfigurationsdatei (user.config) liegt. Andernfalls öffnet sich das Programmfenster nicht und es können keinerlei 
Einstellungen vorgenommen werden.

PRAkTISCHER SOFTWARETEST unD -VERGLEICH I

(a) BIT-Alpha 

(b) Hk-OCR / FREngine 9

Desiderata
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Aus dieser Benutzerführung ergeben sich vor allem einige unnötige Beschränkungen des Batch-Be-
triebs. So müssen gegenwärtig alle verarbeiteten Bilder in demselben Verzeichnis liegen (das bei HK-
OCR zugleich die Exporte aufnehmen muss), was dazu zwingt, große Mengen Bilddaten unnötig zu 
bewegen. Bildverzeichnisse werden komplett verarbeitet. Und für den gesamten Batchlauf bleibt die 
Konfiguration starr.      
 Im Abschnitt 6.4 wird darauf eingegangen, wie deutlich flexiblere Stapelverarbeitungen möglich wä-
ren, wenn die Programme die Parameter, die ihnen ohnehin übergeben werden müssen (Namen von 
Verzeichnissen und Konfigurationsdateien usw., die derzeit einmalig per GUI eingestellt werden und 
daher starr für den gesamten Batch-Lauf gelten), auch als konventionelle Kommandozeilenparameter 
akzeptieren würden.   
         

4.3 Einzelne OCR-Verarbeitungsstufen (ohne Trainings-Phase)

Jede OCR setzt gespeicherte Repräsentationen optischer Muster voraus, anhand derer die Drucktypen 
klassifiziert und einem Zeichen bzw. einer Zeichenfolge zugeordnet werden. Die Beschaffung (Training, 
Bearbeitung, Kombination) der Musterbibliothek geht dem produktiven Einsatz i. d. R. voraus, wird 
aber in einem späteren Abschnitt dieses Kapitels (s. Kap. 4.4) beschrieben.

4.3.1  Bildvorverarbeitung und Binarisierung

Beide Produkte kommen am besten mit Bildern zurecht, die bereits mit normalisierten Helligkeits- 
und Kontrastwerten, ohne Ränder und Verzerrungen, in Stapeln mit vergleichbaren Weißraum-Maßen 
vorliegen usw.  Dennoch nehmen beide Programme auch selbst etliche Bildbearbeitungen vor, was bei 
HK-OCR weitgehend automatisch in der eingebetteten FineReader-Engine geschieht und bei BIT-Alpha 
detailliert konfiguriert werden kann und muss. 

BIT-Alpha bietet eine Vielzahl von die Binarisierung beeinflussenden Einstellungen, die ein großes Po-
tential zur Anpassung an spezielle Vorlageneigenschaften bieten, aber auf eine schwer durchschaubare 
Weise komplex zusammenwirken.
      

(a) BIT-Alpha

Desiderata
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Die Einstellungen werden in einer Konfigurationsdatei im proprietären Format „.bda“ gespeichert (s. 
Abb. 41 am Anfang des Kapitels). Die Arbeit in BIT-Alpha beginnt folglich mit dem Anlegen oder der 
Auswahl solch einer Konfigurationsdatei. Das initiale Programm-Menü „File > Open“49 bezieht sich 
hierauf (nicht etwa auf ein zu lesendes Image); entsprechend bedeutet „File > Save“ das Abspeichern der 
aktuell im Programm BIT-Alpha geltenden Parameter in einer solchen bda-Konfigurationsdatei. Images 
werden dann zur Verarbeitung hinzugeladen: bei Einzelverarbeitung per „File > Load Image“, zur Sta-
pelverarbeitung über „File > Batch process ...“ und die Angabe des Quellverzeichnisses.
 Neben Einstellungen zur Bildvorverarbeitung wie Helligkeits-, Kontrast- und Gammakorrekturreg-
lern, der Behandlung von Umrandungen usw. kann insbesondere sowohl auf Seitenebene (erste Binari-
sierung für Segmentierungszwecke) als auch auf der Ebene von „Regionen“ (zweite Binarisierung für 
Zeichenerkennung) zwischen verschiedenen Binarisierungsalgorithmen gewählt werden. Zur Auswahl 
stehen ein auf Farbanalyse, ein auf Farbintensitätsschwellen beruhender, ein modifizierter Niblack- und 
ein von B.I.T. selbst entwickelter Algorithmus. B.I.T. empfiehlt für Antiqua den eigenen Algorithmus, 
für Frakturschrift dagegen den Niblack-Algorithmus, der besonders die lokalen Helligkeitsunterschiede 
um die Zeichenkonturen herum auswertet.
 Mit den von BIT-Alpha angebotenen Vorschau-Ansichten („Layern“) kann die Auswirkung aktuel-
ler Einstellungen auf die Binärbildqualität einzelseitenbezogen unmittelbar visuell beurteilt werden.
Für den produktiven Einsatz fehlt hier eine Mehr-Seiten-Vorschau, um vorab zu prüfen, wie die anhand 
einer aktuellen Seite vorgenommenen Parameteränderungen sich auf andere Seiten desselben Stapels 
auswirken werden. Diese oft erheblichen Nebenwirkungen stellen sich daher häufig erst nach dem OCR-
Lauf heraus.
 Die binarisierten Seiten-Images können exportiert werden, aber erst beim OCR-Lauf. Nach Bedarf 
wurden in verschiedenen Projektphasen veränderte Binarisierungsoptionen angewandt. Die insgesamt 
sehr komplexe Justierung auf bestimmte Vorlageneigenschaften hin wurde meist von B.I.T. übernom-
men. Zu einigen Parametern sind typische Wertebereiche im Anhang aufgeführt (s. Anh. 7.3). Ein den 
Nutzer zur eigenständigen Konfiguration befähigendes Handbuch stand bis zum Projektende nicht zur 
Verfügung.
     

Eingriffsmöglichkeiten für den Anwender fehlen fast völlig; die Bildnormalisierung, Entzerrung und 
Binarisierung laufen eingekapselt in der FineReader-Engine. Man hat lediglich die Möglichkeit, die 
automatische Dreh-Ausrichtung der Seite ein- oder auszuschalten. Tests der Auswirkung verschiedener 
Binarisierungsoptionen konnten daher nicht gemacht werden. Entsprechend gibt es keine Konfigurati-
onsdatei für etwaige Vorverarbeitungs- oder Binarisierungsparameter. Spezielle Probleme wurden mit 
dem vorliegenden Material dennoch nicht beobachtet, offenbar sind die werkseitigen Einstellungen sehr 
gut für die meisten Anwendungsfälle geeignet. Ein Export der binarisierten Bilder war in HK-OCR nicht 
möglich.

Modularität
Bisher bietet keines der beiden Programme eine Ein- und Ausgabeschnittstelle nach der Binarisierung 
an.50 Für eine modulare Verwendbarkeit der Produkte, d. h. entweder das in einem Programm X bina-
risierte Bild in anderen Workflows weiterzuverarbeiten oder ein bereits binarisiertes Bild direkt in die 
Weiterverarbeitung mit dem Programm X einzuspeisen, wäre eine Schnittstelle wünschenswert.51

49  Dem entspricht ein Aufruf einer „bda“-Datei im Windows-Explorer, wenn bei der Installation unter Windows ein Dateityp „BIT-Alpha.Document“ mit der 
Extension „bda“ und BIT-Alpha als Standardanwendung registriert wurde.

50  Die in BIT-Alpha gegebene Möglichkeit eines Exports des binarisierten Bilds mit der OCR bedeutet zumindest immer einen zeitlichen Mehraufwand.
51 Im bis 2011 laufenden IMPACT-Projekt wurden u. a. Ein- und Ausgabeanforderungen verschiedener OCR-Werkzeuge beschrieben, um deren Kombinierbarkeit 

systematisch darzustellen; das 2012 als Nachfolgeinstitution entstandene Kompentenzzentrum kann als Kommunikationsvermittler in Anspruch genommen 
werden.
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Evaluation
Eine schnelle Vorschau der Binarisierungsqualität mehrerer Seiten (z. B. durch Vorab-Export einer Bild-
menge ohne zeitaufwendigen OCR-Lauf) könnte den Zyklus der Parameterbeurteilung vor dem OCR-
Lauf wesentlich verkürzen. (s. Kap. 6.4)

Benutzerschnittstelle
Die in BIT-Alpha fein konfigurierbaren Möglichkeiten werden in Anwenderhand erst dann wirksam ein-
gesetzt werden können, wenn herstellerseitig eine entsprechende Dokumentation und eine Art Leitfaden 
zur Parametrierung bereitgestellt wird. 
 Von HK-OCR (bzw. der eingebauten FineReader-Engine) wäre dagegen zu fordern, überhaupt mehr 
Konfigurationsmöglichkeiten für den Anwender zu öffnen, die intern durch Abbyy – wie die im Durch-
schnitt guten Ergebnisse zeigen – durchaus genutzt und beherrscht werden, und die in FineReader-Con-
sumer-Produkten gelegentlich auch nutzerkonfigurierbar sind. Alle in der FineReader-Engine potentiell 
einstellbaren Optionen52 sollten in der Programmoberfläche zugänglich gemacht werden.
     
 
4.3.2 Segmentierung

(a) BIT-Alpha

45 Nur einige der konfigurierbaren Parameter von BIT-Alpha (File > Settings > ...)
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Es gilt die gleiche Anmerkung zur Parametervielfalt wie bei der Binarisierung. 
 Eingestellt werden können u. a. minimale und maximale Distanzen zwischen Textblöcken und Ein-
zelzeichen, die Behandlung von Linien, Parameter der „elastischen“ Zeilenerkennung bei gewölbten 
Aufnahmen, Erkennung von Nicht-Text-Regionen (Abbildungen, Ornamentik) und etliches mehr.
 Die aktuell erreichte Segmentierung kann wieder mit verschiedenen Vorschau-Ansichten beurteilt 
werden; allerdings ist die Schlussfolgerung, wann welche Parameter geändert werden sollten, sehr kom-
pliziert und bisher nicht in einem Handbuch dokumentiert. 
 Ebenfalls eingestellt werden können Parameter, die später die OCR steuern wie z. B. Größe und 
Abstand als irrelevant zu entfernender Punkte, der Größenbereich der zu erkennenden „Targets“, sogar 
relative Größenverhältnisse der Drucktypen wie Ober-, Mittel- und Unterlänge der Zeichen u. a. m.
Alle diese Einstellungen werden mit in der bda-Konfigurationsdatei, die auch die Binarisierungsparame-
ter enthält, gespeichert bzw. daraus gelesen.  
      

Wie die Binarisierung verläuft auch die Segmentierung in der getesteten HK-OCR-Version vollautoma-
tisch ohne nutzerseitige Eingriffsmöglichkeiten. 
 HK-OCR sieht vor dem OCR-Start offenbar keine Ansicht und Beurteilung der entstandenen Bild-
blöcke vor; sie können dennoch über einen Button der Korrektur-Einstellungen (Reiter „Korrektur“ > 
„Anzeige“ > „Blöcke“) angezeigt werden. 
Layouterkennungs-Ergebnisse dürften mit in die bei der OCR pro Bild entstehenden binären Layout- 
und FR-Image-Dateien eingehen. Für den Anwender sind diese Informationen nicht auswertbar.53 
  

Modularität
In beiden Produkten ist weder die Eingabe fremder binarisierter Bilder zur Segmentierung noch die 
Ausgabe von Segmentierungsergebnissen vor der OCR vorgesehen.

Evaluation
Für den Anwender auf dieser Stufe zugängliche Layout-Ergebnisse (Blockkordinaten o.ä.) gibt es in 
keinem der beiden Programme.

Benutzerschnittstelle
Für BIT-Alpha gilt die bereits im Binarisierungsschritt gemachte Anmerkung zum Erfordernis eines den 
Nutzer unterstützenden Handbuchs. Für etliche Parameter, die geometrische Größen wie Abstandsmaße, 
Höchst- und Mindestgrößen beschreiben, könnte alternativ zur numerischen Eingabe eine graphische 
Eingabe vor dem Hintergrund einer binarisierten Originalseite angeboten werden. 
 Für HK-OCR gilt hier noch mehr als im vorangehenden Binarisierungsschritt, dass alle in der Fine-
Reader-Engine potentiell einstellbaren Optionen in der Programmoberfläche auch zugänglich gemacht 
werden sollten. Erkennungsrelevante Eigenschaften wie Satzspiegel, Spaltenerkennung, Ausblenden 
von Ornamentregionen, zulässige Zeichenabstände und Wortzwischenräume usw. sollten vor der OCR 
eingestellt werden können. Blockgrenzen können in der derzeitigen HK-OCR-Version nicht verschoben 
werden.54

52 Im Projekt war keine Gelegenheit, sich näher mit ABBYY-Entwicklerhandbüchern zu beschäftigen, dort scheinen aber durchaus Möglichkeiten angelegt zu sein.
53 Probleme ergaben sich bei der Bearbeitung von Vorlagen, die über die eigentlich zu betrachtende Seite hinaus auch noch „Textreste“ der gegenüberliegenden 

Seite enthielten, die nach Möglichkeit ausgeblendet werden sollten.
54 Während im späteren Nachkorrekturschritt („Erweiterte Validierung“) ein Verschieben der Blockgrenzen durchaus angeboten wird.
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4.3.3 OCR

Optische Zeichenerkennung klassifiziert bildliche Darstellungen und ordnet sie einem Zeichen bzw. 
einer Zeichenfolge zu. Im Softwarevergleich spielte keine Rolle, wie diese Musterklassifikation im ein-
zelnen mathematisch realisiert wurde (ob als Neuronale Netze oder mittels vorgegebener Ähnlichkeits-
funktionen über abstrakte optische Grundmuster oder Merkmalsvektoren usw.), da herstellerseitig kaum 
Informationen hierzu gegeben wurden und Qualitätsunterschiede absehbar nicht aus dem je verwende-
ten Paradigma resultieren würden. BIT-Alpha speichert offenbar verschiedene aus dem optischen Bild 
extrahierte Kennwerte, während FineReader vermutlich die binären Zeichen-Images selbst in der Mus-
terdatei speichert. Für den Anwender relevant ist, dass BIT-Alpha infolgedessen die gelernten Muster-
Images aus der gespeicherten Musterbibliothek nicht wiederherstellen kann.55

 Hier wird der OCR-Schritt unter der Voraussetzung vorhandener Musterbibliotheken beschrieben; 
ihre Beschaffung beschreibt ein späterer Abschnitt (s. Kap. 4.4).    

Vorgegebene Muster sind in BIT-Alpha nicht enthalten. Um überhaupt Texterkennung zu beginnen, muss 
man daher eine bereits trainierte Musterbibliothek verwenden. Diese Muster können entweder mit in einer 
bda-Konfigurationsdatei gespeichert sein oder in einer separaten Musterdatei im Format „.bit“ vorliegen. 
Wenn in BIT-Alpha sowohl (per „File > Open“) eine bda-Konfigurationsdatei als auch (per „OCR > Lib-
rary > Load“) eine bit-Musterdatei geladen sind, dann gelten nur die Muster der bit-Musterdatei. Aus der 
bda-Konfigurationsdatei sind dann nur die Binarisierungs- und Segmentierungsparameter wirksam. 
 Wenn die Mustersammlung wie von B.I.T. empfohlen trainiert wurde, sind i. d. R. so genannte „Se-
quenzen“ für regelmäßige einfache wortunabhängige Zeichenersetzungen angelegt worden. Diese kön-
nen wahlweise sogar an drei verschiedenen Orten gespeichert werden: wie die Muster entweder in der 
bda-Konfigurationsdatei oder in der bit-Musterdatei, oder separat in einer eigenen seq-Sequenzerdatei 
(dann zu laden über „OCR > Sequences > Load“)(s. Abb. 41 am Anfang des Kapitels). In der Praxis 
eignen sich „Sequenzen“ besonders für die Zusammensetzung von Buchstabenteilen56 oder auch zur 
Auflösung von Abbreviaturen, die aus mehreren gültigen Zeichen bzw. Special Values (Sonderzeichen) 
bestehen.57     
 Weitere die OCR-Stufe bestimmende Parameter können in den Menüs „File > Settings > OCR“ und 
„OCR > Library > Settings“ eingestellt werden.58 Hierzu gehört die Möglichkeit, den Erkennungslauf 
zu wiederholen sowie ein automatischer Versuch, abgetrennte Teile von Zeichenbildern alternativ als 
eigenes Muster zu lesen. Des Weiteren sind etliche Größenverhältnisse für die Zeichenklassifikation 
konfigurierbar.59

      

In der HK-OCR-Oberfläche wird die OCR gesteuert durch die
–  Wahl einer Musterbibliothek und/oder des eingebauten FineReader-Musterbestands;
–  Wahl von ein bis drei Schriftfamilien (Fraktur/Antiqua/Typewriter);
–  Wahl einer oder mehrerer vorgegebener „Sprachen“ oder selbstdefinierter „Sprachengruppen“ 

mit Wort- und Zeichenbeständen.

55  Es ist aber beim OCR-Lauf von Einzelseiten ein (manueller) Export der bitonalen Zeichen-Images möglich; die einzelnen Image-Dateien werden dabei getrennt 
in Verzeichnissen gespeichert, die nach den zugeordneten Strings benannt sind, so dass außerhalb der Musterbibliothek  die Bild-Zeichen-Zuordnung nachvoll-
zogen werden kann.

56 Wenn z. B. die Zeichensegmentierung dazu neigt, in blassem Druck Beine der Kleinbuchstaben „m“, „n“, „u“ zu separieren oder „w“ in „v“+„i“ aufzuteilen und 
dies in der Parameterkonfiguration nur um den Preis einer generell schlechteren Zeichenseparierung zu ändern wäre, dann können beispielsweise die einzelnen 
Beine als eigene Muster („special values“) trainiert werden und durch Sequenzen zusammengefügt werden. Sequenzen sind daher oft eng auf die trainierten 
Muster bezogen, d. h. andere Musterbibliotheken verlangen oft andere Sequenzen.

57 Es bot sich z. B. an, das „runde r“ als special value zu codieren, um es im sequencer mit folgendem „c.“ zu „etc.“ aufzulösen, sonst aber zu „r“. Historische 
Abbreviaturen können gut als eigene Muster trainiert werden.

58 Erstere werden wie Binarisierungsoptionen in bda-Dateien gespeichert; letztere wie Muster in bda- oder bit-Dateien. 
59 Vergleiche in der Parameterübersicht in 7.3 folgende Kategorien: Target Size (minimale und maximale akzeptierte Zeichengröße); Miniatures (zur Erkennung 

von Initialen); Classification (je nach Variabilität der Schriftform relativ zur Minuskelhöhe einstellbare Größenverhältnisse von: [P]atte (senkrechtes Bein bzw. 
kleiner senkrechter Strich, z. B. i ohne Punkt), [M]inuscule (Kleinbuchstabe), [G]rand (Großbuchstabe bzw. großer Strich), [R]este (kleineres Element als Patte, 
Minuscule oder Grand, z. B. „.“ oder „-“)). B.I.T. weist darauf hin, dass die Parametrierung dieses Menüs grundsätzlich von B.I.T. selbst und nicht vom Benutzer 
vorgenommen wird. Die Einstellungen sind für Fraktur, Kursivschrift der Renaissance oder gerade Antiqua unterschiedlich.

(a) BIT-Alpha

(b) Hk-OCR / FREngine 9
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Die FineReader-Engine bringt einen Grundbestand an Mustern (bezeichnet als „Builtin-Patterns“) auch 
für Fraktur mit, man kann also bereits Texterkennung realisieren, bevor eine Musterdatei geladen wird. 
Für Mainstream-Frakturschriften besonders des 19. Jahrhunderts sind diese built-in patterns oft völlig 
ausreichend und es ist durch eigene Muster keine Verbesserung der Erkennung mehr zu erwarten. An-
ders gesagt: Es muss nur dann eine eigene Mustersammlung eingesetzt werden, wenn – wie bei Alten 
Drucken oder bei speziell gestalteten Lettern – die built-in patterns den Drucktypen der Vorlagen nicht 
gut genug entsprechen.    
 Trainierte Muster sind in Musterdateien im Finereader-Format „.ptn“ gespeichert (s. Abb. 42 am 
Anfang des Kapitels). Genau eine solche Musterdatei kann in HK-OCR im Reiter „Einstellungen“ aus-
gewählt und in der Checkbox „Musterdatei verwenden“ aktiviert werden – wahlweise allein ohne die 
FineReader-Muster (dann Checkbox „interne Muster verwenden“ deaktivieren) oder mit ihnen zusam-
men (Checkbox „interne Muster verwenden“ aktivieren).60 Ein Mischen bzw. Zusammenfügen mehrerer 
in ptn-Dateien gespeicherter Musterbestände ist in HK-OCR nicht möglich. 
 Die Auswahl der Schriftfamilie(n) erfolgt über Checkboxen „Normal“, „Fraktur“ und „Schreibma-
schine“. Es ist nicht erkennbar, ob dahinter nur eine Kombination von Muster-Teilbeständen steckt61 
oder ob weitere interne Parameter betroffen sind.  
 Die Wahl einer „Sprache“ bzw. „Sprachengruppe“ bestimmt vor allem die Lexik und den Satz zuläs-
siger Zeichen. Auch wenn eine „Sprache“ „OldGerman“ zur Ausstattung gehört, war die Erkennungs-
leistung bei Einsatz einer speziell auf den Erscheinungszeitraum (17. Jahrhundert) und die Gattung 
bezogenen Wortliste besser. Hierzu musste aufbauend auf der vorgegebenen Sprache „OldGerman“ eine 
eigene „Sprache“ (base language) und „Sprachengruppe“ (text language) angelegt werden, in diese 
konnte dann der passende Wortbestand importiert werden. 
 Beobachtungen ließen vermuten, dass der Wortbestand recht früh bei der OCR in die Zeichener-
kennung eingeht; mangels exportierbarer Zwischenstufen konnte das nicht genauer untersucht werden. 
Auch bei vermeintlicher Benutzung ausschließlich des eigenen Wortbestands gab es gelegentlich Er-
kennungsleistungen, die am ehesten mit weiterhin aktiven FineReader-Wortlisten erklärbar wären. Auch 
das Verhalten hinsichtlich der prinzipiell in der Konfiguration angebbaren erlaubten und unerlaubten 
Zeichen einer „Sprache“ ist nicht transparent genug bzw. wurde im Pilotprojekt nicht vollständig ver-
standen.62

 Im OCR-Lauf werden von der FineReader-Engine proprietäre sogenannte Layout-Dateien angelegt, 
die offenbar variierenden Parametern des vorzunehmenden OCR-Laufs entsprechen. Neben diesem bi-
nären Format entstehen kurze, als Text lesbare Protokolldateien „layout.txt“ mit einigen statistischen 
Kenndaten zum OCR-Lauf des jeweiligen layouts. Es können pro Image mehrfache layouts angelegt 
werden, auf die dann wahlweise zurückgegriffen werden kann. HK-OCR lässt auch eine automatische 
Wahl des – nach einer internen Statistik vermeintlich erkannter Zeichen – „besten“ layouts zu (Reiter 
„Einstellungen“, Feld „Qualitätsoptimierung“). Man kann dadurch offenbar einige OCR-Parameter va-
riieren, ohne allerdings zu wissen, welche und in welcher Richtung.    
 Eine Besonderheit der FineReader-Engine ist die bei der OCR ebenfalls entstehende FR-Image-Datei, 
die offenbar die volle (Farb-)Bildinformation und einige Zusatzinformationen enthält.63 Im seitenbezo-
genen ABBYY-Lizenzmodell verbraucht die Erstellung jeder FR-Image-Datei eine Lizenzeinheit. Diese 
FR-Image-Datei kann später für erneute OCR-Läufe derselben Seite wieder verwendet werden, ohne 
dass dann eine neue Lizenzeinheit benötigt wird.64      
   

60 Achtung: Ohne Aktivierung der eigenen Muster (Checkbox „Musterdatei verwenden“) erscheint zwar die Checkbox „interne Muster verwenden“ inaktiv (aus-
gegraut), die internen Muster sind dann aber automatisch aktiv!

61 Dazu passt nicht, dass auch bei alleiniger Nutzung einer eigenen (zwangsläufig ungeteilten) Musterbibliothek ein Unterschied der Fraktur-Erkennungsrate bei 
Zuwahl der Antiqua („Normal“)-Schrift beobachtet wurde. Allerdings schien die „Deaktivierung“ der built-in patterns ohnehin nicht vollständig.

62 Über die Zeichen-Listen in den Menüs „Extras > Sprachen editieren > eigene Sprachen > unzulässige Zeichen“ und „Extras > Sprachen editieren > eigene Ba-
seLanguages > Erkennungssatz“ gelang es nicht immer, die zulässigen und nicht zulässigen Zeichen wie erwartet zu steuern. Bei einem offenen Textformat der 
Sprachdefinitionen würde dieses Problem vermutlich gar nicht erst auftreten oder wenigstens leicht identifizierbar sein.

63  Entsprechend liegt deren Dateigröße ein wenig über der Dateigröße der originalen, nicht binarisierten TIFF-Bilder, so dass im Dateisystem des Bilddatenver-
zeichnisses entsprechend Platz vorgehalten werden muss.

64 Zu beachten ist allerdings, dass spätere Wiederholungen des OCR-Gangs zum Teil nur bei identischen Pfaden (absoluten Speicherorten) der Muster- und Sprach-
Dateien möglich sind, und dass die Wiederverwendbarkeit nur für dieselbe Version der FR-Engine zugesichert wird.
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Insbesondere sollte die jederzeitige Kombinierbarkeit separater Muster-Teilbestände ermöglicht bzw. 
konsequenter angeboten werden. Eine gute Anleitung und Dokumentation der Wirkung jedes einstellba-
ren Parameters wäre die Voraussetzung, die Möglichkeiten auszuschöpfen. Hinsichtlich der Benutzer-
schnittstelle konzentrieren sich die Anforderungen an die Programmoberfläche auf die Trainingssituati-
on (s. Kap. 4.4).

4.3.4 Lexikalische nachkorrektur

Idealerweise wird eine Wortliste aller in der Vorlage vorkommenden Wörter und Wortformen benötigt, 
die alle in der Vorlage nicht vorkommenden Formen nicht enthält. Strikt zu vermeiden sind falsche 
Wortformen, da sie nicht nur die Akzeptanz von Lesefehlern erhöhen, sondern auch Fehlkorrekturen 
provozieren.65 Ähnlich problematisch sind Wortfragmente, wie sie aus Trennungen am Zeilenende re-
sultieren können – es bedarf gründlicher Überlegung, ob und wann solche Wortteile ins Korrekturlexi-
kon aufgenommen werden sollten.
 Neben den in Kapitel 3 genannten grundsätzlichen Kriterien kann die Eignung von Nachkorrektur-
schritten davon abhängen, inwieweit Wort- und Zeichenkoordinaten an den von der Korrektur betroffe-
nen Stellen mitgepflegt werden oder nicht, bzw. ob die Korrektur überhaupt erst auf abgeleiteten Forma-
ten erfolgt. Allerdings sind korrekturbedingte Koordinaten-Ungenauigkeiten im praktischen Gebrauch 
(Suchanfragen, Finden der Stelle im Faksimile) meist unproblematisch, da auch die korrigierten Zeichen 
bzw. Wörter sich weiter in unmittelbarer Nähe der nicht mehr ganz zutreffenden Koordinaten befinden.
 Eine linguistische Korrektur ist in beiden Produkten nicht enthalten, bzw. es müssten linguistische 
Kriterien vorab bei der Erstellung der Wortformenliste berücksichtigt werden.

Vor endgültiger Koordinatenspeicherung: automatische lexikalische Korrektur
Der OCR-Lauf erfolgt mit automatischer lexikalischer Korrektur, wenn in „File > Settings > OCR“ die 
Checkbox  „Spellcheck“ aktiviert und per „OCR > Lexical Correction > Load“ eine lx2-Datei (s. Abb. 
41 am Anfang des Kapitels) mit Wortliste und Ersetzungsparametern geladen wird. Das Bearbeitungs-
fenster für diese Einstellungen erreicht man im Menü „OCR > Lexical Correction > Edit“. 
 Sowohl in die Pflege der Wortliste als auch besonders in die Justierung der Ersetzungskoeffizienten 
lohnt es sich zu investieren, da hierdurch die blinde Ersetzung unbekannter Wörter durch irgendein be-
kanntes Wort auf die wahrscheinlicheren Alternativen hin gelenkt werden kann. 
 Die Wortliste sollte hinsichtlich Wortschatz und Schreibvarianten zwar so eng wie möglich am Textma-
terial erstellt werden, aber auch Vollständigkeit anstreben – was besonders dann vorrangig ist, wenn ein 
„automatisches Mustertraining“ (beschrieben im Abschnitt „OCR-Musterbereitstellung“) genutzt wird.
 Die Ersetzungskoeffizienten (Gewichte für Zeichenersetzungen, die zur Überbrückung der eingestellten 
maximalen Wortdistanz kombiniert werden dürfen)66 sollten empirisch anhand der OCR-Fehler eingestellt 
werden, die in einem OCR-Stichprobenlauf des konkreten aktuellen Materials tatsächlich häufig festzu-
stellen waren.
      
Nach endgültiger Koordinatenspeicherung: manuelle Korrektur für Export in „Leseformate“
In der Textansicht („View > Layer > Text“) bietet BIT-Alpha eine einfache Editiermöglichkeit, indem 
beim Anklicken eines Worts eine Eingabemaske erscheint. Die Arbeitsweise ist dem Vorgehen beim 
Training analog und intuitiv verständlich. Das Ergebnis der Korrektur kann aber nur in den für Einzel-
export zur Verfügung stehenden Exportformaten gespeichert werden („Page > Export“), derzeit sind das 
insbesondere PDF, Text und HTML; das XML-Exportformat (hier: ALTO) gehört nicht dazu.

65 Eine unbesehene Übernahme von historischen Transkriptionen bzw. E-Texten ins OCR-Lexikon ist daher auch bei einer „sehr geringen“ Fehlerquote problema-
tisch. Ein Schreibfehler pro Seite kann in 1.000 Seiten Text zu 1.000 falschen Worteinträgen führen. In der OCR-Korrektur ebenfalls nur mit Vorsicht einzusetzen 
wären - grundsätzlich interessante - halbautomatisch generierte historische Wörterbücher, die von sprachgeschichtlich bekannten Lautwechseln und morpholo-
gischen Regelmäßigkeiten ausgehend historischen Wortbestand aufzubauen bzw. Korpora zu ergänzen versuchen, vgl. NEUMANN 2008.]

(a) BIT-Alpha

Desiderata, kriterien für Alternativen
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Erreichbares Ergebnis:
Man erhält ein koordinatenrichtiges XML-Ergebnis also nur in der Güte, die per automatischer Korrek-
tur erreichbar war.
     

Vor endgültiger Koordinatenspeicherung: manuelle Korrektur („Validierung“)
Beim Laden eines OCR-erkannten Bilds bietet der Reiter „Korrektur“ im Einstellungsbereich von HK-
OCR die Anzeige einer Liste der von der OCR erkannten Wörter nebst einem Korrektureingabefeld an. In 
der Wortliste kann mit Cursortasten intuitiv auf- und abwärts navigiert werden, zugleich wird die Fund-
stelle im Faksimile farbig unterlegt und ein vergrößerter Ausschnitt der Trefferumgebung unterhalb des 
Seitenfaksimiles dargestellt. Der Korrekturgang („Validierung“) legt eine eigene Layout-Datei an; es kann 
demnach, solange der Zustand des OCR-Arbeitsverzeichnisses konsistent bleibt, wahlweise auf die OCR-
Versionen vor und nach der Korrektur zurückgegriffen werden.     
 Die im Ergebnis der Korrekturen bzw. Worttrennungen und -zusammenlegungen angepassten Koordi-
naten werden in die Finereader-XML-Ausgabe eingepflegt.      
 Über das Menü „Erweiterte Validierung“ ist hier in der Nach-OCR-Phase sogar eine manuelle polygo-
nale Blockgrenzen-Veränderung möglich, um z. B. aus dem Textblock herausgefallene Zeichen mit einzu-
beziehen oder fälschlich einbezogene Ornamentik auszuschließen.67

Automatische lexikalische Korrektur
Einige Korrektur-Leistungen werden offenbar OCR-nah bereits in Verbindung mit der Zeichenerkennung 
erbracht, wie der Einfluss der gewählten Wortliste auf die Erkennung zeigt. Ein separater automatischer 
Korrekturschritt ist sonst nicht vorgesehen; automatische lexikalische oder linguistische Nachbearbeitung 
kann also nur mit externen Werkzeugen erfolgen, folglich ohne – oder höchstens mit interpolierend schät-
zender – Koordinatenpflege.

Erreichbares Ergebnis:
Wenn der manuelle Korrekturaufwand geleistet werden kann, erhält man also ein koordinatenrichtiges 
Fertig-Ergebnis im FineReader-XML-Format und dessen Ableitungen, d. h. allen wählbaren Exportfor-
maten.

Gebraucht wird auch hier zuallererst eine Dokumentation der Konfigurationsmöglichkeiten und ihrer 
Auswirkungen.     
 Für eine sachgerechte Pflege der Wortbestände und Ersetzungsregeln scheint das ungehinderte 
Vergleichen, Verändern, Übertragen und Kombinieren von beliebig großen Teilen solcher Wort- und 
Regellisten unverzichtbar. Beides wird im Regelfall vollständig vom Anwender bereitgestellt und ist 
hinreichend in Textzeilen beschreibbar. Proprietäre Binärformate, die nach einmaligem Einlesen einer 
Wortliste vom Anwender selbst weder gelesen noch frei bearbeitet werden können, entziehen dem An-
wender dagegen ohne Notwendigkeit die Kontrolle über den ihm gehörenden Bestand. Wortbestände 
und Ersetzungsregeln könnten dabei unabhängig voneinander gespeichert sein. Gewichte für die Erset-
zung eines Zeichens durch ein anderes sollten richtungsabhängig auch unterschiedlich eingestellt wer-
den können (etwa wenn die Ersetzung von „1“ durch „i“ erleichtert werden soll, nicht aber die Ersetzung 
von „i“ durch „1“).

Modularität
Prinzipiell sind lexikalische Korrekturschritte Operationen auf Textdaten und daher zumindest dann 
nicht zwingend an das OCR-Werkzeug gebunden, wenn keine rückkoppelnden Abgleiche mit den op-
tischen Vorlagen mehr erfolgen. Eingabeseitig läge daher nahe, durch eine Schnittstelle zum Korrek-

66  Hoher Koeffizient bedeutet: Ersetzung bevorzugen, niedriger Koeffizient hingegen: Ersetzung „erschweren“.
67 Es ist nicht recht einzusehen, warum das nicht auch schon für die Segmentierung vor der OCR möglich sein sollte. Offenbar ist die Funktionalität der erweiterten 

Validierung von der gewählten Lizenzierung abhängig; sie stand später im Projekt nicht mehr zur Verfügung.
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turschritt die Einspeisung von bereits OCR-gelesenem Material zu ermöglichen, ohne dass hierzu ein 
erneuter OCR-Lauf und der nochmalige Zugriff auf das Image Voraussetzung sind.68 Und warum sollen 
Korrekturmodule mit speziellen Stärken (wie die durch explizite Gewichte sehr fein steuerbare automa-
tische Korrektur von BIT-Alpha oder die praktische Bedienerführung der manuellen Korrektur in HK-
OCR) sich auf die Verarbeitung nur der in der eigenen OCR-Software erzeugten Texte beschränken?
      
Evaluation
Aufgrund der in Ansätzen gegebenen statistischen Auswertung69 sowie der vielfältigen theoretisch ein-
setzbaren Möglichkeiten zu quantitativen Vergleichen der Versionen vor und nach einer Korrektur wäre 
es wünschenswert, wenn die Korrekturmodule selbst eine konfigurierbare Auswahl leicht handhabbarer 
Kennwerte verfügbar machen und vor allem eine Hilfe zur Interpretation anbieten würden.70 Anderer-
seits lässt das Text-(XML-)Format der Ergebnisse auch Fremdwerkzeuge zur Evaluation zu. Soweit 
entsprechende Tools zur Verfügung stehen, wäre das für Anwender eine potentiell unabhängigere und 
objektivere Alternative. 
     
Benutzerschnittstelle
Auch wenn hier keine konkreten Anforderungen an eine ideale Korrekturbenutzerführung skizziert wer-
den können: Die Bedeutung der Ergonomie eben des Korrektur-Arbeitsgangs kann nicht hoch genug an-
gesetzt werden, wenn aus kompromissbehafteten Massen-OCR-Produktionen präsentierbare Volltexte 
hergestellt werden sollen. Das bezieht sich nicht nur auf die prinzipiell erreichbare Arbeitsgeschwindig-
keit, sondern auch auf einen einarbeitungsarmen Einstieg externer, womöglich nur sporadisch mitarbei-
tender Korrektoren. 

4.3.5 Semantische Erschließung: Strukturdaten und Named Entities

Weder Strukturerkennung (angefragt waren textsortenspezifisch z. B. Kolumnentitel, Kustoden, Bogen-
signaturen u. a.) noch die Auszeichnung von „Named Entities“ aufgrund vorgegebener Listen (Orte, 
Berufe, Krankheiten, Bibelstellenangaben) wird bisher durch die getestete Software unterstützt. 
 Für die Projektphase war zunächst vorgesehen, den Herstellern ein für 2011 innerhalb der SBB PK 
und der DBV-AG Alte Drucke erreichbar scheinendes gemeinsam abgestimmtes Application Profile, 
das die umfangreichen Möglichkeiten der TEI hinsichtlich Elementen und Attributen sinnvoll eingrenzt, 
vorzugeben. Zu dieser Abstimmung, sicher eine anspruchsvolle Aufgabe,71 war es während der Pro-
jektzeit nicht mehr gekommen, so dass diese Entwicklungsleistung nicht mehr termingerecht verlangt 
werden konnte.         
 Für die getestete Software konnte eine Ausgabe in semantisch orientierten Formaten wie TEI daher 
nur sehr oberflächlich ohne die genannten bibliothekarischen Zusatzinformationen aus den Exporten 
abgeleitet werden. Die Dienstleister boten entweder eine manuelle Erfassung oder die Programmierung 
von entsprechenden Zusatzmodulen an, was aber mit weiteren Kosten verbunden gewesen wäre und 
mangels Demonstration der Leistungsfähigkeit solcher Zusatztools für den aktuellen Test auch nicht 
angezeigt schien.      
 Insoweit zur Erkennung von Strukturinformation und Named Entities reine Textmerkmale ausrei-
chen, kann eine diesbezügliche Anreicherung der OCR-Texte selbstverständlich auch nachträglich au-
ßerhalb der ursprünglichen OCR-Software erfolgen. 

68  BIT-Alpha führt immer eine Neu-OCR-Analyse durch; HK-OCR kann bei Vorliegen des Images, der Layout-Datei und der Status-XML-Datei im OCR-Arbeits-
verzeichnis auf den letzten OCR-Lauf zurückgreifen.

69 So möglich in statistischen Attributen der XML-Formate und in den layout.txt-Dateien von HK-OCR/FineReader.
70 Gefragt wären kurze Rekapitulationen des Für und Wider von Anteilsquoten „lexikalischer“ Tokens am Text, von Abdeckungs  -Zahlen zum Wörterbuch, der 

Signifikanz von Zeichen- vs. Wortfehlern usw. - Trotz aller Mängel jedes automatisch gewonnenen Evaluierungskennwerts sind diese nutzbar, wenn sie richtig 
verstanden werden: „... it will give an overview of where the OCR engine thinks it‘s succeeding and where it thinks it‘s failing. If there are wide discrepancies 
between one batch of files and another, the software log will allow the institution to prioritise those files where OCR accuracy is low, and to manage (and hope-
fully mitigate) those discrepancies.“ (ANDERSON 2010, S. 2)



51

4.3.6 Export
      
Von OCR-Software wird man grob zwei Hauptexportmöglichkeiten erwarten:

–  ein druckbares, im Idealfall sowohl das Faksimile als auch den Volltext enthaltendes Dokument 
in einem verbreiteten Format wie PDF, RTF oder HTML oder

–  ein die volle Text-, Layout- und Strukturinformation enthaltendes maschinell auswertbares Do-
kument z. B. in XML, aus dem der Anwender alle weiteren Formate und Funktionen (Voll-
textpräsentation? Druckpublikation? Hervorheben der Trefferstelle im Faksimile? Datenbank? 
Suchindex für bloße Volltextsuche?) generieren kann.

     

Für den OCR-Export können die Formate (ALTO-)XML, PDF, HTML, UTF8-Text und ein proprietäres 
Format „B.I.T. portable“ eingestellt werden; dazu können die Farb- und binarisierten Bilder exportiert 
werden. Das PDF-Dokument enthält das farbige Faksimile der Seite mit dem für eine Volltextsuche mit 
Highlighting der Fundstelle hinterlegten erkannten Text, sowie die bitonalen Regionen, die ebenfalls 
durchsuchbar als einzelne PDFs aufgerufen werden können.     
 Der Export der Einzelseiten-OCR wird entweder über das Menü „Page > Export“ oder per Kontext-
menü (Rechtsklick auf die Seite) veranlasst. Für Batch-OCR müssen die gewünschten Formate im Menü 
„File > Batch process ...“ ausgewählt werden. Ein automatischer Export der den erkannten Zeichen ent-
sprechenden bitonalen Bildsegmente als einzelne, nach dem Zeichenwert benannte Bilddateien in eine 
Art Typenbibliothek ist lt. Angaben von B.I.T. gegenwärtig in Vorbereitung. Für eine kurze Beispielseite 
mit sechs Zeilen Text ist ein Quelltext-Screenshot des ALTO-Outputs im Anhang (s. 7.1) abgebildet.
      

Sowohl für Einzelseiten- als auch für den Batch-Export gelten die im Reiter „Speichern“ im Einstellungs-
bereich aktivierten Formate; neben FineReader-XML und einem kompakteren, wortorientierten XML 
wird RTF (mit bildlicher Wiedergabe von nicht als Text erkannten Regionen) und PDF angeboten.72

Der Einzelseiten-Export für die gewählten Formate wird bei einer geladenen OCR-gelesenen Seite mit 
dem Menü „Speichern“ ausgelöst; im Batch-Lauf erfolgt der Export automatisch. Für eine kurze Beispiel-
seite mit sechs Zeilen Text sind Quelltext-Screenshots der genannten XML-Formate im Anhang (s. 7.1) 
abgebildet.
      

Aufgrund der vielseitigen Verwendungsszenarien für OCR-Volltext wird jeder Satz von Exportformaten 
gelegentlich Wünsche offen lassen. Den Dienstleistern wurde deshalb als Anregung übermittelt, zusätz-
lich zu den ausprogrammierten Ausgabeformaten eine templateartige Schnittstelle anzubieten, für die 
der Benutzer selbst die Umwandlung des primären XMLs bereitzustellen hätte (z. B. als XSLT-Style-
sheet, das einfach an ein im Programm vermutlich ohnehin existierendes XSL-Transformationsmodul 
zu übergeben wäre, oder als Datei von Ersetzungs-Regelsätzen aus Regulären Ausdrücken). Das könnte 
gerade in Batchläufen eine flexible Nutzung erlauben, ohne dass jeder Anwenderwunsch vom Hersteller 
ausprogrammiert werden müsste, und vor allem: ohne dass der Anwender sich schon vor Bestellung der 
Software auf jede Einzelheit seiner späteren Nutzungsanforderungen festlegen muss. Zwar sind Um-
formungen von XML-Formaten in beliebige Zielformate jederzeit auch extern möglich, wenn man sich 

71 Benötigt würde einerseits eine abschließende Definition einer als Minimalkonsens tauglichen, überschaubaren Untermenge eines aktuellen TEI-Formats (P5 
oder Lite), s. a. einschlägige Vorarbeiten wie die an der HAB Wolfenbüttel für frühere TEI-Versionen prototypisch entwickelten „Barock-DTDs“, s. STÄCKER 
2002, OPITZ 2002, andererseits hatten verschiedene Bibliotheken unterschiedliche Vorstellungen darüber, wie viele „technische“ OCR-Daten (Verarbeitungs-
parameter, Protokollwerte usw.) in das TEI-Format übernommen werden sollen und dürfen. Aus Sicht der SBB PK (Anforderungen der internen OCR-AG an 
ein notwendiges Standardformat wurden von Oliver Duntze formuliert) sollten folgende Daten (auch langfristig) in den Volltexten mitgeführt werden: Bildkoor-
dinaten (buchstaben- oder wortweise), Schriftgröße und -schnitt, „Strukturdaten“ (Textblöcke auf der Seite), Alternative Lesarten, Linguistische Informationen 
(im Lexikon der OCR vorhanden? Zahlwort? Eigenname? etc.), Erkennungssicherheit. Hinzu kommen administrative Informationen wie Grundlage der OCR 
(Dateiname der Bilddatei), Datum des OCR-Laufs, verwendetes OCR-Programm, eingesetzte Wortliste und Musterdateien.

72 Die Erzeugung des PDF-Formats ist von der Lizenz abhängig, die HK-OCR erfordert.
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intensiv genug mit den erhaltenen Exportformaten auseinandersetzt. Eine im Programm bereits ange-
legte Schnittstelle könnte aber den Aufwand verringern, die Eingriffsstellen etwas vorstrukturieren und 
die Schwelle zur Gestaltung eigener Exportformate somit senken. Vermieden werden sollte jedenfalls, 
dass Anwender ihrerseits ihre Volltext-Anwendungen auf zufällige Eigenheiten der Ausgabeformate 
bestimmter Softwareprodukte abstimmen und damit den zukünftigen Spielraum eigener Entwicklungen 
unnötig beschränken.
       

4.4 Bereitstellung der OCR-Muster: 
 Anlegen (Training) und Pflege von Musterbibliotheken

Training
Die Muster können entweder mit in einer bda-Konfigurationsdatei gespeichert sein oder in einer se-
paraten Musterdatei im Format „.bit“.(s. Abb. 41 am Anfang des Kapitels). Nachdem die OCR einer 
Einzelseite gestartet wurde,73 zeigt die OCR-Ansicht („View > Layer > OCR“), ob und – durch Farben 
unterschieden – mit welcher „Sicherheit“ BIT-Alpha die Zeichen erkannt hat. Das Anklicken eines be-
liebigen Zeichens öffnet das Trainingsfenster (Titelleiste „Verify Recognition“), wo der Zeichenwert des 
optischen Musters festgelegt oder geändert werden kann. 
 Mustern, denen kein Zeichenwert aus den beteiligten Alphabeten zugeordnet werden kann, kann ein 
eigener Code als „Special Value“ zugewiesen werden. Wegen der Möglichkeit, solche Sondercodes 
OCR-nah durch einen im „Sequencer“ (s. u.) festgelegten Zeichenwert zu ersetzen oder zu kombinieren, 
kann damit u. a. ein Training von Drucktypenteilen erfolgen, die in der Segmentierung gelegentlich an-
fallen (z. B. einzelne „Beine“ eines „n“ oder „m“). 
Eine Kurzanleitung für einen einfachen Trainingsgang wird im Anhang 7.2.2 gegeben.
      
Maschinelle Beschleunigung bzw. Verstärkung des Trainings
BIT-Alpha versucht mit zwei Verfahren, in manuellem Training begonnene Musterbestände zur automa-
tischen Vergrößerung bzw. zur Verstärkung des Musterbestands zu nutzen. In beiden Fällen werden den 
manuell trainierten Mustern „ähnliche“ Muster automatisch hinzugefügt, was die richtige Erkennung 
von Drucktypen befördern kann, die dem manuell gelernten Zeichen nicht mehr ganz so ähnlich sind.

–  „Learn Page“: Bei einer geöffneten Einzelseite können die als „fraglich“ erkannten Muster 
einer Seite (in der Ansicht „OCR“ durch nicht-blaue Farben gekennzeichnet), wenn sie vom 
Bearbeiter als korrekt eingeschätzt wurden, mit dem Befehl „OCR > Library > Learn Page“ der 
Musterbibliothek insgesamt auf einmal hinzugefügt werden. Dabei ist ein Konfidenzintervall 
einstellbar, für welche Erkennungswahrscheinlichkeiten das gelten soll.

–  „Autolearn“: Etwas unmotiviert in das Menü der exportierenden Batchverarbeitung integriert 
findet sich die Möglichkeit, eine Anzahl Seiten ohne Export laufen zu lassen und dabei – wieder 
mit einem (unter „OCR > Library > Learning parameters“) einstellbaren Konfidenzintervall – 
die auftretenden optischen Muster des ganzen Stapels mit dem erkannten Zeichenwert automa-
tisch der Musterbibliothek hinzuzufügen.74 Damit können schnell große Mustermengen erreicht 
werden, deren Erkennungsleistung allerdings vor dem Einsatz kontrolliert werden sollte. 

 In jedem Fall sollte der Zustand der Musterbibliothek vor dem „Autolearn“ gesichert werden, 
und es empfiehlt sich, durch vergleichende Tests das materialbezogen günstigste Konfidenzin-
tervall zu ermitteln. 

73 Das Starten der OCR geschieht selbsttätig beim Laden eines Bildes („File > Load Image“) oder wenn die bda-Konfigurationsdatei ein gespeichertes Image 
enthält, dann schon beim Öffnen der bda-Datei („File > Open“).

74 Achtung, im normalen exportierenden Batch-Lauf sollte „Autolearn“ dagegen deaktiviert werden, um die Musterbibliothek nicht ungewollt zu verändern!

(a) BIT-Alpha
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Sequencer
Für Zeichenwerte, special values und Kombinationen aus diesen können im sogenannten Sequencer 
(„OCR > Library > Sequencer“) feste unmittelbar nach der OCR vorzunehmende Ersetzungen definiert 
werden, die es beispielsweise ermöglichen, als special value gelernte Zeichenteile miteinander oder mit 
einem benachbarten Zeichen zusammenzusetzen oder Abbreviaturen zu interpretieren. Diese Ersetzun-
gen dienen weniger der Korrektur echter OCR-Lesefehler als vielmehr der Behandlung erwartungs-
gemäß anfallender punktueller OCR-Ergebnisse, die lediglich einer regulären Umwandlung in einen 
Ziel-Zeichenwert bedürfen.
      
Speicherung, Bearbeitung, Zusammenführung
Muster, die im bit-Musterdateiformat vorliegen, können mit dem Mustereditor „BIT-Knowledge“ bear-
beitet werden; möglich ist u. a. die Bearbeitung einzelner gespeicherter Muster (Entfernen, Zuweisung 
eines anderen Zeichens usw.). Hier steht allerdings keine bildliche Ansicht der Muster-Repräsentation 
mehr zur Verfügung, was den Umgang mit den von BIT-Knowledge angezeigten Muster-Einträgen sehr 
einschränkt.75

46 Trainingsfenster in BIT-Alpha
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75 Der häufigste Anwendungsfall war das Löschen von einzelnen falsch klassifizierenden Mustern, wie sie z. B. durch Tippfehler beim Training oder durch ein zu 
großzügiges automatisches Lernen angelegt werden können. Da man nur den Zeichenwert des zu löschenden Musters sieht, ist nicht ganz auszuschließen, dass 
hierbei vielleicht eine „gute“ Musterrepräsentation gelöscht wird; man löscht in BIT-Knowledge gewissermaßen nur noch „eines der Muster, welche für die fal-
sche Klassifikation zu einem Zeichen x verantwortlich sind“. Für schon in BIT-Alpha bemerkte (oder dort wiederfindbare) Fehler ist die Situation etwas besser: 
hier kann man im Layer „OCR“ für ein konkretes Zeichensegment (anklicken) dasjenige Muster löschen, „das für diese falsche Klassifikation verantwortlich 
ist“. Es scheint in jedem Fall ratsam, nach dem Löschen eines Mustereintrags zu dessen Zeichenwert sicherheitshalber einige „gute“ (typische) neue Muster zu 
lernen.
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In BIT-Alpha kann nicht mehr als eine bit-Musterdatei geladen werden, der Mustereditor „BIT-Know-
ledge“ dient deshalb auch zum Zusammenfügen verschiedener bit-Dateien in eine einzige, damit die 
Muster aus beiden genutzt werden können. Hierzu müssen die Musterbestände je selbst in einer bit-
Musterdatei vorliegen;76 dann kann zu einer ersten geladenen Musterdatei77 eine weitere hinzugeladen78 
und die Gesamtmustermenge gemeinsam in einer bit-Musterdatei gespeichert werden.79 Dieses Hinzu-
mischen einer weiteren Musterdatei kann mit weiteren bit-Dateien wiederholt werden.
 Achtung: Wenn außer Mustern auch Sequenzen in den beteiligten bit-Dateien gespeichert sind, wer-
den beim Mischen nur die Sequenzen der zuerst geöffneten bit-Datei übernommen.

47 BIT-know Mustereditor

76 D. h. wenn sie bis dahin nur in einer bda-Konfigurationsdatei gespeichert waren, muss daraus erst eine bit-Musterdatei angelegt werden 
 (in BIT-Alpha: „OCR > Library > Save“)
77 In BIT-Knowledge: „Load ...“
78 In BIT-Knowledge: „Merge ...“
79 In BIT-Knowledge: „Save ...“
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Grafische Benutzeroberfläche (GUI)
Jede Stelle auf der gelesenen Seite, z. B. in der Ansicht (Layer) „OCR“, ist per Maus frei erreichbar; man 
kann also wählen, ob man nur schwerpunktmäßig markante Zeichen trainieren oder den ganzen Text durch-
gehen möchte. Nach Anklicken eines Zeichenbereichs wird das Trainingsfenster „Verify Recognition“ ak-
tiv. Darin wird das optische Muster binarisiert und in der der OCR-Engine vorliegenden Form noch einmal 
gezeigt, so dass beurteilt werden kann, ob diese Vorlage typisch genug ist und ihr ein Zeichenwert zugewie-
sen werden soll oder nicht. Statt eines Zeichenwerts kann einem Muster auch ein special value (selbstde-
finierter Code) zugewiesen werden, auf den im Sequencer kontextabhängig zurückgegriffen werden kann. 
Sinnvoll ist das z. B. für separat segmentierte Buchstabenteile oder für mehrdeutige Zeichen wie das runde 
„r“, das in der etc.-Abbreviatur ausnahmsweise als „et“ aufzulösen ist. 
 Jedem Muster wird ein „Font“ zugewiesen, der zunächst eine Information zur Ausgabeformatierung 
ist. B.I.T. empfiehlt die Font-Zuweisung als Mittel zur unterschiedlichen Behandlung von Mustern ver-
schiedener Schriftfamilien, d. h. Fraktur einen anderen Font zuzuweisen als Antiqua. Eine andere Art, 
beim Training die Schriftfamilie zu vermerken, gibt es nicht; insofern auch keine Möglichkeit, aus einer 
Musterdatei die Muster der Schriftfamilien separat zu extrahieren.      
 Die Anordnung der Bedienelemente im Fenster „Verify Recognition“ erfordert viel Aufmerksamkeit 
zur Vermeidung von Fehleingaben und teilweise umständliche Tastatur- und Mausaktionen; Hinweise 
zu einer möglicherweise günstigeren Ergonomie wurden dem Hersteller gegeben. 
 Per Standardeinstellung („OCR > Autorefresh“ aktiviert) wird nach jeder neuen Musterstringeingabe 
eine OCR-Analyse mit der neu kompilierten Musterbibliothek gestartet, wodurch die OCR-Ansicht so-
fort die nach dem Lernschritt neu bzw. anders erkannten Zeichen – wieder nach Erkennungssicherheit 
farbig abgestuft – anzeigt. Diese Neuanalyse benötigt je etwas Zeit; für ein zügiges Training kann „Au-
torefresh“ auch deaktiviert werden – dann folgt der Musterstringeingabe keine Verzögerung – und eine 
Neu-OCR lässt sich jederzeit per „OCR > Refresh“ manuell erzwingen. 
 Der Sequencer („OCR > Library > Sequencer“) wird in einer Eingabemaske „OCR-Sequence Mana-
ger“ bedient; auch hier wurden Hinweise zur Ergonomie an den Hersteller gegeben. In den getesteten 
Versionen von BIT-Alpha musste speziell beachtet werden, dass entgegen der Intuition eine neue Se-
quenz offenbar nicht erst bei Betätigung des OK-Buttons dieses Fensters angelegt und gespeichert wird, 
sondern bereits beim Editieren der Zeichenwerte und ohne Hinweis. 
 Die Oberfläche zur Musterbearbeitung in BIT-Knowledge eignet sich gut zum Bearbeiten bzw. Lö-
schen einzelner Muster und zum Zusammenfügen zweier bit-Musterdateien, solange keine Konflikte 
wegen dort mitgespeicherter Sequenzen eintreten können, auf deren implizite Übernahmepriorität nicht 
hingewiesen wird. Eine effektive Bearbeitung von vielen Mustern auf einmal scheitert an der unüber-
sichtlichen Auflistung (fehlende Sortierbarkeit, keine Mehrfachselektion).   
  

Die FineReader-Engine bringt auch für Fraktur einen Grundbestand an Mustern (built-in patterns) mit; 
es muss also nur dann trainiert werden, wenn – wie bei Alten Drucken oder bei speziell gestalteten Let-
tern – die built-in patterns den Drucktypen der Vorlagen nicht gut genug entsprechen. 

Training
Zum Training wird eine Seite wie zur OCR bereitgestellt („Bild öffnen > Ordner wählen > Ordner wäh-
len“); vor dem Trainingslauf muss zunächst im Reiter „Einstellungen“, Feld „Erkennungsmuster“ (bei 
deaktivierter Checkbox „Musterdatei verwenden“) die Checkbox „Training“ aktiviert werden, und es 
muss eine ptn-Musterdatei erstellt bzw. – falls schon existent – ausgewählt werden (Button „..“ neben 
dem Textfeld mit dem Dateinamen der Musterdatei). Wie zur OCR können Sprachen bzw. Sprachen-
gruppen und Schriftfamilien eingestellt werden. Dann kann der Trainingslauf wie ein OCR-Lauf gestar-
tet werden („OCR starten > Aktuelles Bild lesen“).

PRAkTISCHER SOFTWARETEST unD -VERGLEICH I
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Die recht problematische, von den FineReader-Bausteinen bestimmte Benutzerführung des Trainings 
erzwingt im Prinzip ein komplettes lineares Durchgehen der Seite vom ersten Zeichen zum letzten. In 
einem Fenster wird der Bildausschnitt um das aktuelle Segment herum jeweils binarisiert und vergrößert 
dargestellt, und dem markierten Muster kann ein Zeichenwert zugeordnet werden. Möglich sind nur 
Zeichenwerte innerhalb der für die Sprachengruppe eingestellten Zeichen – der Anwender muss also 
bereits vor dem Training alle im Bestand möglicherweise vorkommenden Sonderzeichen (Diakritika, 
Zeichen anderer Sprachen) kennen und bereitstellen. Nach Durchlaufen der Seite wird die Musterdatei 
gespeichert, und es kann eine weitere Seite aufgerufen werden.

Speicherung, Bearbeitung, Zusammenführung
In einem Mustereditor-Fenster (Fenster „User Pattern“) können die in einer ptn-Datei gespeicherten 
Muster in der bitonalen optischen Form mit dem Zeichenwert angezeigt, gelöscht und wohl umdefiniert 
werden. In begrenztem Rahmen ist eine Mehrfachselektion zur Löschung mehrerer Muster auf einmal 
möglich. Nicht vorgesehen ist eine Zusammenführung verschiedener Musterdateien. 

Grafische Benutzeroberfläche (GUI): 
Speziell die von FineReader vorgegebenen Bildschirminteraktionen beschränken unnötig den Spielraum 
und die Effizienz beim Training und bei der Bearbeitung der Musterdateien. Entsprechende Hinweise 
wurden an den HK-OCR-Hersteller gegeben, der trotz Konsultationen mit ABBYY offenbar bisher kei-
ne Möglichkeit zur Bearbeitung dieser Bausteine bekommen hat. Auch eigene Nachfragen bei einer 
ABBYY-Regionalvertretung zeigten, dass die Benutzerfreundlichkeit der Trainingswerkzeuge nicht als 
aktuelle Aufgabe gesehen wird; verschiedenen während der Projektlaufzeit in Deutschland erreichbaren 
ABBYY-Vertretern schien die Möglichkeit eines (sinnvollen) anwenderseitigen Muster-Trainings nicht 
einmal bekannt zu sein. 
      

48 Trainingsfenster in Hk-OCR80

80  Im Beispiel: Die OCR „erkannte“ die Ligatur „fi“; im Training ist Gelegenheit zur Eingabe der richtigen Zeichenfolge „si“. - Bei diesem eher schlechten Muster 
wird man auf ein Training aber vermutlich verzichten, um die Erkennung der „fi“-Ligatur nicht zu beschädigen.
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In der Trainingssituation (Fenster „Pattern Training“ der FineReader-Engine) wird der Benutzer-Zeit-
aufwand durch eine ineffektive Führung durch die Bildseite immens in die Höhe getrieben. Die wich-
tigsten Nachteile sind:

–  Es ist nicht möglich, eine Trainingssequenz an beliebigen Orten innerhalb der Seite zu beginnen 
und zu beenden. Die Navigation verläuft in Einzelschritten vorwärts. Man kann das Training 
nur am Anfang der Seite beginnen und muss daher, auch wenn man etwa nur am Ende der Seite 
ein paar Zeichen trainieren will, jedes Zeichen der ganzen Seite noch einmal bestätigen oder 
explizit überspringen (mit großem Zeitverlust und der Gefahr, beim „Durchklicken“ bereits 
gelernte Muster-Zeichen-Paare zu beschädigen).

–  Ein Rückschreiten (zur Korrektur von bemerkten Fehleingaben) ist nur in Einzelschritten und 
nur innerhalb desselben Worts möglich. 

–  Oft werden dagegen automatisch Zeichen(gruppen) ohne Vorwarnung übersprungen, offenbar 
dann, wenn sie mit hohem Konfidenzwert gelesen wurden. Abgesehen davon, dass auch dort in 
Einzelfällen ein Korrektur- oder Trainingsbedarf bestehen kann, zwingt die ständige Unbere-
chenbarkeit, ob nach einer Eingabe wirklich das nächstfolgende oder aber ein viel späteres Mus-
ter ins Trainingsfeld eingetragen wird, zu einer unnötigen Verlangsamung des Trainingsgangs. 
Bei zügiger Arbeitsweise bestätigt man per Enter-Taste oder Button leicht einen String, der auf 
das nach Schrittfolge erwartete Muster gepasst hätte, versehentlich für ein ganz anderes Muster. 
Wenn der Sprung dabei die Wortgrenze überschritten hat, ist dadurch ein Zurückschreiten zum 
eben eingegebenen Zeichen nicht mehr möglich, und die Fehleingabe wird unweigerlich in die 
Musterdatei übernommen. Eine Korrektur im Mustereditor ist zeitaufwendig und hängt von der 
Wiedererkennung des richtigen Zeichenbilds ab. 

–  Die im Fenster „Pattern Training“ angebotenen Tasten sind zumindest im deutschen Tastatur-
layout nicht immer günstig, es kommt zu ungünstigen Maus-Tastatur-Wechseln und zu einer 
Erleichterung unerwünschter Aktionen gegenüber erwünschten.

Im Mustereditor („Edit Musterdatei“), ebenfalls einer FineReader-Komponente, fiel auf:  
 

–  Das angezeigte Fenster „User Pattern“ ist viel zu klein, es zeigt je nur 2 x 3 Muster in einer 
nicht änderbaren Reihenfolge und kann nicht vergrößert werden. Für einen Überblick fehlt die 
Möglichkeit, das Fenster so groß zu ziehen, dass wesentlich größere Mustergruppen miteinan-
der optisch verglichen werden können. 

–  Die in „Edit Musterdatei“ vorgesehene Möglichkeit, gespeicherte Muster-Zeichen-Zuordnun-
gen zu ändern, scheint noch nicht zu funktionieren. Während des Tests ist zwar das Löschen 
einzelner Muster gelungen, nicht aber das Ändern des zugewiesenen Strings.

      

PRAkTISCHER SOFTWARETEST unD -VERGLEICH I
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Modularität
Um die Stärken selbst trainierter auf konkrete Drucke bezogener Muster ausnutzen zu können, wird eine 
freie Kombinierbarkeit und Teilbarkeit von Musterbibliotheken benötigt. Hierzu wäre ein dokumentier-
tes, für den Nutzer verständliches Speicherformat für Muster gefragt, das u. a. Attribute der einzelnen 
Muster verwalten kann, nach denen Teilbestände selektiert werden können usw. Ideal wäre natürlich 
eine anwendungsübergreifende Austauschbarkeit trainierter Muster (s. Kap. 6.4).

Evaluation
Ehe überhaupt sinnvolle Evaluationswerkzeuge konzipiert werden können, müssen Musterbibliotheken 
in einer jederzeit auslesbaren und miteinander vergleichbaren Form vorliegen.

Benutzerschnittstelle
Hinsichtlich der graphischen Benutzerführung könnten beide Programme voneinander lernen. Unerläss-
lich sind die freie Navigation an eine beliebige Stelle sowie die freie Unterbrechung und unverzögerte 
Wiederaufnahme des Trainingsgangs. 
 Restriktionen im Alphabet der zulässigen Zeichenwerte sollte es nicht geben, da prinzipiell jede 
Druckvorlage, von der noch kein elektronisch durchsuchbarer Volltext vorliegt, etwas Unvorhergesehe-
nes enthalten kann. 
 Der Mustereditor muss eine übersichtliche Ansicht der gespeicherten Muster bieten, d. h. sortierbar, 
in größenverstellbarem Fenster, mit Mehrfachauswahl und verständlich bezeichneten Aktionen.

49 Hk-OCR Mustereditor

Desiderata, kriterien für Alternativen
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4.5 Batch-spezifische Aspekte

Wie bereits angedeutet (s. Kap. 3.1.7), hängt die Qualität von Massen-OCR davon ab, ob die verwen-
deten Parameter, Musterbestände und Lexika so gut auf die Gruppe der gemeinsam zu verarbeitenden 
Bilder abgestimmt sind, wie es in der Einzelseitenbearbeitung möglich ist. 
Die Software hat hier nur insofern Einfluss, als sie 

–  diese Gruppierung in irgendeiner Form unterstützen könnte, z. B. durch Kennziffern zur nach-
träglichen Selektion von Seiten, die gut oder schlecht auf einen OCR-Lauf angesprochen haben 
oder

–  Konfigurationsparameter innerhalb eines Stapels zu wechseln in der Lage ist.
      
Außerdem wird die Flexibilität der Gruppenbildung davon beeinflusst, ob Quell-(Bild-)Dateien zur 
Stapelverarbeitung erst in ein gemeinsames Arbeitsverzeichnis kopiert werden müssen, oder auch wie 
leicht und sicher ggf. der Abbruch und die Weiterführung einer Stapel-Verarbeitung möglich sind usw.
      

Eine Vorab-Gruppierung wird nicht unterstützt, sie muss daher vom Anwender geleistet werden.
 BIT-Alpha bietet keine für den Anwender erreichbare Auswertung von Kennziffern, die eine nach-
trägliche Gruppierung der Bilder in „fertige“ und „nachzuprozessierende“ erleichtern würden. Auch der 
XML-Export enthält keine diesbezüglich auswertbaren Attribute. Für den Ergebnistext könnte der An-
wender selbst z. B. den Bezug zum Wörterbuch herstellen und eine Art Worterkennungsrate bestimmen. 
 Die in einem Batch-Lauf zu bearbeitenden Bilder müssen in ein und demselben Verzeichnis liegen; 
dann kann nach Laden der gewünschten bda-Konfigurationsdatei und den üblichen Einstellungen der 
Batch-Prozess per „File > Batch process ...“ konfiguriert (Exportformate festlegen usw.) und angestoßen 
werden. Zu beachten ist, dass das ebenfalls in diesem Dialog untergebrachte „Autolearn“ (s. Kap. 4.4) 
im normalen (Export-)Batchlauf deaktiviert sein muss, um die Musterbibliothek nicht ungewollt zu 
verändern.
 Die gewählten Exportformate werden in Unterverzeichnisse eines wählbaren Exportverzeichnisses 
geschrieben. Wenn außer den sparsamen Text-, HTML- und XML-(ALTO)-Formaten auch das Bilder 
enthaltende PDF exportiert wird, ist auf ausreichend Speicherplatz im Dateisystem des Exportverzeich-
nisses zu achten. 
 Zur Fortsetzung einer abgebrochenen Stapelverarbeitung war es am praktischsten, je die bereits ver-
arbeiteten Bilder aus dem Quellverzeichnis zu entfernen oder überhaupt neue Verzeichnisse zu benut-
zen.
      

Eine Vorab-Gruppierung wird nicht unterstützt, sie muss daher vom Anwender geleistet werden.
 HK-OCR legt bei jedem OCR-Lauf zu jedem layout auch Protokolldateien an, in denen statistische 
Kennziffern der aktuellen OCR festgehalten werden und die bei eingeschaltetem voting schon von HK-
OCR selbst zur automatischen Auswahl des nach diesen Kennziffern „besten“ OCR-Versuchs genutzt 
werden. Eine genaue Dokumentation der Bedeutung der einzelnen Werte lag der Software nicht bei, 
sollte aber erhältlich sein. Sinnvolle Interpretierbarkeit vorausgesetzt, könnten sich diese Werte wegen 
des Textformats der Protokolle auch nach Stapelverarbeitungen maschinell auswerten lassen, ebenso die 
im Finereader-XML-Export (s. Screenshots einer FineReader-XML-Ausgabe im Anhang 7.1) enhalte-
nen Attribute zur Zeichenerkennungskonfidenz („charConfidence“) und zum Vorkommen des gelesenen 
Worts im Wörterbuch („wordFromDictionary“).81

 Die in einem Batch-Lauf zu bearbeitenden Bilder müssen in ein und demselben Verzeichnis liegen, 
das zugleich das Ausgabeverzeichnis ist. Wegen der pro Originalbild entstehenden FRImage-Dateien, 
die stets etwas größer sind als die Originalbilddatei, muss der freie Speicherplatz im Dateisystem des 
Verzeichnisses noch einmal etwas größer sein als die Gesamtdateigröße der Bilder.

81 Vgl. die Hinweise zur kritischen Anwendbarkeit solcher Kennzahlen in den Best-Practice-Guides des IMPACT-Projekts (ANDERSON 2010)
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Der Status der Verarbeitung jedes Bilds aus dem Batch-Lauf wird in einer Liste in HK-OCR angezeigt 
und in einer XML-Datei im Ausgabeverzeichnis vermerkt. Solange diese Steuerdatei („_BildDateien.
xml“) erhalten ist, kann eine abgebrochene Stapelverarbeitung leicht wieder aufgenommen werden und 
überspringt die bereits als verarbeitet und gespeichert vermerkten Bilder. Abbrüche traten vereinzelt 
spontan auf, möglicherweise wegen geringer Zugriffsverzögerungen auf ein Netzlaufwerk. Sicherheits-
halber sollte nach jedem unterbrochenen Batch-Prozess die Vollzähligkeit der XML-Exporte überprüft 
werden; eventuell fehlende einzelne Seiten können dann leicht manuell nachprozessiert werden. Hierzu 
kann es notwendig werden, per Kontextmenü den in der Stapel-Übersicht von HK-OCR vermerkten 
„Status“ der jeweiligen Bilddatei zurückzusetzen. 
     

Zu den im Folgenden angedeuteten Anforderungen werden im Abschnitt 6.4 konkrete Abhilfemöglich-
keiten beschrieben.
      
Granularität
Batch-Verarbeitung ist aus sich heraus nicht davon abhängig, dass die zu verarbeitenden Bilder in ein 
und demselben Verzeichnis liegen. Außerdem müssen lange Batch-Läufe gelegentlich unterbrochen und 
dann nur für den Rest fortgesetzt werden, oder man will von vornherein nur bestimmte Bilder verar-
beiten. Es gibt keinen nachvollziehbaren Grund, dass im Dateisystem erreichbare Quellbilder erst in 
ein Arbeitsverzeichnis gebracht werden müssen, und dass der Stapel vom Inhalt dieses Verzeichnisses 
bestimmt wird. 
 Es sollte zudem auch innerhalb eines Stapels möglich sein, für die Bilder wechselnde Parameter, 
Muster- und Wortbibliotheken vorzusehen. Die innerhalb üblicher Stapel zu beobachtenden erheblichen 
Qualitätsunterschiede der Fraktur-OCR rechtfertigen den Aufwand allemal, und mit etwas Glück geben 
bereits die Umfangsangaben im Katalog oder die Metadaten der Digitalisate für Seitenbereiche deren 
Schriftart und Sprache an.

Evaluation
Würde die Software geeignete statistische Indikatoren zur Abschätzung der Erkennungsgüte der einzelnen 
Seiten bereitstellen, dann könnten so ermittelte ungenügende Seiten nachträglich einer Neu-OCR mit anderen 
Mustern – oder anderen Wörterbüchern – zugeführt werden. Für Szenarien, in denen genügend Rechenzeit 
gegeben ist, sollte es möglich sein, heterogenes Material von vornherein parallel mit verschiedenen Muster-
dateien bzw. Wortlisten zu verarbeiten und aus den Ergebnissen das je geeignetste zu selektieren.

Benutzerschnittstelle
In beiden Programmen müssen Konfigurationen bisher auch dann per Bildschirminteraktion ausgewählt 
werden, wenn sie fertig in Parameterdateien vorliegen. Für eine Stapelverarbeitung mit vorab festste-
henden Konfigurationen sollte aber neben der Bildschirminteraktion stets auch ein nicht-interaktives 
Anstoßen auf Kommandozeilen-, Batch-/Skript- oder Ticket-Ebene möglich sein (konventionelle Über-
gabe der Arbeitsverzeichnisse und der jeweiligen Parameter-, Muster- und Wörterbuchdateien). 

Desiderata, kriterien für Alternativen
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4.6 Voraussetzungen und Randbedingungen des Softwareeinsatzes

Für beide Produkte wurden übliche Windows-PCs (Prozessoren Intel Core 2 Duo E8400 mit 3,0 GHz, 
Arbeitsspeicher 2GB, Betriebssystem Windows XP Professional SP 3) genutzt. Solange nur mit einer 
Instanz des jeweiligen Programms gearbeitet wird, haben diese Hardwarevoraussetzungen genügt; be-
stimmte Verarbeitungsphasen der OCR lasten den PC dabei zeitweise sehr aus, so dass von gleichzeiti-
ger Arbeit in anderen Anwendungen abzuraten ist.

Lizenzmodell
Die Standalone-Anwendung BIT-Alpha (ebenso der Mustereditor BIT-Knowledge) wird als Anwen-
dung lizenziert, hierzu ist eine Aktivierung unter Administratorrechten nötig.

Installations- und Betriebsvoraussetzungen
Zum Betrieb von BIT-Alpha genügt ein Einzelplatz-PC mit einem aktuellen Windows-Betriebssystem 
(ab XP). Eine möglichst gute Prozessorleistung (Mehrkernarchitektur) ist angeraten. Für jede Seite ist 
größenabhängig mit mehreren Minuten OCR-Analyse zu rechnen. Die Priorität des Programms für das 
Betriebssystem kann in der Benutzeroberfläche eingestellt werden, z. B. um sie herabzusetzen, wenn 
der PC gleichzeitig für anderes genutzt werden muss und längere OCR-Zeiten hingenommen werden 
können („File > Settings > System > Thread Priority“).

Angebot als Dienstleistung
B.I.T. bietet wahlweise die Komplett-OCR (vom Bild zum Exportformat) oder die Unterstützung an-
wenderseitiger OCR (Konfiguration der Binarisierungsparameter, Übernahme von Training usw.) auch 
als Dienstleistung an.

Lizenzmodell
HK-OCR wurde als Anwendung von Herrmann & Kraemer zeitlich befristet lizenziert und ermöglicht 
gesondert die Neu-OCR bzw. die Korrektur („Validierung“) von Seiten, für die bereits eine FRIma-
ge-Datei im Arbeitsverzeichnis vorliegt. Zur erstmaligen OCR jedes Bilds (zugleich: Erstellung der 
FRImage-Datei) wird außerdem eine ABBYY-Volumenlizenz benötigt. Hierzu muss entweder auf dem 
Arbeitsrechner oder auf einem im Netzwerk erreichbaren Rechner der ABBYY-Lizenzmanager instal-
liert sein und erworbene Seitenlizenzen enthalten. 

Installations- und Betriebsvoraussetzungen
Sowohl zum Betrieb von HK-OCR als auch für den ABBYY-Lizenzmanager genügen Einzelplatz-PCs 
mit einem aktuellen Windows-Betriebssystem (ab XP). Die Installation und Aktivierung erfolgt jeweils 
unter Administratorrechten. Der ABBYY-Lizenzmanager kann entweder ebenfalls auf dem OCR-Rech-
ner oder auf einem anderen per Netzwerk erreichbaren Rechner installiert werden und betreibt offenbar 
einen ständig laufenden Dienst. Der Lizenzmanager muss während der OCR ständig und nicht nur „ein-
mal je Image“ erreichbar sein; auch bei nur sehr kurzzeitigem Aussetzen der Verbindung zum Lizenzma-
nager-Rechner wurden HK-OCR-Stapel ohne direkte Fortsetzungsmöglichkeit abgebrochen. Für jede 
Seite ist größenabhängig mit mehreren Minuten OCR-Analyse bzw. Exporterstellung zu rechnen. 

Angebot als Dienstleistung
Herrmann & Kraemer bietet die OCR auch als Dienstleistung an, ggf. auch in einem integrierten Work-
flow mit weiteren Komponenten. 

  

PRAkTISCHER SOFTWARETEST unD -VERGLEICH I

(b) Hk-OCR / FREngine 9

(a) BIT-Alpha
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5 Praktischer Softwaretest und -vergleich II: Optimierungsversuche  
 durch Sortierung, Binarisierungsparameter, Training und Lexika

Zur Beurteilung der in jeder Software variierbaren OCR-Faktoren waren viele parallele OCR-Läufe 
erforderlich, die sich jeweils in möglichst wenigen Bedingungen unterscheiden durften. 
 Als Material verwendet wurden insbesondere eine Marge aus sehr homogenen Gedichtzeilen 
(Druckort: Königsberg) und eine Marge, in der die zwei nächst kleineren Schriftgrade bei verwand-
tem Typenbild überwogen. Für bestimmte Musterbibliotheken wurden darüber hinaus bewusst die mit 
Schriftvarianten überladenen Titelblätter herangezogen, um möglichst schnell eine große Vielfalt zu 
erreichen (Vgl. Kap. 2.6, Abb. 36).       
    

50 Tabellarischer Vergleich der OCR-Läufe; längere rote Zeichenlisten bedeuten mehr Erkennungsfehler

Methodik
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Für beide Schriftgruppen wurden Stichproben festgelegt, die manuell transkribiert wurden und als Re-
ferenz zur skriptgesteuerten Ermittlung von OCR-Fehlern der verschiedenen Testläufe dienten. Das 
Training erfolgte konsequent auf Seiten, die nicht den Stichproben angehörten.82 Verglichen wurden 
die unter verschiedenen Bedingungen entstandenen OCR-Ergebnistexte einerseits durch tabellarische 
Gegenüberstellung der Volltext-Resultate, andererseits durch die Liste der „fehlenden“ und die Liste der 
„fälschlich gelesenen“ Zeichen einer Seite.          
 Die Längen dieser Listen dienten als einfache Maßzahlen zum relativen Vergleich verschiedener 
OCR-Läufe, d. h. um festzustellen, wann eine Konfigurationsänderung einen Fortschritt erbrachte und 
wann nicht. Als realistische „Fehlerrate“ für die Zeichen-Ebene sind diese Zahlen nicht zu interpretieren.83  
 Wegen der vielen Einflussdimensionen konnten bei weitem nicht alle interessanten Parameterkombi-
nationen getestet werden; oft musste in einer Art Wege-Auswahl frühzeitig entschieden werden, welche 
günstige Parameteränderung weiterverfolgt wird und welche ungünstige nicht. 
   

82 Zu beachten bleibt, dass in OCR-Prozessen immer wieder eine so große Schwankung der Erkennungsrate beobachtet wird, dass jeder Schluss von der Stichprobe 
auf die Gesamtheit auch hinterfragt werden kann. Die Statistik fordert, dass für solche Inferenzen entweder eine echte Zufallsauswahl oder eine „repräsentative“ 
(Quoten-)Stichprobe vorliegen muss; beides ist für Images gescannter Buchseiten schwer herzustellen.
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Zur Visualisierung der unübersichtlichen Ergebnismengen wurden die verschieden konfigurierten Batch-
läufe in einem Ableitungsdiagramm dargestellt, in dem die gezählten Fehleranteile nicht nur genannt, 
sondern auch als Farbwert zwischen Rot und Grün dargestellt wurden. So konnten die aussichtsreiche-
ren Zweige der Versuchsanordnung schnell gefunden und auf weniger aussichtsreiche Konfigurations-
gruppen früh verzichtet werden (vgl. Abb. 54 u. 58). 
           

Gruppierung
Wegen der Möglichkeit, verschiedene Musterdateien zu mischen, ist ein zunächst separates Training 
relativ reiner Zeichenbestände in BIT-Alpha unproblematisch, wenn die Muster später auch kombiniert 
genutzt werden sollen. Etwas einschränkend wirkt das Zusammenspiel der Muster mit den eingegeben 
Sequenzen: verschiedene zu kombinierende Musterdateien sollten auf ähnliche Sequenzen zurückgrei-
fen, um nach dem „Merging“ ihre Erkennungsleistung zu behalten. 
 Die trainierten Muster einer Schriftgröße haben bis zu einem gewissen Grad auch Zeichen anderer 
Schriftgrößen richtig klassifiziert, d. h. es gibt eine gewisse Toleranz gegenüber Größenabweichungen. 

Binarisierungs- und Segmentierungsparameter
Wegen der Komplexität der vorzunehmenden Einstellungen wurden die bda-Dateien überwiegend vom 
Dienstleister konfiguriert und bereitgestellt. Zusätzlich wurden auch im Projekt einige bda-Dateien ex-
perimentell abgewandelt oder von Grund auf selbst eingerichtet, um die Wirkung bestimmter Parameter 
kennenzulernen. Einige Hinweise hierzu finden sich im Anhang 7.3; ein erläuterndes Handbuch bleibt 
einzufordern.
 Durch vergleichende OCR-Läufe verschiedener bda-Dateien auf denselben Seiten mit gleichem Trai-
ningsstand konnten anhand der Fehlerzählung die günstigeren bda-Konfigurationen ausgewählt werden, 
z. B. wurde so der zur Marge passende Binarisierungsalgorithmus gewählt (hier: „Niblack“). 
 Gelegentliche sprunghafte Unterschiede in der „Fehlerrate“ derselben Stichprobe konnten auch auf 
den Ausfall ganzer Absätze hindeuten, wenn bestimmte Segmentierungsparameter auf einzelnen Seiten 
einen Textblock fälschlich als Bildregion klassifizierten (genauere Hinweise hierzu im Anhang 7.3). 
Erkennbar war das am ehesten visuell in einer tabellarischen Textübersicht (auffällige Lücken, lange 
Fehlerlisten) oder durch einen maschinellen Vergleich der Textlänge mit anderen OCR-Läufen dersel-
ben Seite (beides wurde von der Software selbst leider nicht bereitgestellt; vgl. Abb. 51). 
      
Training      
Solange man der Benutzerführung im Training folgt und schwerpunktmäßig die nicht erkannten sowie 
die farbig hervorgehobenen besonders unsicher erkannten Zeichen trainiert, ergibt sich eine automati-
sche Verbesserung der Erkennungsleistung mit fortschreitendem Training von selbst. Im Zweifelsfall 
kann per manuellem oder automatischem refresh der Anzeige nach jedem Trainingsschritt zumindest für 
den Bereich der aktuell geöffneten Seite sofort kontrolliert werden, ob mit dem Lernfortschritt für das 
trainierte Zeichen unerwünschte Verschlechterungen der Erkennung anderer Zeichen eingetreten sind 
(farbige Markierungen ändern sich; vgl. Abb 52). 

83  Auf standardisierte, extern vergleichbare statistische Maße wurde verzichtet, da sie softwaremäßig nicht unmittelbar bereitstanden und ihre aufwendige Einbe-
ziehung in den Software-Test der Fragestellung des Projekts nicht entsprochen hätte. Der wie beschrieben gezählte Anteil „fehlender“ Zeichen kann zumindest 
als echte Untergrenze der Fehlerrate auf Zeichen-Ebene gelten. Andere Fehlerarten blieben ausgeklammert: z. B. erscheinen Buchstabenvertauschungen („un“ 
statt „nu“) in diesen Listen nicht; ebenso wurden Weißraum-Fehler wie fehlende oder falsche Spatien bewusst aus der Zählung ausgenommen – sie hätten 
wegen der sehr unterschiedlichen Verhältnisse im Drucksatz und entsprechenden Abgrenzungsproblemen (ab wann sollen nicht erkannte Wortzwischenräume 
als OCR-Fehler gelten?) einen unverhältnismäßig hohen und unberechenbar schwankenden Anteil eingenommen und die wichtigeren Differenzen in der echten 
Zeichenerkennungsleistung vermutlich überdeckt. Die Liste „überschüssiger“ Zeichen kann hingegen Unterschiedliches bedeuten: echte Lesefehler sind es 
dann, wenn sie falsche Lesarten tatsächlich vorhandener Druckzeichen darstellen; daneben erscheinen hier aber auch Artefakte von fälschlich als Zeichen inter-
pretierten Bildelementen, Durchdruckstellen der Rückseite usw., die eine Nutzbarkeit der so entstandenen Volltexte nicht im selben Maße beeinträchtigen und 
daher als Fehler schwächer gewichtet werden können.

(a) BIT-Alpha
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Spezieller Evaluierungsbedarf besteht für das in 
BIT-Alpha mögliche automatische Lernen, bei 
dem Muster, die (noch) nicht im Trainingsbestand 
sind, aber einen Zeichenwert mit gewisser „Wahr-
scheinlichkeit“ klassifizieren, den trainierten Mus-
tern in einem Batch-Lauf (zweckmäßigerweise 
ohne Export) automatisch hinzugefügt werden. Ob 
diese Erweiterung der Musterbibliothek real zu 
einer besseren oder schlechteren OCR-Leistung 
führt, hängt von der Passung der automatisch hin-
zugekommenen Muster zur konkreten Vorlage ab 
und muss an Originalstichproben überprüft wer-
den. Durch die Einstellung des Konfidenzinter-
valls („OCR > Library > Learning parameters“) 
kann gesteuert werden, ob das automatische Ler-
nen die Musterbibliothek eher „vorsichtig“ oder 
eher „großzügig“ erweitert. 
 Auf diese Weise konnten einige gegenüber der 
nur manuell trainierten Mustermenge „besser“ er-
kennende bda-Dateien erstellt werden. 

51 Auswirkung falscher Segmentierung auf Fehlerrate

52 Farbliche Darstellung unterschiedlich „sicher“ erkannter Zeichen

PRAkTISCHER SOFTWARETEST unD -VERGLEICH II
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Wörterbuch
Nachdem die Möglichkeiten der Mustererkennung ausgeschöpft sind, kann eine sorgfältig angelegte 
lexikalische Korrektur noch einen merklichen Fortschritt bringen. Wieder ist das Zusammenspiel meh-
rerer Faktoren in BIT-Alpha sehr komplex und erfordert eine gründliche Vorbereitung mit mehrfachem 
Vergleichstest anhand einer Originalstichprobe. Aufeinander abgestimmt werden müssen:

–  eine gut zur Lexik passende Wortliste, die einerseits möglichst vollständig inklusive aller flek-
tierten Formen und vorkommenden Schreibvarianten sein, andererseits möglichst wenig irre-
levanten Wortschatz enthalten soll. Es kann versucht werden, einmalige bzw. sehr selten vor-
kommende Wortformen zu sichten und ggf. auszuschließen. Ob getrennte Wortteile einzeln 
eingelesen werden können oder zusammengesetzt werden müssen, ist abhängig von den Tren-
nungseinstellungen in der Konfiguration der Lexikalischen Korrektur zu entscheiden. Jedes 
Vorgehen hat Vor- und Nachteile.

–  die Distanz, bis zu der eine Ersetzung überhaupt stattfinden soll (Entscheidung, ob generell eher 
viel oder wenig ersetzt werden soll);

–  die einzelnen Ersetzungskoeffizienten (Erleichterung oder Erschwernis der konkreten Zeichen-
paare, die ausgetauscht werden dürfen).

      
Hier liegt ein hohes Potential an lexikalischer und linguistischer Adaption an das Textmaterial. Die 
entstehenden Konfigurationen (in lx2-Dateien) können gespeichert werden und wären dann für Material 
der jeweiligen Sprache und Epoche wiederverwendbar.

Der Aufwand ist allerdings hoch. Im Testprojekt konnten die Möglichkeiten nicht vollständig ausge-
schöpft werden; bewährt hat sich die Erstellung von Wörterbüchern aus vergleichbarer Literatur (hier 
besonders: Personalschriften, Gelegenheitsgedichte und biographisches Material des 17. Jahrhunderts) 
sowie die Einpflege spezieller Thesauri (hier: zeitspezifische Orts-, Berufs- und Krankheitsbezeich-
nungen) und bereits vorliegender Katalogdaten (Titel- und Personenfelder) der zu lesenden Schriften 
selbst, wodurch auch sehr spezifische passende Wortformen ins Wörterbuch gelangten. Die Pflege und 
Nachbesserung des Wortbestands wird stark behindert durch das binäre, nicht frei editierbare Format 
der lx2-Dateien; dringend wäre eine freie Bearbeitung der Wortliste in einem offenen Textformat erfor-
derlich, in dem jederzeit Such- und Ersetzungsoperationen, Umsortierungen, Löschung und Austausch 
größerer Blöcke usw. möglich sind. 
 Zur Beurteilung des lexikalischen Korrekturschritts sollte neben der Fehleranzahl auch die Art der Feh-
ler betrachtet werden. Wenn etwa eine ursprünglich optisch nahe liegende Verwechslung unter Wörter-
bucheinfluss zu einem optisch unähnlichen neuen Fehler ersetzt wird, dann wäre trotz gleich gebliebener 

53 Einfluss des Lexikons. Rot über dem Text die Listen der fehlenden (<) und überzähligen (>) Zeichen
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Fehlerquote die ursprüngliche Version besser nutzbar als die neue. Insofern können quantitative Maße 
die Fehler lexikalischer Korrektur nur zum Teil abbilden und gelegentlich sogar in der Vergleichsaussage 
falsch liegen. Fällt eine falsche Korrektur gar in einen plausiblen Kontext (gesehen z. B.: Vorlage „bei sich“ 
> OCR „bei stch“ > Korrektur „bei steh“), dann wird auch dem menschlichen Leser, der die fehlerbelasse-
ne Version wohl im Sinne der Vorlage richtig interpretiert hätte, eine falsche Lesart aufgedrängt. 
     

Gruppierung
Eine erste, auf einer sehr homogenen Schriftgruppe trainierte Mustermenge erkannte die speziell zu 
dieser Schriftgröße passenden Seiten sehr gut und bereits Seiten des nächst niedrigeren Schriftgrads 
deutlich schlechter. Die Muster in den ptn-Dateien dürfen demnach als hoch selektiv gelten, was in pas-
senden Einsatzszenarien ein Vorteil sein kann.      
 Eine Anlage separater später kombinierbarer Musterbibliotheken für bestimmte Schrifttypen und 
-größen läge daher für HK-OCR bzw. FineReader besonders nahe. Wegen der fehlenden Möglichkeit 
zum Mischen verschiedener Musterbestände aber erfordert die Mehrfachverwendung eine sorgfälti-
ge Planung bzw. erhöht den Aufwand. Ohne weiteres lässt sich z. B. ein Musterbestand für Schrift X 
trainieren, zunächst in einer X.ptn-Datei speichern, und anschließend könnte für den Einsatz an ge-
mischten Vorlagen der Schriftgruppen X+Y in einer Kopie „XY.ptn“ dieser Musterdatei das Training 
mit Schriftart Y fortgesetzt werden, um eine kombinierte Bibliothek aus beidem zu erhalten. Eine reine 
Y-Mustersammlung ist daraus dann aber nicht extrahierbar, wie umgekehrt ein ggf. rein vorliegender 
Y-Musterbestand nicht der X-Bibliothek hinzugefügt werden kann. Wenn Muster in verschiedenen Mi-
schungen benötigt werden, kann durch diese Beschränkung ein mehrfaches Training bestimmter Vorla-
gen nötig werden.     
 Leicht möglich ist andererseits die Kombination der gewählten Anwender-Muster mit den einge-
bauten FineReader-Mustern, so dass es sich stets lohnt, die drei Alternativen (a) Anwender-Muster, (b) 
FineReader-Muster, (c) beides zusammen an Originalstichproben miteinander zu vergleichen.
     
Binarisierungsparameter, Training, Wörterbuch      
Wegen der in HK-OCR überschaubaren Konfigurationsmöglichkeiten konnten einige Parametervariationen 
auf verschiedenen Trainingsstufen systematisch paarweise unter Konstanthaltung der anderen Bedingungen 
verglichen werden. 

– Muster (,Lohnt sich Training und/oder die Kombination von eingebauten mit trainierten Mustern?‘)
Für die Laborsituation der homogenen ersten Marge konnte sehr schnell die Wirksamkeit des Trainings 
nachgewiesen werden.
 Bereits nach einem Training von 37 Seiten aus Gelegenheitsgedichten Simon Dachs war die Erken-
nung der Stichprobe mit den selbst trainierten Mustern wesentlich besser als die Erkennung mit den 
FineReader-Mustern allein (die Anzahl fehlender Zeichen fiel auf weniger als die Hälfte, die Anzahl 
überschüssiger Zeichen ca. auf ein Fünftel)84 und auch merklich besser als die Erkennung bei Kom-
bination der selbst trainierten mit den FineReader-Mustern (der Anteil fehlender Zeichen sank um ein 
Fünftel, die Anzahl überschüssiger auf unter die Hälfte). Dieser Effekt war unabhängig davon, ob die 
FineReader-Sprache „OldGerman“ oder das Anwenderwörterbuch, und ob in den OCR-Optionen allein 
Fraktur oder die Kombination von Fraktur und Antiqua aktiviert war (vgl. Abb. 54 u. 55).
 Für heterogene Muster ist der Fortschritt erwartungsgemäß langsamer, hier wurde nach Training von 
sechzig Seiten Titelblättern ein Zustand erreicht, in dem der Anteil fehlender Zeichen auch für die OCR 
der obigen homogenen Gedicht-Seiten bei Verwendung nur selbst trainierter Muster fast an die Fine-
Reader-Rate herankam und der Anteil überschüssiger Zeichen bereits deutlich geringer war als bei den 
FineReader-Mustern. Schon weit vorher, ab ca. zehn Seiten Training, war die Erkennung mit den selbst 
trainierten Mustern zwar noch deutlich schlechter als die FineReader-Rate, aber bereits hier brachte die 

84 Auch wenn die Fehlerzählung nicht für sich als Gütemaß gelten kann, dürfen die Unterschiede der so gezählten Fehlerfälle wohl als Hinweis auf analoge Bewe-
gungen anderer Fehlermaße interpretiert werden.

PRAkTISCHER SOFTWARETEST unD -VERGLEICH II

(b) Hk-OCR
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Hinzuwahl der selbst trainierten Muster 
zu den FineReader-Mustern eine stabile 
Verbesserung.
 Für spätere, im 18. Jahrhundert er-
schienene Schriften des SBB-Funeral-
schriftenbestands ändert sich das Bild. 
Erste Tests deuten an, dass für das späte 
17. und beginnende 18. Jahrhundert eine 
Kombination aus den trainierten und den 
FineReader-Mustern häufig das bessere 
Ergebnis erzielt und dass im späteren 18. 
Jahrhundert häufig die FineReader-Mus-
ter auch allein zumindest besser abschnei-
den können als die trainierten Muster des 
17. Jahrhunderts aus dem Projekt. Da 
speziell zu den Schriften des 18. Jahrhun-
derts noch keine Proben trainiert wurden, 
konnte kein echter Vergleich mit solchen 
stattfinden. Eingehendere Tests wären 
sicher nicht aussichtslos. Solange aller-
dings die additive Verwendung speziell 
trainierter Musterbestände ungeklärt ist, 
wird der Aufwand ihrer Erstellung wegen 
der eingeschränkten Nachnutzbarkeit sel-
ten vertretbar sein. 

54 Graphischer Vergleich aufeinander folgender OCR-Läufe mit verschiedenen Musterdateien

55 Vergleich aufeinander bezogener OCR-Läufe mit verschiedenen Musterdateien; die Zahlen zeigen die durchschnittliche Rate fehlender Zeichen pro Seite an
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– Nur-Fraktur- vs. Fraktur-plus-Antiqua-Training (,Lohnt es sich, in Fraktur-Musterdateien An-
tiqua-Muster mitzutrainieren?‘)

Bei der Gelegenheit des Trainings von Titelblättern mit ihrer Vielfalt an Schrifttypen wurde getestet, ob ein 
Mittrainieren der enthaltenen Antiqua-Zeichen die Erkennung reiner Frakturseiten beeinträchtigt. Wenn ja, 
würde man darauf zumindest in einer Musterbiblio-
thek verzichten; wenn nein, könnte von Anfang an 
eine Reserve von Antiqua-Zeichen unbedenklich 
mitgeführt werden, unabhängig davon, wie viel 
Antiqua-Einsprengsel der Text tatsächlich enthält. 
 Wider Erwarten zeigte sich auch auf den Nur-
Fraktur-Seiten stets eine leichte Verbesserung 
der Frakturerkennung, wenn ein gewisser Anteil 
(im Versuch: ca. fünf Prozent) Antiqua-Zeichen 
mittrainiert wurde. Eine Erklärung fällt schwer; 
immerhin bleibt die pragmatische Aussage, hier 
nicht streng separieren zu müssen (vgl. Abb. 56). 

– Schriftfamilien-Checkboxen (,Lohnt sich die Zuwahl von (eingebauter) Antiqua-Erkennung?‘)
Ob die in der HK-OCR-Konfiguration mögliche Zuwahl von „Normalschrift“ einen zusätzlichen Mus-
terbestand in die Erkennung einbezieht oder andere Parameter ändert, war nicht dokumentiert. Der Ver-
gleich der Ergebnisse zwischen Nur-Fraktur- und Fraktur-plus-Antiqua-Läufen ergab, dass nur für die 
FineReader-Builtin-Patterns allein und für noch fast untrainierte eigene Muster durch Zuwahl der An-
tiqua eine Verschlechterung eintrat, in allen Fällen fortgeschrittenen eigenen Trainings und der Kombi-
nation selbst trainierter mit den FineReader-Mustern dagegen eine Verbesserung der Erkennung auch in 
reinen Fraktur-Seiten. Ohne nähere Kenntnis der 
Funktion der Normalschrift-Auswahl fällt eine In-
terpretation dieses Befunds schwer. Zu vermerken 
ist die Empfehlung, auch für reinen Frakturtext 
die Normalschrift-Checkbox möglicherweise nut-
zen zu können (vgl. Abb. 57).

– Lexikon (,Lohnt sich die eigene 
 Wortliste?‘):

In allen ausgewerteten Situationen der ersten 
Schriftgruppe war eine deutliche Überlegen-
heit des Einsatzes von altdeutschen Wortlisten 
gegenüber modernem Wortschatz generell, und 
fast immer eine leichte Überlegenheit des auf die 
Funeralschriften angepasst erstellten Lexikons 
gegenüber dem FineReader-OldGerman festzu-
stellen – obwohl das im Projekt verwendete Wör-
terbuch bei weitem noch nicht zu Ende optimiert 
worden war.
Für die zweite Schriftgruppe (die zugleich aus 
über Lyrik hinausgehendem Material bestand) fiel 

56 Zusätzlich trainierte Antiquamuster und durchschnittliche Rate fehlender Zeichen

57 Zuwahl mitgelieferter Antiquamuster u. durchschnittliche Rate fehlender Zeichen

PRAkTISCHER SOFTWARETEST unD -VERGLEICH II



70 VOLLTExT VIA OCR  –  MöGLICHkEITEn unD GREnZEn

der Unterschied noch deutlicher aus. Hier wurde zusätzlich zum Vergleich der FineReader-Sprache 
„OldGerman“ mit der Anwender-Sprachengruppe auch die in HK-OCR mögliche Kombination beider 
einbezogen. Sie erreichte die Werte der Anwenderwortbibliothek ebenfalls nicht und blieb meist auf 
derselben Erkennungsgüte wie die FineReader-Sprache allein. Zu interpretieren ist das wohl so, dass im 
Fall der Kombination die FineReader-Wortliste klar dominiert: zum Vorteil der Erkennung, wenn sie die 
passenderen Einträge enthält, sonst zu ihrem Nachteil.
 Sowohl die in die Sprach-Definitionen von FineReader eingehenden Wortlisten als auch die Anwen-
derlexika haben einen starken Einfluss auf die OCR-Leseergebnisse, ohne dass der Anwender hier viel 
steuern (insbesondere: dämpfen) kann.85 Auch hier lohnt es sich also, viel Sorgfalt auf die Erstellung 
des Wörterbuchs zu verwenden, selbst wenn HK-OCR bzw. FineReader bisher keine Feinsteuerung der 
Ersetzungen erlaubt.
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85 Gesehen wurde z. B. eine offenbar lexikongetriebene Hyperkorrektur von zunächst (OCR mit FineReader-Mustern ohne gewählter Sprache:) „dieNen“ zu 
(FineReader-Muster mit gewählter Sprache:) „vierten“, die nach eigenem Mustertraining bei Verwendung desselben Lexikons richtig als „dienen“ gelesen  
wurde.
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58 Vergleiche in Schriftgruppe 2: Trainingsfortschritt, Musterwahl, Wortbestandswahl und -kombination usw.
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6 Zusammenfassung der Ergebnisse
6.1  Einflussfaktoren auf die Erkennungsgüte
6.1.1 Nachweis des Einflusses von Vorsortierung

Für beide getesteten Softwareprodukte gilt: Seiten, deren Typenvorrat einer passenden trainierten Mus-
terbibliothek zugeordnet werden kann, können auch schon nach mäßigem Training und bei durchschnitt-
lichen sonstigen Randbedingungen eine hohe Erkennungsgüte erreichen:

      
Durch eine entsprechende Gruppierung des Ausgangsmaterials können Stapelverarbeitungen aussichts-
reich vorbereitet werden. Ohne Vorsortierung kann diese Erkennungsrate bei weitem nicht erwartet 
werden, und entsteht die Notwendigkeit, die Spreu erst nach der OCR vom Weizen zu trennen. Dies 
trifft auch für große Teile der im Projekt verarbeiteten Bände zu, eben weil die Vorsortierung nur in 
Versuchsmargen (insgesamt ca. 5.000 Seiten) konsequent genug war.

   
6.1.2 Nachweis des Einflusses von Binarisierungsparametern

Dass Binarisierungs- und Segmentierungsparameter entscheidend für die Möglichkeit einer sinnvollen 
Musteridentifizierung sind, ist trivial. Zwar ist bemerkenswert, mit wie wenig nutzerseitiger Paramet-
rierung die FineReader-Engine eine im Durchschnitt optimale Zeichensegmentierung erreicht, dennoch 
gehen hier Möglichkeiten zur Nachjustierung verloren. Zu den im Gegenbeispiel BIT-Alpha reichhaltig 
verfügbaren Optionen und Parametern wird im Anhang versucht, eine vorsichtige Orientierung über 
sinnvolle Einstellungen und Wertebereiche zu geben (s. Anh. 7.3); verbindliche Information wäre aller-
dings vom Hersteller anzufordern. An folgendem Beispiel kann verfolgt werden, wie sich die Anzahl 
fehlender richtiger Zeichen unter dem Gebrauch verschiedener Binarisierungsparameter verändert.

59 Gute Zuordnung von Drucktypen zu passender Musterbibliothek - bearbeitet mit Hk-OCR



73

6.1.3 nachweis des Trainingseffekts

BIT-Alpha, das ohne Muster ausgeliefert wird, beruht auf der Wirksamkeit des Trainings passender 
Muster, so dass der hier während der Versuche mit zunehmendem Training beobachtete Erkennungsfort-
schritt – bzw. die Differenzen bei Verwendung verschiedener Musterbibliotheken – selbstverständlich ist.
 Interessanter war die Feststellung, wie sehr sich ein materialbezogenes Training auch bei der mit gu-
ter Frakturmuster-Grundversorgung ausgestatteten FineReader-Engine auswirkte. Das zeigen nicht nur 
die im Text beschriebenen Fehlerzählungen auf den vorliegenden Ground-Truth-Stichproben, sondern 
auch die in den Layout-Protokollen der FineReader-Engine vermerkten Erkennungsraten (offenbar 
Anteile der im Wörterbuch enthaltenen Wörter an den insgesamt erkannten). In den Bänden des 17. 
Jahrhunderts, die sowohl mit Finereader-Mustern als auch mit selbst trainierten Mustern vergleichend 
prozessiert wurden, wurden für die eigene Musterdatei – trotz der begrenzten Trainingsintensität von 90 
Seiten – oft als um zwei bis fünf Prozentpunkte höhere Raten vermerkt als im Lauf mit den FineReader-
Frakturmustern. 
            

60 Texterkennung nach verschiedenen Binarisierungsverfahren in BIT-Alpha
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86 Die Ersetzung von Wörtern über das Wörterbuch in HK-OCR ist nicht steuerbar.
87 VEREIN FÜR COMPUTERGENEALOGIE

6.1.4  nachweis des Wörterbucheffekts
      
Durch gezielte Gegenüberstellung von OCR-Ergebnissen, die mit bzw. ohne Hinzunahme von Wortlis-
ten entstanden, lässt sich bei beiden Softwareprodukten zeigen, dass sich der Einsatz von Wortbiblio-
theken positiv auf die Ergebnisse auswirkt. Dieser Effekt beruht in BIT-Alpha auf einer vom Anwender 
detailliert steuerbaren lexikalischen Korrektur nach der OCR. Bei HK-OCR dagegen beeinflusst die 
Wortbibliothek durch Definition so genannter „Sprachen“ und „Sprachengruppen“ der FineReader-En-
gine offenbar schon die Texterkennung. Der maßgebliche Einfluss der Wortliste zeigt sich vor allem in 
der Erkennung der Wortgrenzen. Vergleicht man das Beispiel in den verschiedenen Bearbeitungsstufen 
wird vor allem durch die korrigierten Wortgrenzen der Text flüssiger lesbar. Es fällt ebenso auf, dass 
durch Einsatz der Wortliste86 neue Fehler entstehen können: „dieNen“ wird fälschlich zu „vierten“.
 Die im Projekt erstellte gattungsspezifische Wortliste bestand in der OCR-Optimierungsphase aus 
ca. 70.000 Einträgen. Wie eingangs beschrieben, enthält sie vor allem Wortschatz aus Leichenpredig-
ten. Dieser Wortschatz entstand durch Transkription von Referenzseiten und speist sich zusätzlich aus 
Titelmaterial aller über den GBV nachgewiesenen Leichenpredigten. Zudem ergänzt um Gedichte von 
Simon Dach und einige wenige zeitgenössische Texte wurden vor allem die Thesauri der Forschungs-
stelle für Personalschriften Marburg THEPRO und THELO sowie eine Liste historischer Krankheits-
bezeichnungen des Vereins für Computergenealogie87 herangezogen. Eine weitere Optimierung in der 
Testphase selbst konnte nicht vorgenommen werden.
 Wörterbücher können deutlich genauer erstellt werden, wenn das Ausgangsmaterial regional, zeitlich 
und inhaltlich auf den Verwendungszweck abgestimmt im Zuge einer fehlerfreien Erfassung entstanden 
ist. Ein weiterer Weg erschließt sich über die Hinzunahme aller möglichen Flexionsformen bzw. Recht-
schreibvarianten der vorkommenden Wörter (s. Kap. 3.1.5 und 4.3.4).

61 Fortschritt in OCR-Erkennung (hier mit Hk-OCR) durch Training
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6.2  Im Projekt erreichte Erkennungsgüte

Eine wie im Beitrag von Thomas Stäcker (vgl. 8.7) dargestellte statistisch abgesicherte Fehleranalyse 
wurde bisher nicht durchgeführt. Gleichwohl wurden Stichproben aus den verschiedenen Projektphasen 
untersucht. Diese zum Teil erst aus der Zeit nach der Optimierung entstandenen Daten sollen hier kurz 
vorgestellt werden, um Eindrücke anhand von kompletten Beispielen zu erlauben. Die Fehlerzählung er-
folgte analog zu der in der Herzog August Bibliothek Wolfenbüttel durchgeführten Methode (Worttren-
nungen, fehlende bzw. überschüssige Spatien fanden keine Berücksichtigung).
 Wie bereits geschildert (s. Kap. 5) wurde in der Optimierungsphase nur in sehr bescheidenem Maße 
trainiert, so dass grundsätzlich starke Probleme bei der Erkennung von in Marginalien gesetzten Tex-
ten auftraten, was zum einen an der sehr kleinen und oft schwer lesbaren Schrift, zum anderen an der 
mangelnden Segmentierung lag. Auch die Erkennung von Ziffern und Zeichen in fremden (als den im 
Trainingsmaterial vorkommenden) Alphabeten muss daher als unbefriedigend bezeichnet werden. Die 
folgenden Fälle sind zu unterscheiden:

Homogene Texte von Simon Dach in einer Schrift. Hierzu wurden vorab 50 Seiten Text trainiert.
BIT-Alpha (vgl. Abb. 63):
Von sieben wahllos herausgesuchten Seiten wiesen fünf eine Erkennungsgüte von 97,7 % und höher auf; 
in zwei Fällen wurden über 99 % erreicht.

Weniger homogene Texte von Simon Dach mit wenigen unterschiedlichen Schriften. Hierzu wurden 
vorab 60 Titelblätter und 30 Seiten Text trainiert.
HK-OCR: 
Hier wurden nur drei Seiten stichprobenartig untersucht. Die Ergebnisse lagen bei 93,6 % bis 96,4 %.

62 Fortschritt in OCR-Erkennung (hier mit Hk-OCR) durch Wortliste

ZuSAMMEnFASSunG DER ERGEBnISSE

1. Marge:

2. Marge:
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Nicht vorselektierte Texte Funeralschriften vornehmlich aus dem 17. Jh. Kein weiteres Training hat statt-
gefunden; die vorab erstellten Musterdateien der 2. Marge wurden für das gesamte Material angewendet.
BIT-Alpha (vgl. Abb. 64): 
Von acht einzelnen Seiten wiesen nur vier eine Erkennungsgüte über 90 % auf (91,8 % bis 95,8 %).
HK-OCR (vgl. Abb. 65): 
Hier wurden nur sechs Seiten stichprobenartig untersucht. Die Ergebnisse lagen bei fünf Seiten deutlich 
über 94 % (88 % bis 97,9 %).

Eine Hochrechnung erlauben diese willkürlich erhobenen Daten kaum. Es gilt außerdem zu berück-
sichtigen, dass im so genannten Massenlauf keine weiteren Selektionen mehr vorgenommen werden 
konnten, was sicherlich bei weiterem Training eigens getrennter Gruppen zu Qualitätssteigerungen ge-
führt hätte. Speziell für BIT-Alpha ist diese Art der Prozessierung nicht die angezeigte, da wie bereits 
oben geschildert, die Software in besonderem Maße ein Training erfordert und nicht auf einen großen 
Fundus vorhandener Muster zurückgegriffen werden kann.
    

63 Beispiel BIT-Alpha; 1. Optimierungslauf: 40 in: yi 851-3, S. 2

3. Marge (Massenlauf):
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64 Beispiel BIT-Alpha; Massenlauf: Ee 705-1071, S. 29

65 Beispiel Hk-OCR; Massenlauf: Ee 705-106, S. 7

ZuSAMMEnFASSunG DER ERGEBnISSE
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6.3  Hervorzuhebende Vor- und nachteile der getesteten Software 
 für die OCR deutschsprachiger Alter Drucke
6.3.1 Good practice

BIT-Alpha zeichnet sich aus durch:
–  eine reiche Parametervielfalt in Binarisierung und Segmentierung, wodurch auf Layout- und 

Schrifttypeneigenschaften detailliert eingegangen werden kann;
–  die Möglichkeit, auch Schrifttypen-Teile (Schaft, Fuß usw.) als eigene Muster auf „Special 

characters“ zu trainieren, um die Teile später mittels Sequencer zusammenzusetzen (so können 
bestimmte häufige OCR-Fehler wie brüchige „n“, „m“, „u“ repariert werden);

–  die mit dem Hilfsprogramm BIT-Knowledge gegebene Möglichkeit zur Mischung mehrerer 
Musterbibliotheken;

–  eine fein steuerbare Wortkorrektur durch gewichtete Zeichenersetzungskoeffizienten. 

HK-OCR besitzt:
–  eine aus dem Stand (ohne langwierige Justierungen) gegebene sehr gute Segmentierung auf 

Zeichenniveau und
–  eine gut bedienbare Benutzeroberfläche für Wortkorrekturen mit Berücksichtigung der Kor-

rekturen in der Koordinatenberechnung des XML-Exports.

6.3.2  Gegenwärtige nachteile

Die wichtigsten Nachteile von BIT-Alpha sind darin zu sehen, dass
–  unnötige „Compound“-Formate der Parameter- und Hilfsdateien (s. Kap. 4.1) zur manchmal 

unerwünschten Zusammenspeicherung von nicht zusammengehörigen Informationen führen 
und

–  zu den zahlreichen Optionen bzgl. Parameteränderungen eine gründliche Dokumentation und 
eine übersichtliche Vorschau der Auswirkungen solcher Justierungen fehlte.

Als für die getesteten OCR-Aufgaben ungünstig erwiesen sich folgende Eigenschaften von HK-OCR, 
die offenbar auf Komponenten der FineReader-Engine beruhen:

–  die stark beschränkte Navigation im Trainingsteil (s. Kap. 4.4);
–  die unpraktische Bedienung des Mustereditor-Fensters;
–  die fehlende Kombinierbarkeit trainierter Musterbestände sowie
–  die Erschwernis durch die Doppel-Lizenzierung einerseits der Software beim Hersteller, ande-

rerseits der von ABBYY zu erwerbenden und zu installierenden Einzelseitenlizenzen.

(a) BIT-Alpha

(a) BIT-Alpha

(b) Hk-OCR/FREngine 9

(b) Hk-OCR/FREngine 9
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6.4  Anforderungen an Software-Weiterentwicklung
      
Aus Sicht eines an realistischen Produktionsbedingungen für OCR interessierten Anwenders haben eini-
ge Produkteigenschaften gefehlt, die für eine Stapel verarbeitende Software eigentlich bewährt sind und 
die auch mit dem Programmdesign beider Produkte ohne weiteres vereinbar wären.
 Ein Anliegen dieser Studie ist es daher, zur Diskussion über nahe liegende Anforderungen bei der 
Weiterentwicklung von für historische Drucke geeigneten OCR-Tools beizutragen und eine aktive 
Nachfrage nach wesentlichen Produktmerkmalen anzuregen, die den Herstellern eine adressatengerech-
te Produktentwicklung ermöglicht.       
 Die folgenden, für die getesteten Programme BIT-Alpha und HK-OCR den Herstellern sinngemäß 
mitgeteilten (und in deren Software meist ohne weiteres integrierbar scheinenden) Anregungen können 
zugleich als allgemeiner Kriterienkatalog für die Auswahl bzw. Entwicklung von OCR-Produkten mit 
herangezogen werden. 
      

Könnten dem jeweiligen Programm als konventionelle Aufrufparameter schon beim Start alle Angaben 
(Namen der Konfigurations-, Muster- und Wörterbuch-/Sprachdateien, ebenso Bildverzeichnisse bzw. 
Bilddateinamen) übergeben werden, sinngemäß etwa:

 OCRAPP.exe -conffile xx -patternfile yy -lexiconfile zz-outputdir xx/xx image1.tiff 

 OCRAPP.exe -conffile yy -patternfile zz -lexiconfile xx-outputdir xx/yy image2.tiff

       ...
Dann könnten Batchprozesse viel flexibler gestaltet werden, indem z. B. im selben Stapel zu bestimmten 
Bilder(gruppe)n bestimmte Konfigurationen oder Muster-/Wortbibliotheken übergeben werden. Auch 
für Beschränkungen, die aus der gegenwärtig „nur aus einem gemeinsamen Bildverzeichnis heraus“ 
möglichen Batch-Verarbeitung resultieren, wäre die explizite Angabe der zu prozessierenden Images 
hilfreich. Dadurch könnten die Images an ihrem Speicherort verbleiben, ohne dass der Bearbeiter ein 
eigentlich unmotiviertes (und gelegentlich wegen fehlender Rechte oder aus Speicherplatzgründen gar 
nicht mögliches) temporäres Hin-und-Her-Schieben von Quelldateien organisieren muss. Demzufolge 
wäre ein Anstoßen beliebig kleinteiliger Test- und Produktionsläufe mit sehr unterschiedlichen Bedin-
gungen kein zeitlicher Faktor mehr. 
 Zudem wären die OCR-Anwendungen mit dieser konventionellen Aufrufsyntax so auch in beliebige 
Workflow-Systeme integrierbar, an denen Anwenderinstitutionen aus unterschiedlichen Gründen fest-
halten wollen. Die Entscheidung zwischen bibliothekseigenem Workflow und der Nutzung von Produkt 
XY wäre dann nicht mehr nötig.
      

Da für eine an einzelne Vorlagen angepasste OCR die eingesetzten Binarisierungsparameter-, Muster-, 
Ersetzungsregel-, Sprach- und Lexikon-Dateien optimal ausgewählt und kombiniert werden müssen, 
sollten sie am besten:

–  unabhängig voneinander einzeln abgespeichert werden;
–  soweit möglich jederzeit auch außerhalb des OCR-Prozesses passiv lesbar sein (so für Pro-

tokoll- und Vergleichszwecke, z. B. wenn Nutzer ihre längerfristig Muster-, Parameter- und 
Regelsammlungen anlegen und pflegen);

–  und je möglichst komfortabel editierbar sein.

ZuSAMMEnFASSunG DER ERGEBnISSE

Aufrufsituation im Betriebssystem

Konfigurationsspeichermodell; Formate; Zusammenspiel von Parameter-, Muster- und weiteren 
Hilfsdateien
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Im Ergebnis sollte die gezielte Änderung oder Löschung bestimmter Parameter/Muster/Ersetzungsre-
geln/Wortlisteneinträge jederzeit möglich sein, ohne eine OCR-Analyse anzustoßen und ohne Auswir-
kungen auf nicht-betroffene Parameter/Muster/Regeln.  Im Sinne „atomarer“ Datenablage sollte für jede 
Steuerinformation nur ein eindeutiger Speicherort vorgesehen sein.
 Für alle diese Hilfsdateien (außer den Mustern selbst) gilt, dass eine Speicherung in einem textarti-
gen, les- und editierbaren Format (einfache Listen, Schlüssel-Wert-Paare wie in *.ini- oder *.config-
Dateien, notfalls XML) möglich sein sollte und folgende Vorteile hätte: 

–  Es wäre erstmals ein durchgehendes monitoring und logging der im konkreten OCR-Lauf wirk-
samen Parameter, Sequenzen, Wortlisten oder Ersetzungskoeffizienten möglich – eine Voraus-
setzung für sinnvolle langfristige Weiterpflege durch die Anwender.

–  Parameterlisten, Sequenzen, Wortlisten, lexikalische Ersetzungen usw. könnten bequem und 
wesentlich flexibler ergänzt, korrigiert oder in ausgewählten Teilen gelöscht werden.  

–  Zur Übertragung bewährter Parameter oder Regeln in eine andere Konfiguration ist bisher der 
manuelle Neueintrag jedes einzelnen Werts in zeitaufwendigen Dialogen der graphischen Be-
nutzerschnittstelle nötig. Aus textartigen Hilfsdateien aber wäre eine selektive und dennoch 
kompakt „blockweise“ Übertragung von Parametersätzen von einer Konfigurationsdatei in eine 
andere möglich.88

Insbesondere ist kein Grund erkennbar, ausgerechnet auch die vom Anwender selbst in Textform oder 
durch Tastatureingaben bereitgestellten Wortlisten, Listen erlaubter/verbotener Buchstaben, Ersetzungs-
regeln usw. in proprietären, vom Anwender nicht mehr lesbaren Binärformaten zu verwalten. Die sach-
gerechte Pflege dieser Bestände gestaltet sich dadurch unbegründet schwierig bis unmöglich.
 Aber auch für die Speicherung der Muster selbst wäre ein dokumentiertes und anwendungsübergrei-
fendes Format anzustreben, das die freie Bearbeitung und nach Möglichkeit sogar den Austausch von 
Mustern zwischen verschiedenen OCR-Anwendungen erlaubt. Die Formate von Open-Source-OCR-
Anwendungen wurden nicht untersucht, könnten aber vermutlich zur Formulierung entsprechender An-
forderungen herangezogen werden. Bei geeigneter Serialisierung (Aufeinanderfolge von Datensätzen) 
wären Kombination und Durchsuchbarkeit solcher Musterdateien trivial.
      

Während des Pilotprojekts ist viel Zeit mit ineffektiven Bedienungsabläufen verbraucht worden. Das be-
trifft nicht nur die OCR-bezogenen Softwareeigenschaften, zu denen im folgenden Anregungen genannt 
werden, sondern offenbar geraten längst bewährte und etabliert geglaubte Merkmale ergonomischen 
Programm-Designs in Neuentwicklungen gelegentlich in Vergessenheit. Umso wichtiger ist es, dass 
Anwender, die durch Aufträge an Softwarehäuser Einfluss auf die Programmgestaltung nehmen können, 
sich rechtzeitig über die Mindestanforderungen klar sind, die für eine Arbeitsweise mit vertretbarem 
Personalaufwand unverzichtbar sind. 
 Da die Wirtschaftlichkeit von maschineller OCR eng mit der für Training und Konfiguration aufzu-
wendenden Arbeitszeit zusammenhängt, sind im Anhang (s. Anh. 7.4) einige solcher allgemeiner Min-
destanforderungen genannt, auf die geachtet werden sollte. 
 Die Zusammenarbeit mit beiden Dienstleistern hat gezeigt, dass Hinweise durchaus willkommen 
sind – schließlich sind Produkte, die einer schnellen technischen Entwicklung folgen müssen, praktisch 
immer „in Entwicklung“. Bei konsequenter Nachfrage und rechtzeitiger Übernahme gewünschter Ei-
genschaften z. B. in ein Pflichtenheft würden diese Merkmale sicher nicht fehlen.
      

88 Speziell die Stärke der B.I.T.-Programme, unterschiedliche Kombinationen von Binarisierungsparametern, Mustern, Sequenzen, Wortlisten, Lexikalischen Er-
setzungsregeln usw. überhaupt zu ermöglichen, könnte so noch viel konsequenter eingesetzt und produktiv gemacht werden.

Benutzeroberfläche und Ergonomie
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OCR-spezifisch wären folgende Anliegen zu nennen:89

Zeitsparende Orientierung über aktuell geltende Eigenschaften, Parameter usw. 
und ihre Auswirkungen
Wenn eine reiche Konfiguration von Binarisierungs- und Segmentierungsparametern angeboten wird, dann 
wird wegen ihrer Vieldimensionalität eine Beurteilung der Wirkung einzelner Änderungen fast unüber-
schaubar und zwingt bei der Konfiguration eines OCR-Stapels zur Beschränkung auf erfahrungsgestützte 
Vermutungen, ohne diese auch nur stichprobenartig mit vertretbarem Aufwand verifizieren zu können. 

Eine Vorschau auf zu erwartende Ergebnisse könnte leicht gewonnen werden, wenn die Programme
–  wie oben beschrieben alle nötigen Parameter auch in der Kommandozeile akzeptieren würden

  und
–  die bisher nur in der Benutzeroberfläche erreichbaren Vorschau-Ansichten als Bilddateien ex-

portieren könnten. 

Denn dann könnte durch Batch-Testläufe wie
  OCRAPP.exe -conffile xx image1.tiff --printlayer=BlockLayout 

  > image1-confxx-blocklayout.png

  OCRAPP.exe -conffile yy image2.tiff --printlayer=CharLayout 

  > image2-confyy-blocklayout.png

  OCRAPP.exe -conffile yy image2.tiff --printlayer=OCR 

  > image2-confyy-charlayout.png

  usw.
sehr schnell (jedenfalls ohne von Bearbeitern aufzuwendende Zeit) ein repräsentativer Überblick über 
die konfigurationsbezogene Segmentierungsgüte und Layouterkennung einer größeren Bildmenge ge-
wonnen und z. B. in einer automatisch erstellten Tabelle visuell vergleichend dargestellt werden.90 Ver-
mutlich würde es durch solch eine „Viele-Screenshots-Ansicht“ überhaupt erst möglich, die Auswir-
kung einer konkreten Parameteränderung auf einen vorliegenden Gesamt-Stapel halbwegs kontrolliert 
abzuschätzen.  Bisher entscheidet man über die Anpassung eines Parameters anhand einer eher sehr 
kleinen Menge gesehener und einzeln analysierter Bilder (dabei mit Minuten Wartezeit je Bild) und 
muss sich für die Prognose auf die Intuition verlassen – mit der Gefahr, bei der „Rettung“ einer Seite die 
Erkennung vieler anderer zu beschädigen. 
      
Interaktivität, frühe Evaluation der Einzelverarbeitungsschritte
Für alle Stufen gilt: Wo adaptive Selbstkonfiguration und automatische Korrektur nicht stattfinden oder 
eher heuristisch, d. h. nur möglicherweise optimal arbeiten, könnte Software mit unmittelbaren Warn-
meldungen und Hinweisen auf sinnvolle interaktive Eingriffe die schnelle Findung der geeigneten Ein-
stellungen und Konfigurationen unterstützen.
 Speziell die Segmentierung sollte auch in der Stapelverarbeitung justierbar präsentiert werden, um 
auf druckspezifische Schwierigkeiten bei der Layouterkennung reagieren zu können. Gebraucht wür-
den einerseits „halbfertige“ Konfigurationsvorlagen, wo der Anwender bestimmte Abstandsmaße, Ein-
gangstexte und ähnliche Kriterien festlegen kann, anhand derer bestimmten Blöcken für den aktuellen 
Stapel eine bestimmte Textstruktureinheit zugewiesen wird,91 andererseits eine am Bildschirm gut ge-
führte Möglichkeit zur schnellen graphischen Verschiebung von Blockgrenzen sowohl für Einzelseiten 
als auch auf Beispielseiten mit Geltung für einen Stapel. Voraussetzung wäre hierfür u. a. eine Möglich-
keit, Images eines Stapels auf dem Bildschirm in Schichten übereinander darzustellen und so Gruppen 
mit Layoutgemeinsamkeiten (einfachster Fall: linke Seiten vs. rechte Seiten) bilden zu können.
      

89 Vgl. außerdem die einzelschrittbezogen genannten Desiderata in den Abschnitten des Kapitels 4.
90 Hingewiesen sei auch auf Vorarbeiten im IMPACT-Projekt zu Evaluierungen bereits jeder Teilstufe des OCR-Prozesses. Das 2012 als Nachfolgeeinrichtung von 

IMPACT entstandene Kompetenzzentrum sollte als Ansprechpartner in Anspruch genommen werden.
91 Unter den Konfigurationsparametern von BIT-Alpha gibt es etliche, die hierfür geeignet wären.

ZuSAMMEnFASSunG DER ERGEBnISSE
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Alternative: Vorsorgliche Parallelverarbeitung mit späterer Evaluation
Eine in OCR-Algorithmen ansatzweise bereits anzutreffende Parallelverarbeitung92 könnte als Vorbild 
dienen, bei der OCR inhomogener Vorlagen generell unterschiedliche Lesegänge durchzuführen und 
deren Ergebnisse für einen anschließenden Vergleich bereitzustellen. 
 Insoweit in solchen parallelen OCR-Outputs dieselben Teilblock- (Absatz- usw.) Segmentierungen 
erreicht und ausgezeichnet wurden, sollte hier sogar ein über die Selektion des besseren Gesamtseiten-
Ergebnisses hinausgehender Mehrwert erreichbar sein, indem trotz seitenweiser OCR die Evaluation 
auf Blockebene ansetzen könnte und sich z. B. für einen Absatz der Output aus dem OCR-Lauf mit Kon-
figuration A, für einen anderen Absatz der Output aus dem OCR-Lauf mit Konfiguration B als passender 
erweist.

Transparenz und Konfigurierbarkeit der wirkenden Faktoren
Alle sinnvoll variierbaren Faktoren sollten für den Anwender konfigurierbar sein und müssen in jedem 
Fall – auch nachträglich und auch dann, wenn die Einstellung automatisch erfolgte – visuell dargestellt 
und protokolliert werden können. Erfolge an einem OCR-Stapel sind nur nachnutzbar, wenn sich die 
Umstände reproduzieren lassen.
      
Modularität
Wo immer ein Anwenderinteresse an der Ausgabe von Teilergebnissen oder an der Einspeisung anderen 
Materials vorliegt, sollte die geschlossene Programmarchitektur geöffnet und eine voraussetzungslose 
Nutzung auch von Einzelkomponenten ermöglicht werden. 
 Es gibt beispielsweise keine Notwendigkeit, die gute Binarisierungsleistung einer Software nur im 
Zusammenhang mit dem OCR-Lauf in derselben Software zu erlauben. 
 Die Funktion der Korrekturkomponente sollte nur dann an das Vorhandensein der Original-Bildda-
teien geknüpft sein, wenn tatsächlich neue OCR-Analysen notwendig sind. Soweit hingegen nur die 
textartigen OCR-Leseergebnisse verarbeitet werden, sollten diese – ohne erneute OCR-Analyse – einge-
speist werden können; idealerweise auch Material, das aus anderen Quellen als der OCR des Programms 
selbst kommt. Gerade wenn ein Korrekturmodul spezielle Stärken hat (HK-OCR seine gut bedienbare 
„Validierungs“-Oberfläche, BIT-Alpha seine gut justierbare automatische Nachkorrektur anhand ge-
wichteter Zeichenersetzungsregeln), wäre sein Einsatz auf beliebigem Input wünschenswert.
 Die jederzeitige Ausgabe von Zwischenergebnissen wird auch schon zur Evaluation von Teilschritt-
Konfigurationen benötigt.
   
   
6.5  Schlussfolgerungen und Tipps; Ausblick

Der vermutlich ergiebigste Hinweis für die OCR Alter Drucke dürfte sein, dass nur eine adäquat vorbe-
reitete OCR Aussicht auf zufrieden stellende Ergebnisse bietet und dass hierzu eine gründliche Kenntnis 
des Materials notwendig ist.
 Je nach Verwendungszweck93 können unterschiedliche Qualitätsanforderungen bestehen, zu deren 
Überprüfung zunächst von der gewählten OCR-Software unabhängige Kriterien und Werkzeuge gefun-
den werden sollten. Zur Mindestausstattung von OCR-Projekten gehören daher Standardwerkzeuge für 
Textextraktion und einfache statistische Auswertungen; hierfür können die in allen Betriebssystemen 
gängigen Kommandozeilenfilter und eine Skriptsprache mit komfortabler Textverarbeitung wie Perl 
bereits genügen. 
      
92 Zu nennen ist hier z. B. in HK-OCR das mehrfache Lesen unter unterschiedlichen Bedingungen („Layouts“) mit anschließender manueller oder automatischer 

Auswahl des „besten“ Ergebnisses, s. Kap.4.3.3“
93  Eine Übersicht der wichtigsten Verwendungsziele gibt z. B. Ralf Stockmann (SUB Göttingen) in einem Vortrag „Was tun mit den Ergebnissen der OCR?“ im 

Rahmen des IMPACT-Projekts; darunter u. a. eine nach steigender „Sichtbarkeit“ geordnete Aufzählung der Bereitstellungsarten: „Versteckt in Suchindex“ - 
„Versteckt, aber Image-Highlighting der Fundstelle“ - „Volltext als Layer hinter dem Image (etwa in PDF gebunden)“ - „Volltext sichtbar über / neben dem 
Image“ - „Nur Volltext sichtbar“ - „Volltext als Download“ - „Volltext für Harvester verfügbar (TEI Datei in OAI)“, s. STOCKMANN 2010

öffnung der Blackboxes

Informationsverluste als „Leitfaden“
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Neben der „absoluten“ Qualitätsbeurteilung (zur Entscheidung, ob und wann sich ein OCR-Projekt 
lohnt) sind innerhalb der Arbeit häufig relative Entscheidungen zu treffen, z. B. in welche Richtung eine 
Konfiguration geändert werden soll, wofür es nicht auf die Perfektion von Fehlerkriterien ankommt, 
sondern nur darauf, ob die Tendenz einer Verbesserung oder Verschlechterung der Erkennungsrate ab-
gelesen werden kann. Vergleiche müssen beliebig oft (und jeweils schon für Veränderungen nur eines 
Faktors) vorgenommen werden können, um aus den Ergebnissen die richtigen Schlüsse zu ziehen.
 Für die Suche nach geeigneter Software oder nach Dienstleistern können dann die im Kapitel 3 ge-
nannten typischen Fehlerquellen der OCR als Entscheidungshilfe dienen. Interessenten sollten sich klar 
werden, welche der absehbaren Informationsverluste auch im eigenen konkreten Material auftreten wer-
den und welche möglicherweise unproblematisch sind. Daraus folgernd könnten sie dann die Software 
oder den Dienstleister danach auswählen, wie sie mit den betreffenden Fehlerquellen umgeht.
 Außerhalb der eigentlichen OCR-Leistungsfähigkeit werden Fragen der Nachhaltigkeit und der Bin-
dung an Lizenzen und Formate eine Rolle spielen wie:

–  Korrespondieren von Import- und Exportformaten mit den eigenen Geschäftsgängen;
–  Wiederholbarkeit der OCR- und Korrekturläufe; 
–  Wiederverwendbarkeit von Konfigurationsdateien, Musterbibliotheken und Korrekturlexika;
–  Auswirkungen einer eventuellen Softwareinstallation auf betriebliche Abläufe;
 usw.

      
Nicht zuletzt lohnt es sich, stets die denkbaren Auftragsmodi anhand der konkreten OCR-Aufgabe ge-
geneinander abzuwägen:

–  Arbeit in eigener Regie durch Erwerb bzw. Lizenzierung der Software;
–  Beauftragung der Gesamt-OCR als Dienstleistung (hier sollte eine Zielerkennungsgüte vertrag-

lich festgelegt werden; s. auch Kap. 8.8);
–  Arbeitsteilige Zusammenarbeit: z. B. mit eigener Produktion, eigenem Training, aber Beauftra-

gung der Konfiguration schwieriger Parameter94 – oder umgekehrt: externe Beauftragung von 
Stapelverarbeitungen, die der Anwender vorher selbst konfiguriert hat.95

6.5.1  Tipps für Anwender der getesteten Software: 
 Wann wäre welches der getesteten Produkte geeignet?

Um sich von der Software ausgehend ein Bild zu machen, werden die Kapitel 4 und 5 empfohlen, wo in 
den einzelnen Abschnitten auf die Merkmale von HK-OCR und BIT-Alpha eingegangen wird.
 Zur Nachnutzbarkeit von nutzereigenen Muster- und Wortbibliotheken gilt für beide Produkte ähn-
lich, dass die erstellten Bibliotheken prinzipiell aufbewahrt und wiederverwendet werden können. 
Selbstverständlich muss langfristig auf die Kompatibilität etwaiger Nachfolgeversionen der jeweiligen 
Programme geachtet werden. Eine wirklich flexible Nachnutzbarkeit für nicht vorhergeplante Fälle wird 
wie beschrieben durch die proprietären, vom Nutzer nur bedingt editierbaren Speicherformate einge-
schränkt.
 Wenn man vom Einsatzbedarf ausgehen möchte, könnten aus den Versuchen im Pilotprojekt folgende 
Empfehlungen abgeleitet werden:
   

–  BIT-Alpha eher für Szenarien, in denen
–  der zu erkennende Zeichenvorrat (insbesondere Diakritika, griechische, hebräische Zeichen  

u. ä.) im voraus nicht vollständig bekannt ist oder
–  es im Training darauf ankommt, frei und mit häufigen Sprüngen navigieren zu können.

94 Nachteil dieser Variante wäre, dass unerwünschte Softwareeigenschaften wie eine kompliziert dargebotene oder schlecht dokumentierte Konfiguration honoriert 
würden.

95 Ein möglicher Vorteil: die professionelle Materialkenntnis kann optimal eingesetzt werden.
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– HK-OCR eher für Szenarien, in denen
–  der zu erkennende Zeichenvorrat (insbesondere Diakritika, griechische, hebräische Zeichen  

u. ä.) im voraus vollständig bekannt ist und in den Spracheinstellungen angegeben werden  
kann oder

–  ein Training überwiegend ohne Sprünge, d. h. fortlaufend über die ganze Seite erfolgen kann.

–  BIT-Alpha eher für Szenarien, in denen 
–  der Anwender vorlagenbedingt Einfluss auf Binarisierung und Segmentierung nehmen möchte 

oder muss und Zeit für die Konfiguration hat (Alternative: Konfiguration in Form einer bda-
Datei beim Softwarhersteller bestellen; hier sollten Qualitätskriterien vereinbart werden);

–  eine ausreichend große ungefähr passende Mustermenge trainiert werden kann oder vorliegt;
–  ein die Vorlage weitgehend abdeckendes Lexikon zur Verfügung steht und eine automatische, 

gewichtet einstellbare lexikalische Korrektur bevorzugt wird.
 (Als Alternative können Konfiguration und/oder Training und/oder Stapelverarbeitung (mit/

ohne Wortkorrektur) beim Softwarehersteller als Dienstleistung bei B.I.T. in Auftrag gegeben 
werden; hier empfiehlt sich, Zielmaße für die zu liefernde Erkennungsgüte zu vereinbaren.)

–  HK-OCR eher für Szenarien, in denen
–  das Bildmaterial keine speziellen Schwierigkeiten für Binarisierung oder Segmentierung auf-

weist, die eine individuelle Änderung von Parametern erfordern würden;
–  eine sehr gut zur Vorlage passende Mustermenge trainiert werden kann oder vorliegt und die 

Stapelverarbeitungen sehr gut nach homogener Sprache, Schriftfamilie und -größe portioniert 
werden können;

–  eine manuelle lexikalische Korrektur bevorzugt wird bzw. auf eine automatische lexikalische 
Korrektur entweder verzichtet werden kann oder diese nachgelagert – dann ohne Mitpflege der 
Wortkoordinaten – vorgenommen wird.

 (Die Übernahme von Trainingsleistungen wurde zum Projektzeitpunkt nicht von der Hersteller-
firma angeboten. Wenn der Anwender aber Musterdateien und Lexika bereitstellen kann, könnte 
auch hier die Verarbeitung als Dienstleistung beim Softwarehersteller Herrmann & Kraemer 
vereinbart werden.)

      
Nicht zum Untersuchungsgegenstand gehörte die Eignung für jüngere Frakturschriften, es soll aber wenigs-
tens erwähnt werden, dass für zunehmende Nähe zum 19. Jahrhundert die in der FineReader-Engine bereits 
enthaltenen Fraktur-Muster immer besser passen und ein eigenes Training hierfür meist unnötig wäre.
 Bei beiden Produkten bleibt es Aufgabe des Anwenders, die jeweiligen XML-Exporte in ein Zielfor-
mat seiner Volltextpräsentation oder in einen Suchindex zur Volltextsuche zu überführen. 
      

Wenn Eingriffsmöglichkeiten bzw. Einspeisung und Auswertung vor und nach jedem Zwischenschritt 
erwünscht sind, sind beide Produkte derzeit nicht darauf vorbereitet. Theoretisch mögliche Kombina-
tions- und Anschlussmöglichkeiten bestehen daher nur am Anfang und Ende der jeweiligen Verarbei-
tungskette.
 Eine wirklich offene und an jedem Verarbeitungsschritt ihre Teilergebnisse liefernde Verarbeitungs-
kette scheint allerdings auch in anderen Produkten nicht Standard zu sein; möglicherweise sollte das 
2012 gegründete IMPACT-Kompetenzzentrum hier in Anspruch genommen werden, um einschlägige 
Anforderungen zu bündeln.  
      

Für eine OCR-Prozessierung von Anfang bis Ende:

Für eine schrittweise, modulare OCR-Verarbeitung 
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6.5.2  Tipps für generelle Planungen von OCR Alter Drucke

Modularität des Workflows 
Jedes OCR-Projekt ist bestimmten Eigenheiten und Rahmenbedingungen unterworfen, die wesentlich 
im zu erschließenden Material selbst begründet sind. Gleichwohl soll versucht werden, einige allgemei-
ne Hinweise zu formulieren. Wie bereits eingangs erwähnt, lässt sich der Workflow auch dank internati-
onaler Projekte und ihrer Ergebnisse zunehmend modularisieren und standardisieren. Wesentliches Ziel 
ist dabei, sich zukünftig für das jeweilige Projekt einen geeigneten Workflow aus verschiedenen Kom-
ponenten zusammenzustellen und somit die für die Aufgabenstellung besten Resultate zu erhalten. Im 
hier behandelten Projekt bestand diese Möglichkeit nicht bzw. konnte nur sehr begrenzt durch Parame-
trierung der jeweiligen Software Einfluss genommen werden. Auf die dadurch entstandenen Nachteile 
wurde wiederholt hingewiesen. Die Softwaretests zeigen, dass sich beide Softwareprodukte durch Stär-
ken und Schwächen in verschiedenen Bereichen auszeichnen. Bestünde die Möglichkeit, die einzelnen 
starken Module für eine spezielle Anwendung zu kombinieren und auch weitere freie Module in den 
eigenen Workflow zu integrieren, ergäben sich neue Chancen zur Ergebnisoptimierung. Die Einbezie-
hung weiterer Software war jedoch nicht Gegenstand dieses Pilotprojekts. In der Fachdiskussion spielen 
das Workflowmanagement und seine technische Unterstützung eine wachsende Rolle.96

      
Materialkenntnis 
Wichtige Kriterien für die Planung von OCR leiten sich zuerst aus der Sichtung und Kenntnis der Dru-
cke selbst ab. Sowohl ihr Erhaltungszustand, typographische Besonderheiten als auch inhaltliche Bezü-
ge bilden Themen, mit denen eine Beschäftigung im Vorfeld lohnt. Der Erhaltungszustand des Drucks 
sowie die Qualität seiner Digitalisierung erfordern geeignete Aktivitäten für eine optimale Binarisie-
rung. Wie auch im Projekt gezeigt werden konnte, beeinflussen verschiedene Binarisierungsmethoden 
direkt die OCR-Erkennung. Das Wissen über Inhalt und Darstellung des zu erkennenden Wortmaterials 
ist wesentlich für die Einbeziehung möglichst passender Musterdateien und Wörterbücher. Neben der 
regionalen und zeitlichen Einordnung der Drucke ist daher die Kenntnis der überwiegend verwendeten 
Sprache (auch der Fachsprache) sowie der vorkommenden Schriftenvielfalt von Vorteil. Besteht die 
Möglichkeit, in einem Projekt geringfügige Anpassungen der Konfigurationsparameter vorzunehmen, 
können bereits wenige Vorsortierungen das Ergebnis verbessern. Eine grobe Einteilung nach Druckorten 
(-gebieten) bzw. Erscheinungszeiträumen ist hierbei anzuraten; gegebenenfalls lohnt auch eine Syste-
matisierung nach äußeren Merkmalen oder Gattungen.
      
Einbeziehung der OCR-Ergebnisse
Eine zusätzliche Optimierungsvariante ist es, die Erkennungsgüte der erstellten Dateien zu analysieren. 
Hierfür bieten sich verschiedene Methoden an – wichtig ist letztlich die Vergleichbarkeit der Ergebnisse 
innerhalb eines Projekts. Heranzuziehen sind durchaus auch Werte, die durch die OCR selbst erstellt 
und den Wörtern oder Zeichen als Information (z. B. Konfidenzwerte) mitgegeben werden. All diese 
Informationen können Indikatoren für eine nachträgliche Selektion sein, um Material zurückzustellen 
oder einer gesonderten Behandlung zu unterziehen. Beispielsweise ist folgendes Szenario vorstellbar: 
die Erkennungsgüte einer Seite ist extrem schlecht. Nach Blick auf das Image wird festgestellt, dass 
die Seite im Buch kopfüber eingebunden war, wodurch die Zeichenerkennung fast unmöglich wurde. 
Diesen Fehler könnte man folglich unkompliziert beheben. Ein anderes Beispiel ist die gezielte Analyse 
der Wörterbuchnutzung: Eine signifikant geringe Wörterbuchnutzung (so die Software derartige Aus-
wertungen zulässt) kann anzeigen, dass sehr wahrscheinlich ein Werk in einer fremden Sprache vorliegt. 
„Fremd“ bedeutet in diesem Fall: die Sprache gehört nicht zu denen, die im zeitgleich bearbeiteten 
Material überwiegend vertreten sind und mit deren Wörterbuch aktuell gearbeitet wird. Weitere Einsatz-
felder von Evaluationsergebnissen verschiedenster Qualität sind aufwandsabhängig denkbar.

96 Ein interessanter Vortrag zum Thema Workflowdesign: SCHLARB 2011.
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Sekundäre Materialien
Hinsichtlich der Sortierung wird offenbar, wie wichtig es bei Alten Drucken schon in der vorbereitenden 
Phase sein kann, die vorhandenen bibliographischen Beschreibungen zu analysieren. Existieren in den 
oftmals konvertierten Titelaufnahmen gar Informationen über die Schriftart („In Fraktur gedruckt“ oder 
dergleichen), gibt es eine Sprachbezeichnung? Kann diese Sprachbezeichnung eventuell auf einfache 
Weise generiert oder übernommen werden? Lässt sich mit diesem Titelmaterial möglicherweise bereits 
ein Wortschatz für ein Wörterbuch finden? Gibt es vergleichbare Texte, die als Referenzmaterialien 
verwendet werden können?
     
Arbeitsteilung
Eine andere wesentliche Frage ist die der Nutzung von Dienstleistungen als Alternative zum Inhouse-
Einsatz von OCR-Software. Die Beantwortung hängt von vielen Faktoren ab. Nicht zuletzt wird jedoch 
die technische und personelle Ausstattung in der jeweiligen Einrichtung maßgeblich sein. Nicht zu un-
terschätzen (und das belegen die Erfahrungen im Projekt) sind Rechenzeiten und Speicherbedarf.97

     
Bibliotheksspezifische Schlussfolgerungen
Es eröffnen sich vielfältige Möglichkeiten zur Gestaltung eigener Arbeitsabläufe. Mit jedem weiteren 
Workflowschritt entstehen neue Fragen und Ideen. Mithin ergeben sich für die Funeralschriften/Alten 
Drucke der Staatsbibliothek zu Berlin weitere Testszenarien, von denen nur einige angerissen wer-
den sollen:
 Ist es realisierbar, den OCR-Service der VZG98 unter Nutzung des Abbyy Recognition Servers über 
das Ticket-System mit den via HK-OCR erstellten Muster- und Wörterbuchdateien zu „füttern“? Bei 
erfolgreichem Einsatz könnten auf diese Weise weitere Funeralschriften einer Massen-OCR-Erkennung 
unterzogen werden. Gleichzeitig wäre zu testen, ob diese Muster und Parameter auch für inhaltlich 
vielfältigeres Material (jedoch möglichst zeitlich vergleichbares) zu besseren Ergebnissen führen als die 
Standardeinstellungen.
 Grundsätzlich ist für die Staatsbibliothek weiterhin zu untersuchen, ob es für einzelne Workflow-
schritte andere Softwarelösungen gibt, mit denen bessere Ergebnisse zu erzielen sind. In diesem Zusam-
menhang könnte auch die Opensource-Software Tesseract99 Gegenstand vergleichender Betrachtungen 
sein. Weitere Ansatzpunkte bilden die vielfältigen Bemühungen im von der EU geförderten IMPACT-
Projekt, Phasen der OCR-Vorbereitung und OCR-Nachbearbeitung zur Optimierung zu nutzen.100 Bei-
spielhaft wurden inzwischen Evaluationswerkzeuge (auch einzelschrittbezogen) entwickelt, deren An-
wendung vergleichbare Ergebnisse verschiedener Herkunft ermöglichen soll. Der intensive Kontakt 
und die Zusammenarbeit mit verwandten Projekten ist für den Erfahrungsaustausch von unschätzbarem 
Wert (Vgl. eine Auflistung von Projekten im Anhang 7.5).
      

  

97 Die Prozessierung eines Images (Quartformat) mit einem Standardbürocomputer dauerte durchschnittlich bis zu 10 Minuten; eine Alto-Datei ist ca. 70 KB, eine 
FR-XML ca. 500 KB, eine FR-Image-Datei ca. 5-7.000 KB groß.

98 http://www.gbv.de/wikis/cls/OCR-Service_der_VZG [Stand: 02/2013]
99 http://code.google.com/p/tesseract-ocr/ [Stand: 02/2013]
100 Zu nennen ist hier die Entwicklung des IMPACT Interoperability Framework.
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7  Anhänge
7.1  Beispiele Exportformat 

Zur Demonstration der XML-Ausgabeformate wurde eine sehr kurze, nur aus sechs Zeilen bestehende 
Seite gewählt:

66 Faksimile – Beispielseite



88 Volltext Via oCR  –  MögliChkeiten und gRenzen

67 Bit-alpha export alto

(a) Bit-alpha: 
ALTO



89

68 Bit-alpha export alto (Fortsetzung)

anhänge



90 Volltext Via oCR  –  MögliChkeiten und gRenzen

69 Bit-alpha export alto (Fortsetzung)
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70 hk-oCR export FineReader-xMl

(b) hk-oCR: 
FineReader-XML           

anhänge



92 Volltext Via oCR  –  MögliChkeiten und gRenzen

71 hk-oCR export FineReader-xMl (Fortsetzung)
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72 hk-oCR export FineReader-xMl (Fortsetzung)

anhänge



94 Volltext Via oCR  –  MögliChkeiten und gRenzen

73 hk-oCR export FineReader-xMl (Fortsetzung)
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74 hk-oCR export FineReader-xMl (Fortsetzung)

anhänge



96 Volltext Via oCR  –  MögliChkeiten und gRenzen

75 hk-oCR export FineReader-xMl (Fortsetzung)
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76 hk-oCR export kompaktes xMl

HK-XML
Mit Koordinaten auf Wort- statt auf Zeichenebene ist auch ein deutlich kompakteres Format möglich:

   

anhänge
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7.2  kurzanleitungen für einfache Fälle
7.2.1 OCR (Muster- und Wortbibliothek müssen vorliegen):

 
 Vorbereitung:
 bda-Datei bereitstellen (für Binarisierungseinstellungen und Muster) (s. Kap. 4.1)

  lx2-Datei bereitstellen (für Wortkorrektur) (s. Kap. 4.1)

  BIT-Alpha-Sitzung:
 File > Open
  bda-Datei wählen 
 (Nur falls in einer bit-Datei gespeicherte Muster verwendet werden sollen:) 
 OCR > Library > Load 
  bit-Datei wählen 
 (Nur falls in einer seq-Datei gespeicherte Sequenzen verwendet werden sollen:) 
 OCR > Sequences > Load 
  seq-Datei wählen
 OCR > Lexical Correction > Load
  lx2-Datei wählen
 File > Settings > OCR 
  aktivieren:
   Iterate recognition
   Disjunction
   Spellcheck
 File > Load image
  TIFF-Bild wählen 
   => OCR beginnt
 File > Export
  gewünschtes Ausgabeformat wählen

 Vorbereitung:
 Zu bearbeitende Bilder in einem Verzeichnis versammeln 
 bda-Datei bereitstellen (für Binarisierungseinstellungen und Muster) (s. Kap. 4.1)
 lx2-Datei bereitstellen (für Wortkorrektur) (s. Kap. 4.1)

 BIT-Alpha-Sitzung:
 File > Open
  bda-Datei wählen
 OCR > Lexical Correction > Load
  lx2-Datei wählen
 File > Settings > OCR 
  aktivieren:
   Iterate recognition
   Disjunction
   Spellcheck

(a) BIT-Alpha (Beispiel mit Musterbibliothek in bda-Datei und lexikalischer korrektur):

Einzelseite

Stapelverarbeitung
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 File > Batch process ...
  Bild-Verzeichnis und Export-Verzeichnis und Export-Formate einstellen (Achtung, 
  „Autolearn“ hier im Regelfall deaktivieren!)
  > OK

 
 Vorbereitung:
 Zu bearbeitende Bilder in einem Verzeichnis versammeln
 Bei der Installation werden die Pfade der Muster- und Sprachdateienverzeichnisse eingestellt, 

z. B.:
  <VERZEICHNIS>\UserPattern

  <VERZEICHNIS>\CustomLanguageFolder

  <VERZEICHNIS>\CustomBaseLanguageFolder

  <VERZEICHNIS>\DictionaryFolder

 In diesen Verzeichnissen Muster- und Sprachdateien bereitstellen (s. Kap. 4.1)

 HK-OCR-Sitzung:
 Bild öffnen > Ordner wählen
  Bildverzeichnis einstellen (ist zugleich Exportverzeichnis)
 Reiter „Einstellungen“
  Standardsprachen
   alle deaktivieren, wenn eigene Sprachengruppe genommen wird
  Eigene Sprachengruppen
   aktivieren der gewünschten Sprachengruppe (Haken setzen kann 2 Klicks erfordern)
  Erkennungsmuster
   aktivieren:   „Musterdatei verwenden“
   deaktivieren:   „interne Muster verwenden“
   Button „..“:  Musterdatei auswählen
  Schriften
   aktivieren:   „Normal“ 
   aktivieren:   „Fraktur“ 
   deaktivieren:   „Schreibmaschine“ 
  weitere Optionen
   aktivieren:   „Bild ausrichten“
   aktivieren:   „verw. vorhandene Layouts“
  Qualitätsoptimierung
   aktivieren:   „Voting“
   aktivieren:   „Versuchsautomatik“
   „4 Versuche max.“
  aktivieren:    „Automatisch Speichern“
 Reiter „Speichern“
  > XML, PDF, RTF
   Ausgabeformate einstellen, mindestens „FR-XML“
  > Nach Speichern
   alles deaktivieren
 OCR starten 
  [für Einzelseite:] > aktuelles Bild lesen
  [für Stapelverarbeitung:] > Alle Bilder lesen

  

AnHänGE

(b) Hk-OCR (Beispiel mit Musterbibliothek und nutzerwörterbuch):

Einzelseite und Stapelverarbeitung
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7.2.2 Training (Anlegen bzw. Erweitern von Musterbibliotheken)

 

 Musterdatei wählen oder erstellen:
 (Falls bda-Datei schon existiert:) 
  File > Open 
   bda-Datei wählen
 (Nur falls in einer bit-Datei gespeicherte Muster verwendet werden sollen:) 
  OCR > Library > Load 
   bit-Datei wählen
 (Nur falls in einer seq-Datei gespeicherte Sequenzen verwendet werden sollen:) 
  OCR > Sequences > Load 
   seq-Datei wählen

 Bild laden:
 File > Load image
  TIFF-Bild wählen 
   => OCR-Analyse der Seite beginnt, abwarten

 Training
 View > Layer > Analyzed
  sollte Zeichensegmentierung erkennen lassen (wenn nicht: Binarisierungseinstellungen 
  verbessern)
 View > Layer > OCR
  zeigt in jedem Zeichensegment entweder das binarisierte Bild der Zeichenregion oder,  

 wenn ein mehr oder weniger passendes Muster gefunden wurde, das „erkannte“ Zeichen  
 in einem farbigen Feld von rot („sehr unsicher“) über orange und gelb zu grün („sichere“  
 Zuordnung zu einem sehr ähnlichen Muster) bis zu blau (für genau dieses Binärbild ist  
 schon beim Training ein Zeichen gelernt worden).

 OCR > Autorefresh 
– entweder aktivieren (nach jeder Trainingseingabe wird die Musterbibliothek neu kom-

piliert, das führt jeweils zu mehreren Minuten Wartezeit, zeigt dann aber im Layer 
„OCR“ sofort den neuen Erkennungsstand der Seite an)

– oder deaktivieren (Trainingseingaben werden ohne Einkompilierung und ohne Neuan-
zeige der Seite zwischengespeichert), dafür kann ohne Zeitverzug weitertrainiert wer-
den. Eine Neukompilierung der Musterbibliothek und damit Anzeige-Aktualisierung 
erreicht  man jederzeit durch einen Aufruf:

  OCR > Refresh
 Im Layer „OCR“ kann nun frei das nächste zu trainierende Zeichen101 gewählt werden (mit 

Maus anklicken). Es erscheint das Trainingsfenster „Verify Recognition“, wo das binäre Zei-
chenmuster in verschiedenen Ansichten gezeigt wird und im Feld „Recognition result > this 
String-Value“ der Zeichenwert für dieses Muster eingegeben werden kann. Im Rahmen „Ac-
tion“ wird durch „Update“ der Zeichenwert dem Muster zugeordnet.

101 Zweckmäßigerweise wird man zunächst die sehr schlecht erkannten Zeichen (rot und orange unterlegte) oder die noch gar nicht erkannten Zeichen (binäres 
Image im Segment) wählen.

(a) BIT-Alpha
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 Speichern der Muster nach Ende des Trainings:
–  entweder zusammen mit den Binarisierungs- und Segmentierungsparametern 
 in die bda-Datei:  
  File > Save
–  oder separat in eine bit-Datei:
  OCR > Library > Save

 

 Musterdatei wählen oder erstellen:
 Reiter „Einstellungen“ > Rahmen „Erkennungs-Muster“ > Button „..“
 
 Bild laden:
  Bild öffnen > Ordner wählen > Ordner wählen
  In Rahmen „Stapel“ Bilddatei auswählen (z. B. Doppelklick)

 Training:
 Reiter „Einstellungen“
  Rahmen „Erkennungs-Muster“:
   Checkbox „Musterdatei verwenden“ deaktivieren
   Checkbox „Training“ aktivieren
  Rahmen „Schriften“
   mindestens eine Checkbox für Schriftfamilie aktivieren (z. B. „Fraktur“)
  Rahmen „Standardsprachen“ und/oder „Eigene Sprachengruppen“
   passende Sprache wählen (hiervon hängt der mögliche Zeichenvorrat ab)
 OCR starten > Aktuelles Bild lesen

 Nach Einlesen des Bilds erscheint das Trainingsfenster „Pattern Training“ und springt zum ers-
ten bzw. nächsten  Zeichensegment.102 Im Eingabefeld kann ein Zeichen oder eine Zeichenfolge 
(„ligature“) neu eingetragen bzw. geändert und mit „Train“ bestätigt werden. Wenn bereits das 
richtige Zeichen vorgeschlagen wurde, kann es mit „Train“ bestätigt oder mit „Skip“ übergan-
gen werden. Muster, die nicht trainiert werden sollen, müssen mit „Skip“ übergangen werden.

 In begrenztem Maße können die Segmentgrenzen vergrößert oder verkleinert werden (Ziehen 
mit der Maus oder Buttons „<<„ bzw. „>>„ soweit aktiv).

 Speichern der Muster nach Ende des Trainings:
 Nach Schließen des Trainingsfensters können die trainierten Muster in die ptn-Datei gespeichert 

werden, nach Erreichen des Seitenendes geschieht das automatisch (zur Kontrolle ist empfoh-
len, Datum und aktuelle Dateigröße der ptn-Datei im Musterdateiverzeichnis zu überprüfen).

       

102 Das nächste zu trainierende Zeichen kann nicht frei ausgewählt werden; man wird von Anfang bis Ende durch die Seite geführt.

AnHänGE

(b) Hk-OCR
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7.3 Details zu einzelnen Parametern

Hinweis: Die angegebenen Informationen stammen teils aus dem knappen Handbuch, teils aus der 
Schulung des Herstellers und teils aus eigenen Tests.

Systemeinstellungen:

   Zweck:    Priorität einstellen, mit der BIT-Alpha den Prozessor 
      belasten darf
   Werte:    „Idle“ bis „Time critical“ (sehr zu Lasten aller anderen 
      Anwendungen)
   Verwendet:   „Normal“

              
Einstellung einer bda-Datei:         

 Empfehlung: ein Image mit mittlerer Helligkeit und mittlerem Kontrast laden, um Parameterän-
derungen testen zu können.

             
File  >  Settings [in empfohlener Reihenfolge der Einstellungen bei Beginn:]  

–  ganze Seite und erste Segmentierung in Textblöcke betreffend: 
   

  Settings 
   Zweck:    Helligkeit, Kontrast und Gammakorrektur für das Image so  

     einstellen, dass eine optimale Binarisierung erreicht wird.
   Orientierung:  Ansicht im Layer „Binary“. Änderungen eines der drei 
      Parameter können Nachjustierungen der anderen erforderlich  

     machen. 
– Contrast       
 verwendete Werte:  0.5–0.6  (Durchschnitt: 0.52, am häufigsten: 0.5)
– Intensity          

typischer Wertebereich:  0.4–0.6; verwendet: 0.4–0.51 (Durchschnitt: 0.49, 
    am häufigsten: 0.5)
 Wann erhöhen?   z. B. wenn Buchstaben zusammenkleben
 Wann erniedrigen?  z. B. wenn das Bild zu hell ist
– Gamma   verwendet: 1

  Margins        
   Zweck:    Randbereiche des Images von der OCR ausschließen 
   Orientierung:  Ansicht in Layer „Binary“: dunkelblauen Rahmen 
      passend einstellen

–  left (cm)       
 verwendete Werte:  0.5–0.7  (Durchschnitt: 0.52, am häufigsten: 0.5)
–  right (cm)       
 verwendete Werte:  0.5–0.7  (Durchschnitt: 0.52, am häufigsten: 0.5)

(a) Parametervielfalt BIT-Alpha

 Menü File > Settings > Preprocessing:

 Menü File > Settings > System > Thread Priority:

 Menü File > Settings > Color Enhancement:
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–  top (cm)       
 verwendete Werte:  0.5–1.2  (Durchschnitt: 0.71, am häufigsten: 0.7)
–  bottom (cm)       
 verwendete Werte:  0.5–1.2  (Durchschnitt: 0.72, am häufigsten: 0.7)

  Blackborder-Elimination        
   Orientierung:  Ansicht in Layer „Binary“: hellblauen Rahmen passend  

     einstellen
–  left (cm)       
 verwendete Werte:  0.5–0.7  (am häufigsten: 0.5)
–  right (cm)       
 verwendete Werte: 0.5–0.7  (am häufigsten: 0.5)
–  top (cm)       
 verwendete Werte:  0.7–1.2  (am häufigsten: 0.7)
–  bottom (cm)       
 verwendete Werte:  0.5–1.2  (am häufigsten: 0.7)
–  Enabled       
 verwendet:   in der Regel aktiviert

  Binarisation        
   Zweck:    Einstellung der „ersten“ (für die Segmentierung 
      verwendeten) Binarisierung
   Algorithmen:  „Color based algorithm“, „BIT“, „Intensity based algorithm“, 
      „Modified Niblack algorithm“
   Verwendete Auswahl: „Modified Niblack algorithm“ (für Fraktur empfohlen)

–  Configure 
 > Intensity based algorithm 
 > Relative Intensity threshold % 
 verwendete Werte:  35–60 (Durchschnitt: 46.94, am häufigsten: 50)
 Wann erhöhen:  bei hellem Bild
 Wann erniedrigen: bei dunklem Bild
–  „Clean binarised image“       
 Zweck:    entfernt „Wolkenstaub“; 
 Wann deaktivieren:  bei sehr „dünnen“ Vorlagen mit schwachem Kontrast
–  „Remove dots“       
 Zweck:   enfernt „größere“ Punkte
 Wann aktivieren:  z. B. bei Mikrofilm; rechnerintensiv
–  min. dist. cm      
 verwendete Werte:  0.02–0.09 (Durchschnitt: 0.05, am häufigsten: 0.04)
–  max. size cm      
 verwendete Werte:  0.05–0.15 (Durchschnitt: 0.10, am häufigsten: 0.09)

  Rotation        
   Zweck:    Seitenausrichtung anhand erkannter Linien
   Algorithmen:   „Linear Algorithm“ (versucht, Rechtwinkligkeit 
      wiederherzustellen), „Circular Algorithm“ (Rotation, Winkel  

     bleiben erhalten)
   Verwendet:   „Circular Algorithm“ und ohne Rotation

–  min. angle (degrees)       
 verwendete Werte:  0.01

AnHänGE
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  Limits (im Image gespeicherte Maßeinheiten und Auflösung müssen korrekt sein)
   Zweck:    Entfernung von vertikalen Linien

–  max. thickness cm       
 verwendete Werte:  0.1–0.8 (Durchschnitt: 0.54, am häufigsten: 0.8)
–  min. thickness cm       
 verwendete Werte:  0.01
–  min. black length cm       
 Zweck:    minimale Länge eines gedruckten „Zeichens“ in eventuell 
    unterbrochenen Linien
 verwendete Werte:  0.4–0.9 (Durchschnitt: 0.54, am häufigsten: 0.4)
–  max. white length cm       
 Zweck:    maximaler weißer Zwischenraum in eventuell gepunkteten 
    oder unterbrochenen Linien
 verwendete Werte:  0
–  min. total length cm       
 Zweck:    minimale totale Länge, um zu definieren, ab wann eine Linie  

   als solche erkannt werden soll, die eventuell gepunktet oder  
   unterbrochen ist

 typischer Wertebereich:  -3
 verwendete Werte:  0.75–10 (Durchschnitt: 5.24, am häufigsten: 10)
 Wann erhöhen:   + wenn „falsche Linien“ (z. B. aus übereinander stehenden  

   m-Füßen) erkannt werden
–  Use bitmap       
 Zweck:    Gescanntes Bild der Linie wiedergeben, statt sie ideal 
    nachzuzeichnen
 verwendete Werte:  Aktiviert

  Limits (im Image gespeicherte Maßeinheiten und Auflösung müssen korrekt sein)
   Zweck:    Entfernung von horizontalen Linien zur besseren 
      Absatztrennung (aber nicht erwünscht, wenn keine 
      Linien da sind)

–  max. thickness cm       
 Zweck:    maximale Breite des Strichs der Linie
 verwendete Werte:  0.1–0.5 (Durchschnitt: 0.36, am häufigsten: 0.4)
–  min. thickness cm       
 Zweck:    minimale Breite des Strichs der Linie
 verwendete Werte:  0
–  min. black length cm       
 Zweck:    minimale Länge eines gedruckten „Zeichens“ in eventuell 
    unterbrochenen Linien
 verwendete Werte:  0.4–0.9 (Durchschnitt: 0.59, am häufigsten: 0.5)

 Menü File > Settings > Lines V        

 Menü File > Settings > Lines H        
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–  max. white length cm       
 Zweck:    maximaler weißer Zwischenraum in eventuell gepunkteten  

   oder unterbrochenen Linien
 verwendete Werte:  0.1
–  min. total length cm       
 Zweck:    minimale totale Länge, um zu definieren, ab wann eine Linie  

   als solche erkannt werden soll, die eventuell gepunktet oder 
    unterbrochen ist
 verwendete Werte:  0.75–10 (Durchschnitt: 5.13, am häufigsten: 10)
–  Use bitmap       
 Zweck:    Gescanntes Bild der Linie wiedergeben, statt sie ideal 
    nachzuzeichnen 
 verwendete Werte:  Aktiviert

  Parameters (im Image gespeicherte Maßeinheiten und Auflösung müssen korrekt sein)
 Zweck:    Einstellungen für die Segmentierung der Seite in 
    verschiedene Regionen, d. h. Paragraphen, Titel, Untertitel  

   und graphische Elemente
–  min. horiz. distance cm       
 Zweck:    die minimal erlaubte horizontale Distanz zwischen 
    benachbarten Regionen. Näher beieinander liegende 
    Regionen werden zusammengefügt.
 verwendete Werte:  1–2 (Durchschnitt: 1.83, am häufigsten: 2)
 Praxiserfahrungen:  Bei zunächst deaktivierter „Dissection“ justieren, bis in der  

   „Binary“-Ansicht der prozessierten Seite die grauen 
    Teilrahmen korrekt sind (z. B. Satzspiegel)
–  min. vert. distance cm       
 Zweck:    die minimal erlaubte vertikale Distanz zwischen 
    benachbarten Regionen. Näher beieinander liegende 
    Regionen werden zusammengefügt.
 verwendete Werte: 0.5–2 (Durchschnitt: 1.69, am häufigsten: 2)
–  min. width cm       
 Zweck:    die minimal erlaubte horizontale Breite für die Erstellung 
    einer Region.
 verwendete Werte:  0.1
–  min. height cm       
 Zweck:    die minimal erlaubte vertikale Höhe für die Erstellung 
    einer Region.
 verwendete Werte: 0.1
–  Default Region Type       
 Zweck:    BIT-Alpha teilt jeder bei der Segmentierung kreierten Region 
    Eigenschaften über den Typ des Bilds in der Region zu. 
 Werte:    „Binary Region“: monochromes Bild (Schwarz-weiß), 
    „Palette Region“: Graustufenbild, jeder Pixel mit 8 bit kodiert,  

   „color region“: Farbbild, jeder Pixel mit 8 oder 16 bit kodiert
 verwendete Werte:  „Binary Region“

AnHänGE

 Menü File > Settings > Segmentation       
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File  >  Settings  
–  betreffend Segmentierung in unterblöcke: 

   
  Dissection  
   Zweck:    betrifft zusätzlich Unterteilung nach Abständen zwischen 
      Textblöcken; Teilblöcke werden dann automatisch 
      separat eingestellt
   Praxiserfahrungen:  Justieren, bis in der Binary-Ansicht der prozessierten Seite  

     die grauen Teilrahmen korrekt sind (z. B. Absätze, Strophen ...). 
      Nachjustieren kann Abhilfe schaffen, wenn in manchen 
      Textblöcken keine Zeichen-Segmentierung erfolgt ist.

–  min. width cm       
 Zweck:    Versuch, ab dieser Breite den Textblock zu teilen
 verwendete Werte:  5-10 (Durchschnitt: 7.94, am häufigsten: 9)
–  min. height cm       
 Zweck:    Versuch, ab dieser Höhe den Textblock zu teilen
 verwendete Werte:  4–10 (Durchschnitt: 5.00, am häufigsten: 4)
–  enable hor. dissection       
 Zweck:    versucht, entlang „waagerechter weißer Streifen“ zu teilen
 verwendete Werte:  Aktiviert
–  hor. dissection threshold % (Prozent-Anteil weiß im Zwischenraum)
 verwendete Werte:  95–99 (Durchschnitt: 97.83, am häufigsten: 98)
–  hor. dissection thickness cm (Mindestbreite weiß)
 verwendete Werte:  0.01-0.3 (Durchschnitt: 0.13, am häufigsten: 0.2)
–  enable vert. dissection       
 Zweck:    versucht, entlang „senkrechter weißer Streifen“ zu teilen
 verwendete Werte:  Aktiviert
–  vert. dissection threshold %      
 verwendete Werte:  95-99 (Durchschnitt: 98.11, am häufigsten: 99)
–  vert. dissection thickness cm      
 verwendete Werte:  0.01-0.5 (Durchschnitt: 0.24, am häufigsten: 0.2)
 Wann verändern:  Wenn Textblöcke nicht als solche erkannt werden und „Image 
     detection“ nicht deaktiviert werden soll

  Resolution        
   Zweck:    Angabe der korrekten Auflösung, falls in den Image-
      Metadaten nicht korrekt enthalten
   verwendete Werte:  Aktiviert

  Image detection        
   Zweck:    Erkennung von Bildregionen (Illustrationen usw.), die von  

     der OCR ausgenommen werden sollen
   Wann deaktivieren:  wenn Textblöcke fälschlich als Bild interpretiert werden 
      (keine Zeichensegmentierung in Ansicht „Analyzed“) 
      und eine Änderung  der „vert. dissection thickness cm“   

     keine Abhilfe bringt

 Menü File > Settings > Segmentation   
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–  enabled
 verwendete Werte:  Aktiviert, Deaktiviert (am häufigsten: Aktiviert)
–  hor.      
 verwendete Werte:  0.45-1 (Durchschnitt: 0.57, am häufigsten: 0.45)
–  vert.      
 verwendete Werte:  0.45-1 (Durchschnitt: 0.57, am häufigsten: 0.45)

File  >  Settings 
–  betreffend Zeichenregionen:  
      
        
 Detection          

–  Detect binary regions         
Zweck:    Unterscheidung von Zeichen (für OCR) und Bildregionen 

    (für bildliche Wiedergabe)
 Hinweis:   Parametrierung unnötig, wenn in Preprocessing  
    > Segmentation > Default Region Type „Binary Region“ 
    eingestellt wurde
 verwendete Werte:  Aktiviert, Deaktiviert (am häufigsten: Aktiviert)

 
 Binarisation        

 Praxiserfahrungen:  In Ansicht „Analysed“ und „OCR“ auf gute Zeichensegmen- 
   tierung achten und darauf, dass keine Textblöcke aus der 

    Zeichensegmentierung herausfallen
   Algorithmen:  „Color based algorithm“
      „BIT-Algorithmus“
      „Intensity based algorithm“
      „Modified Niblack algorithm“ 
      – Konfigurationsparameter siehe unten –

– Clean binarised image        
 Empfehlung:   Deaktivieren bei sehr dünnen (aus „Punktwolken“ 
    bestehenden) Schriftzeichen
 verwendete Werte:  Aktiviert, Deaktiviert (am häufigsten: Aktiviert)
– Remove dots:        
 verwendete Werte:  Aktiviert, Deaktiviert (am häufigsten: Aktiviert)
–  min. dist. cm       
 verwendete Werte:  0.02-0.13 (Durchschnitt: 0.07, am häufigsten: 0.05)
–  max. size cm       
 verwendete Werte:  0.05-0.25 (Durchschnitt: 0.12, am häufigsten: 0.08)

 Binarisation > Color based algorithm
 verwendete Werte:  Deaktiviert

AnHänGE

Menü File > Settings > Binary regions
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 Binarisation > BIT-Algorithmus > Configure
   Hinweis:   vom Hersteller für typische Drucke empfohlen; weniger 

    für Zeitungen und Fraktur 
 verwendete Werte:  Aktiviert, Deaktiviert (am häufigsten: Deaktiviert)
– Minimum > horiz.    
 verwendete Werte: 0.01-0.025 (am häufigsten: 0.02)
 Wann erhöhen:  bei blassem Druck
– Minimum > vert.    
 verwendete Werte:  0.01-0.025 (am häufigsten: 0.02)
– Maximum > horiz.    
 verwendete Werte:  2-4 (am häufigsten: 2)
 Wann erhöhen:   bei blassem Druck
– Maximum > vert.    
 verwendete Werte:  2-4 (am häufigsten: 2)
– Binarisation > cut-off    
 verwendete Werte:  0.4-0.53 (am häufigsten: 0.5)
 Wann erhöhen:   bei blassem Druck (wenn Buchstaben dunkler werden sollen)
 Wann erniedrigen:  gegen Durchdruck 

 Binarisation > Intensity based algorithm > Configure
 verwendete Werte:  Aktiviert, Deaktiviert (am häufigsten: Deaktiviert) 
– Relative Intensity threshold %     
 typischer Wertebereich:  50-70
 verwendete Werte:  50, 61 (am häufigsten: 50)
 Wann erhöhen:   wenn schwacher Kontrast
 Wann erniedrigen:  wenn Zeichen zusammenkleben (zu dunkel)

 Binarisation > Modified Niblack algorithm > Configure
 Hinweis:   nutzt dynamischen Kontrast (Varianz der Helligkeit) um 
    jeden Buchstaben herum, erkennt eher Kontur als „schwere“  

   Innenbereiche; für Fraktur empfohlen
 verwendete Werte:  Aktiviert, Deaktiviert (am häufigsten: Aktiviert)  
– Noise reduction: 
  – Enable noise reduction    
   verwendete Werte:   Aktiviert
  – Vertical noise frequency (mm):    
   verwendete Werte:   0.25-0.5 (am häufigsten: 0.5)
  – Horizontal noise frequency (mm):    
   verwendete Werte:   0.25-0.5 (am häufigsten: 0.5)
– Configuration:          

 – Vertical adjustment radius (cm):    
   verwendete Werte:   0.2-0.25 (am häufigsten: 0.25)
  – Horizontal adjustment radius (cm):    
   verwendete Werte:   0.2-0.25 (am häufigsten: 0.25)
  – Noise threshold (%):    
   verwendete Werte:   9-10 (am häufigsten: 10)
   Wann erhöhen:    wenn zu dunkel
   Wann erniedrigen:  wenn Zeichen brüchig sind
  – Noise factor:  
   verwendete Werte:   1

Menü File > Settings > Binary regions [Forts.]
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 Target Size        

 Zweck:    minimale und maximale akzeptierte Zeichengröße
–  min. width (cm)       
 verwendete Werte:  0.03–0.05 (Durchschnitt: 0.04, am häufigsten: 0.03)
 Wann erniedrigen:  wenn Text fälschlich als Miniatur erkannt wird
 Praxiserfahrungen:  in Ansicht „OCR“ so groß wie ohne Lücken möglich einstellen
–  max. width (cm)       
 verwendete Werte:  0.035–6 (Durchschnitt: 3.84, am häufigsten: 4)
 Hinweis:   ggf. an Initialen denken
–  min. height (cm)       
 verwendete Werte:  0.03–0.05 (Durchschnitt: 0.04, am häufigsten: 0.03)
–  max. height (cm)       
 verwendete Werte:  3-4 (Durchschnitt: 3.83, am häufigsten: 4)
 Hinweis:   ggf. an Initialen denken

 Options        
 Hinweis:   Optionen primär für OCR-Lauf sinnvoll; im Training 
    dagegen diese zunächst deaktivieren! Nach dem ersten 
    Training kann erst mit „Iterate“, dann mit „Iterate+Disjunction“ 
    das Training wiederholt werden.
–  Iterate recognition       
 Zweck:    entfernt z. B. Punkte bei nicht erkannten Zeichen.
 verwendete Werte 
 (im OCR-Lauf):  Aktiviert
–  Disjunction       
 Zweck:    Trennung von zusammengeklebten Charakteren für die OCR- 

   Bearbeitung 
 verwendete Werte  
 (im OCR-Lauf):  Aktiviert, Deaktiviert (am häufigsten: Aktiviert)
–  Spellcheck  
 Hinweis:  Sprachkorrektur per Wortliste für die OCR-Bearbeitung 
    aktivieren (s. „Lexika“)
 verwendete Werte 
 (im OCR-Lauf):  Aktiviert, Deaktiviert (am häufigsten: Aktiviert)

   
  
  Target Size 

– min. width (cm)      
 verwendete Werte: 0.03-0.05 (am häufigsten: 0.04)
– max. width (cm)      
 verwendete Werte:  3-6 (am häufigsten: 4)
– min. height (cm)      
 verwendete Werte:  0.03-0.05 (am häufigsten: 0.04)
– max. height (cm)      
 verwendete Werte:  3-4 (am häufigsten: 4)

AnHänGE

Menü File > Settings > OCR

 Menü File > Settings > OCR > Advanced Settings > Edit
 (muss für jede Schriftfamilie separat eingestellt werden)     
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  Miniatures   
 Zweck:    Erkennung von Initialen
–  Min. Overlap      
 verwendete Werte: 0.02–0.3333 (Durchschnitt: 0.12, am häufigsten: 0.05)
–  min. X (rel.)      
 verwendete Werte:  3–9 (Durchschnitt: 5.78, am häufigsten: 6)
–  min. Y (rel.)      
 verwendete Werte:  3–9 (Durchschnitt: 5.78, am häufigsten: 6)

  Classification 
 Zweck:    je nach Variabilität der Schriftform103, relativ zur 
    Minuskelhöhe einstellbare Größenverhältnisse von: [P]atte  

   (senkrechtes Bein bzw. kleiner senkrechter Strich, z. B. i ohne 
    Punkt), [M]inuscule (Kleinbuchstabe), [G]rand 
    (Großbuchstabe bzw. großer Strich, [R]este (kleineres 
    Element als Patte, Minuscule oder Grand, z. B. „.“ oder „-“)
–  Minuscule min. X      
 verwendete Werte:  0.3-0.5 (Durchschnitt: 0.4, am häufigsten: 0.4)
–  Minuscule min. Y      
 verwendete Werte:  0.5-0.8 (Durchschnitt: 0.71, am häufigsten: 0.7)
–  Minuscule max. Y      
 verwendete Werte:  1.05-1.2 (Durchschnitt: 1.11, am häufigsten: 1.1)
–  Collation min. Y      
 Zweck:    Abschneiden von über die Gesamtgröße hinausgehenden  

   Zeichen
 verwendete Werte:  1.8-2.5 (Durchschnitt: 2.03, am häufigsten: 2)
 Praxiserfahrungen:  Heraufsetzen kann Abhilfe schaffen, wenn in Bereichen keine 
    Zeichensegmentierung erfolgte.

  Lines
 Hinweis:  muss für jede Schriftfamilie separat eingestellt werden 

   Zweck:    Zeileneigenschaften
   Hinweis:   In Menü und Handbuch wird „Line“ teils für „Zeile“, teils für
       „Linie“ verwendet.

– Topline min.  
 verwendete Werte: 0
–  Bottomline min.      
 verwendete Werte:  0.25-0.5 (Durchschnitt: 0.31, am häufigsten: 0.27)
–  Topline max.      
 verwendete Werte:  0.25-0.6 (Durchschnitt: 0.37, am häufigsten: 0.35)
–  Bottomline max.      
 verwendete Werte:  0.3-0.6 (Durchschnitt: 0.36, am häufigsten: 0.3)
–  Rigidity      
 Zweck:    Starrheit der (Zeilen-)Linienführung
 verwendete Werte:  5-9 (Durchschnitt: 6.44, am häufigsten: 7)
 Wann erhöhen:   + um weniger Krümmung zu erlauben
 Wann erniedrigen:  – um mehr Krümmung zu erlauben

103 Die Parametrierung dieses Menüs wird grundsätzlich von B.I.T. selbst und nicht vom Benutzer vorgenommen. Die Einstellungen sind für Fraktur, Kursivschrift 
der Renaissance oder gerade Antiqua unterschiedlich.

 Menü File > Settings > OCR > Advanced Settings > Edit [Forts.]
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–  Min. Limit      
 verwendete Werte:  0.3-0.9 (Durchschnitt: 0.63, am häufigsten: 0.8)
–  Max. Limit      
 verwendete Werte:  1-1.5 (Durchschnitt: 1.33, am häufigsten: 1.5)
–  Large Smear      
 Zweck:    Berechnung der Zeilenerkennung mittels „Verwischen“ der
    Großbuchstaben 
 verwendete Werte:  3-7 (Durchschnitt: 4.67, am häufigsten: 5)
 Praxiserfahrungen:  Erniedrigen kann Abhilfe schaffen bei „verschluckten“ Zeilen
–  Small Smear      
 Zweck:    Berechnung der Zeilenerkennung mittels „Verwischen“ der  

   Kleinbuchstaben
 verwendete Werte:  0.3-0.5 (Durchschnitt: 0.41, am häufigsten: 0.5)
–  Merge Distance      
 Zweck:    Einstellung, ab wann Zeilen als separat gesehen werden sollen
 verwendete Werte:  0.75-3 (Durchschnitt: 1.53, am häufigsten: 1)
–  Merge Overlap      
 verwendete Werte:  0.3-0.9 (Durchschnitt: 0.56, am häufigsten: 0.9)
–  Up-Factor      
 verwendete Werte:  0.13-0.5 (Durchschnitt: 0.24, am häufigsten: 0.2)
–  Down-Factor      
 verwendete Werte:  0.15-0.5 (Durchschnitt: 0.22, am häufigsten: 0.17)
–  Horiz. Locality      
 verwendete Werte:  2-4 (Durchschnitt: 3.61, am häufigsten: 4)
–  Vert. Locality      
 verwendete Werte:  1-2 (Durchschnitt: 1.83, am häufigsten: 2)

  R-R (Abstand bei Kombination der Klassen „Reste“-“Reste“)
–  Horizontal      
 verwendete Werte:  0.05-0.3 (Durchschnitt: 0.12, am häufigsten: 0.1)
–  Vertical      
 verwendete Werte:  0.2-0.9 (Durchschnitt: 0.72, am häufigsten: 0.9)

  R-P (Abstand bei Kombination der Klassen „Reste“-“Patte“)
–  Horizontal      
 verwendete Werte:  0.1-0.2 (Durchschnitt: 0.13, am häufigsten: 0.1)
–  Vertical      
 verwendete Werte:  0.7-1.5 (Durchschnitt: 0.98, am häufigsten: 0.9)

  R-M (Abstand bei Kombination der Klassen „Reste“-“Minuscule“)
–  Horizontal      
 verwendete Werte:  0.05-0.2 (Durchschnitt: 0.12, am häufigsten: 0.1)
–  Vertical      
 verwendete Werte:  0.7-1.5 (Durchschnitt: 0.98, am häufigsten: 0.9)

  R-G (Abstand bei Kombination der Klassen „Reste“-“Grand“)
–  Horizontal      
 verwendete Werte:  0.1-0.2 (Durchschnitt: 0.13, am häufigsten: 0.1)
–  Vertical      
 verwendete Werte:  0.4-1.5 (Durchschnitt: 1.02, am häufigsten: 0.9)

AnHänGE
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  M-M (Abstand bei Kombination der Klassen „Minuscule“-“Minuscule“)
–  Horizontal      
 verwendete Werte:  0.02-0.1 (Durchschnitt: 0.04, am häufigsten: 0.03)
–  Vertical      
 verwendete Werte:  0.9-1.5 (Durchschnitt: 0.98, am häufigsten: 0.9)

  P-P (Abstand bei Kombination der Klassen „Patte“-“Patte“)
–  Horizontal      
 verwendete Werte:  0.05-0.2 (Durchschnitt: 0.12, am häufigsten: 0.1)
–  Vertical      
 verwendete Werte:  0.5-0.9 (Durchschnitt: 0.85, am häufigsten: 0.9)

  M-P (Abstand bei Kombination der Klassen „Minuscule“-“Patte“)
–  Horizontal      
 verwendete Werte: 0.05-0.15 (Durchschnitt: 0.09, am häufigsten: 0.1)
–  Vertical      
 verwendete Werte:  0.5-0.9 (Durchschnitt: 0.88, am häufigsten: 0.9)

  G-P (Abstand bei Kombination der Klassen „Grand“-“Minuscule“)
–  Horizontal      
 verwendete Werte:  0.05-0.2 (Durchschnitt: 0.08, am häufigsten: 0.05)
–  Vertical      
 verwendete Werte: 0.5-5 (Durchschnitt: 1.29, am häufigsten: 0.9)

  G-G (Abstand bei Kombination der Klassen „Grand“-“Grand“)
–  Horizontal      
 verwendete Werte:  0.02-0.07 (am häufigsten: 0.05)
–  Vertical      
 verwendete Werte:  0.9-2 (Durchschnitt: 1.13, am häufigsten: 0.9)

  M-G (Abstand bei Kombination der Klassen „Minuscule“-“Grand“)
–  Horizontal      
 verwendete Werte:  0.02-0.05 (Durchschnitt: 0.04, am häufigsten: 0.05)
–  Vertical      
 verwendete Werte:  0.9-2 (Durchschnitt: 1.13, am häufigsten: 0.9)

  

  PDF        
– only text       
 Zweck:    Bild nicht mitexportieren
 verwendete Werte:  Deaktiviert
– one single image ebedded per page       

Zweck:    Nur ein Bild pro Seite (Kopie des Original-Faksimiles) 
    einbetten. Der per OCR gelesene Text ist für Textsuche und 
    Highlighting als unsichtbares Hintergrundbild hinterlegt.
 verwendete Werte:  Aktiviert, Deaktiviert (am häufigsten: Deaktiviert)

Menü File > Settings > Export

 Menü File > Settings > OCR > Advanced Settings > Edit [Forts.]
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– one image embedded for each segmented region      
Zweck:    Jede bei der Segmentierung der Seite erstellte Region auch als 

    Bild einbetten (kann dann separat aus dem PDF 
    geöffnet werden).
 verwendete Werte:  Aktiviert, Deaktiviert (am häufigsten: Aktiviert)
– Create high-resolution links for text regions     
 verwendete Werte:  Aktiviert, Deaktiviert (am häufigsten: Deaktiviert)

  METS/ALTO        
– relative to the original image 
 Zweck:    Koordinaten auf das originale Bild beziehen (sinnvoll, wenn  

   dieses und nicht auf das zur OCR ggf. gedrehte Bild 
    präsentiert wird)
 verwendete Werte:  Aktiviert

 
OCR           

 
  Learning configuration 

–  min.: 
 typischer Wertebereich:  0.55 bei „use Spellcheck“, 0.8 ohne Spellcheck
–  max.:
 typischer Wertebereich:  0.75 bei „use Spellcheck“, 0.9 ohne Spellcheck
– use Spellcheck 
 verwendete Werte: Deaktiviert      

 

  Recognition        
–  mass-threshold       
 verwendete Werte:  0.12-0.2 (Durchschnitt: 0.15, am häufigsten: 0.14)
–  position-threshold       
 verwendete Werte:  0.12-0.16 (Durchschnitt: 0.14, am häufigsten: 0.14)
–  stretching-threshold       
 verwendete Werte:  0.12-0.3  (am häufigsten: 0.14)
–  density-threshold       
 verwendete Werte:  0.12-0.2 (Durchschnitt: 0.15, am häufigsten: 0.14)
–  confidence-threshold (nur in bestimmten BIT-Alpha-Versionen)
 verwendete Werte:  0.7-0.8 (Durchschnitt: 0.78, am häufigsten: 0.8)
–  blanks low-limit       
 verwendete Werte:  0.05-0.25 (Durchschnitt: 0.16, am häufigsten: 0.2)
–  blanks high-limit       
 verwendete Werte:  0.6-1.5 (Durchschnitt: 0.78, am häufigsten: 0.6)
–  blanks coefficient       
 verwendete Werte: 0.6-1.2 (Durchschnitt: 0.97, am häufigsten: 1)
 Wann erhöhen:   wenn mehr zusammengehalten werden soll
 Wann erniedrigen:  wenn mehr getrennt werden soll

AnHänGE

OCR > Library > Learning parameters ...      

OCR > Library > Settings...
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  Separation        
–  min. confidence       
 verwendete Werte:  0.7-0.75 (Durchschnitt: 0.73, am häufigsten: 0.75)
–  min. confidence       
 verwendete Werte:  0.6-0.75 (Durchschnitt: 0.67, am häufigsten: 0.65)
–  min.width       
 verwendete Werte:  0.4-0.5 (Durchschnitt: 0.49, am häufigsten: 0.5)
–  limit (left)       
 verwendete Werte: 0.2-0.3 (Durchschnitt: 0.22, am häufigsten: 0.2)
–  limit (right)       
 verwendete Werte:  1.2-1.7 (Durchschnitt: 1.44, am häufigsten: 1.5)
–  min. (right)       
 verwendete Werte:  0.15-0.2 (Durchschnitt: 0.19, am häufigsten: 0.2)
–  min. thickness       
 verwendete Werte:  0.1-0.5 (am häufigsten: 0.4)
–  min. complexity (left)       
 verwendete Werte:  1
–  min. complexity (right)       
 verwendete Werte:  1

  Algorithm        
–  by form      
 verwendete Werte:  Aktiviert
–  by mass      
 Zweck:    empfohlen z. B. bei chinesischen Zeichen

 

  Coefficients:        
–  Default:       
 verwendete Werte:  1-1.51  (am häufigsten: 1)
–  Split:       
 verwendete Werte:  0.70-1  (am häufigsten: 1)
 Wann erhöhen:   Trennung erschweren (auf 2 oder 3 um Trennungen zu 
    verhindern)
 Wann erniedrigen:  Trennung erleichtern
–  Symbol added/deleted:       
 verwendete Werte:  1-2.1  (am häufigsten: 1)
– (Text-area)       
 Zweck:    Für einzelne Zeichenpaare gewichtete „Ersetzungskosten“  

   einstellen (0 = Ersetzung ungehindert; 1 = keine Ersetzung)
  Signature:        

 Zweck:    wie oft ein Wort korrigiert werden kann
–  [Entry]       
 verwendete Werte:  2 oder 3  (am häufigsten: 2)
–  Disable correction for words starting with capital letters     

verwendete Werte: Deaktiviert

OCR > Lexical Correction > Edit        

OCR > Library > Settings... [Forts.]



115

  Correction:        
–  max. distance:       
 verwendete Werte:  0.2-0.5 (Durchschnitt: 0.35, am häufigsten: 0.20)
 Wann erhöhen:   wenn großzügiger ersetzt werden soll
 Wann erniedrigen:  wenn zurückhaltender ersetzt werden soll

  Split mode:        
–  Recurse fragments       
 verwendete Werte:  Aktiviert, Deaktiviert (am häufigsten: Deaktiviert)
–  Split fragments       
 verwendete Werte:  Aktiviert, Deaktiviert (am häufigsten: Aktiviert)
–  No fragmentation       
 verwendete Werte:  Deaktiviert

(b) HK-OCR / FineReader: Gibt es Potentiale durch die Erschließung von ABBYY-seitig 
angelegten Konfigurationsmöglichkeiten?

Über die Oberfläche von HK-OCR sind im wesentlichen nur die in den Kapiteln 4 und 5 beschriebenen 
Parameter konfigurierbar.  
      
Für ein Interesse an eventuell weiterführenden, in HK-OCR derzeit noch nicht realisierten Konfigura-
tionsmöglichkeiten der FineReader-Engine muss auf einschlägige ABBYY-Entwickler-Dokumentatio-
nen, speziell die darin enthaltenen Objekt-Spezifikationen verwiesen werden. 
      

AnHänGE
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7.4  Einige Mindestanforderungen an Bedieneroberflächen

Man muss die inzwischen kaum noch überschaubare Menge von Normen, Styleguides und Empfehlun-
gen zu Softwareergonomie104 keineswegs systematisch durcharbeiten, um zumindest folgende (systema-
tisch meist unter Steuerbarkeit und Erwartungskonformität einzuordnende) Anforderungen für plausibel 
zu halten. Sie spielten schon im Projektverlauf eine Rolle und können im OCR-Produktionseinsatz erst 
recht zum kritischen Faktor werden: 
      

Konfigurations-, Muster-, Lexikon- und alle anderen Dateien sollten jederzeit entladen werden können 
(Fortsetzung der Sitzung erkennbar mit den jeweiligen Default-Werten), auch ohne dass dazu eine neue 
entsprechende Datei geladen werden muss. (Die Anzeige der aktuellen Parameterdateinamen in Titel- 
oder Statuszeile muss dem natürlich folgen).  
 Besonders während Verarbeitungsschritten mit Zeitbedarf (häufig während Layoutanalyse und OCR) 
muss eine Möglichkeit zum sofortigen Abbruch angeboten werden.
Bei Abbrüchen von Stapelläufen muss es eine einfache Möglichkeit zur Fortsetzung am Abbruchpunkt 
geben, ohne dass Verzeichnisinhalte umorganisiert werden müssen.

Die Namen aller aktuell geladenen bzw. wirksamen Parameter-, Image- und sonstigen Dateien sollten 
dem Bearbeiter jederzeit ohne weitere Handgriffe, Mausaktionen, Suchschritte vor Augen stehen, z. B. 
in der Titelzeile und/oder der Statuszeile. 
 Es muss erkennbar sein, ob und wann manuelle Parameteränderungen in einer Konfigurationsdatei 
gespeichert werden, d. h. diese verändern (was man in der aktuellen Sitzung nicht immer will).
Benutzeraktionen sollen stets (auch) über beschriftete Menüs erreichbar sein, nicht allein durch einen 
ikonographischen Button, dessen Bedeutung erst erlernt werden muss oder erst nach Mausaktionen 
angezeigt wird.
 Aktionen, die der Anwender wahlweise anstoßen möchte oder nicht, sollten je explizit durch einen 
passenden Menübefehl ausgelöst werden und nicht implizit in einem unerwarteten Zusammenhang be-
ginnen.
 In Dateiauswahl-Dialogen muss statt der Verwendung des mehrdeutigen Labels „Öffnen“ jeweils 
erkennbar sein, ob eine gewählte Datei (a) zum Lesen bzw. Betrachten, (b) zum Bearbeiten oder (c) zum 
Ausführen darin enthaltenen Codes geladen wird. 

In keiner Situation darf die riskantere Aktion leichter fallen als die sicherere Aktion. In Editier-Umge-
bungen muss das Übergehen bzw. Verwerfen einer Eingabe (per Tasten oder Button-Fokus) mindestens 
genauso schnell erreichbar sein wie die Bestätigung einer Eingabe, die etwas verändert.
 Für Situationen, in denen aus Dateien, Datensätzen usw. nur passiv gelesen werden soll, dürfen zum 
„Öffnen“ der Datei bzw. des Datensatzes keine Komponenten mit Schreibmöglichkeit verwendet werden.

Um sofort in einer bewährten Arbeitsumgebung beginnen zu können, sollte es möglich sein zu wählen, 
ob Fenstergröße und -position sowie die aktuellen Verzeichnisse der letzten Sitzung wiederverwendet 
werden oder nicht.
 Parameterdateinamen, Bilddateiliste, Ausgabeverzeichnis usw. sollten auch bereits als Programmpa-
rameter beim Aufruf übergeben werden können, um (in Batchdateien bzw. Shell-Skripten oder Desktop-
Icons usw.) passende Aufrufe für Sitzungen zu ermöglichen.
     

104 Ein kompakter Überblick mit weiterführenden Quellenangaben findet man z. B. in RUDLOF 2006; Normen u. a.: EN ISO 9241

–  Jede Arbeitssituation muss jederzeit konsistent beendet werden können.

–  Jede Arbeitssituation muss auf den ersten Blick erkennbar sein.

–  Safety first: Bedienelemente müssen eine sichere Arbeitsweise erleichtern und unsichere 
 Aktionen erschweren.

–  Bedienelemente sollen eine schnelle Arbeitsweise ermöglichen. 
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Für häufige Aktionen sollte außer einem Maus-Button wenn möglich immer auch eine Taste angebo-
ten werden, möglichst in Anlehnung an allgemein übliche, z. B. für „Refresh“ so etwas wie [F5] oder 
[Ctrl]+[R], für „weiter“ so etwas wie [Tab] oder Cursortasten usw.  
 Solange mit beiden Tastaturhälften gearbeitet werden muss, ist der Wechsel zur Maus und zurück im-
mer ein Zeitverlust. Und umgekehrt: In Situationen, wo die Mausbedienung effektiver oder notwendig 
ist, sollte nach Möglichkeit nur eine Hand ergänzend auf der Tastatur nötig sein. 
 Bedienelemente sollen sowohl örtlich als auch hinsichtlich des Fokuswechsels in einer der Bearbei-
tung entsprechenden Reihenfolge angeordnet sein. Für absehbare Schrittfolgen sollte die [Enter]- oder 
[Tab]-Taste zum nächsten Schritt führen.
 Listen von Einträgen müssen zum schnellen Auffinden eines Eintrags jederzeit in nachvollziehbaren 
Ordnungen sortierbar sein. Lange Listen sollten eine Mehrfachselektion ermöglichen, um Gruppen von 
Einträgen zusammen behandeln zu können. 
 Das erwünschte Speichern von kleinen Parameteränderungen soll nicht dadurch erschwert werden, 
dass unnötig viel anderes jeweils mitgespeichert werden muss – eine störend lange Speicherzeit verleitet 
zum Verzicht auf rechtzeitiges Sichern von Einstellungen und führt so leicht zum Verlust bereits erarbei-
teter Konfigurationen.
      

 
Die Geometrie der Oberfläche sollte niemals dazu führen, sinnvolle Aktionen für unmöglich oder zu 
aufwendig zu halten.
     

Dateiauswahldialoge sollten an einem nachvollziehbaren, aber bequemen Ort beginnen, z. B. im Ver-
zeichnis der aktuell an dieser Stelle geltenden Auswahl – d. h. nicht stets in der Wurzel des Dateisystems 
und nicht in einem irgendwann früher benutzten, aber aktuell nicht geltenden Ordner.
 In Speicherdialogen zu einer bereits geöffneten Datei wird ein editierbarer Vorschlag der Speicherung 
am bisherigen Ort unter bisherigem Dateinamen, so wie man das als Standardverhalten von Anwendun-
gen kennt, erwartet.
 Dialoge zur Dateiauswahl und -speicherung sollten stets in einer echten Combobox bereitgestellt 
werden, in der alternativ zum „Durchklicken“ der Pfad auch als kompletter String ins Textfeld kopiert 
werden kann. 
 Eine routinemäßige Speicherabfrage („Soll .. gespeichert werden?“) sollte nur dann angeboten wer-
den, wenn tatsächlich Einstellungen geändert wurden (nur dann hätte die Abfrage auch eine sinnvolle 
Hinweisfunktion darauf, dass man in der Sitzung etwas geändert hat, und man hätte Anlass zu überle-
gen, ob versehentlich oder nicht).

AnHänGE

–  navigation einzuschränken hat nur Sinn, wenn dadurch nicht zeitaufwendige umwege für  
 absehbar notwendige Arbeitsgänge entstehen. 

–  Eine schnelle und fehlerfreie navigation erfordert Anlehnung an die vom Betriebssystem 
 gewohnten Standard-Abläufe.
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7.5  Literatur- und Linkliste
     
Im Folgenden wird sowohl zitierte als auch weiterführende Literatur angegeben. Für systematischen 
bzw. weiterführenden Informationsbedarf wird auf die Literaturangaben in den genannten Publikatio-
nen verwiesen.
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FRACTuR 1808
Die Fractur 
in: Adelung, Johann Christoph: Grammatisch-kritisches Wörterbuch der hochdeutschen Mundart. 
Wien: Pichler. Bd. 2. 1808. S. 261
FRAkTuR 1954
Fraktur
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8.  Erfahrungsbericht Helmstedter Drucke 
 Online an der Herzog August Bibliothek 
 Wolfenbüttel

 Thomas Stäcker
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8.1  Zusammenfassung

Ziel des Projekts ist die Image- und Volltextdigitalisierung der in Helmstedt gedruckten Werke, die sich 
in der Herzog August Bibliothek befinden. Die Herzog August Bibliothek besitzt etwa 10.000 Drucke 
mit dem Druckort Helmstedt, die bis zur Schließung der Universität Helmstedt 1810 in Helmstedt ge-
druckt worden sind. Die auf das 16. und 17. Jh. entfallenden Drucke sollen als Image und im Volltext per 
OCR digitalisiert, mit  Strukturdaten zur Navigation versehen und im Verbundkatalog sowie im VD 16 
und VD 17 nachgewiesen werden. Der aus dem 18 Jh. stammende Anteil wird digitalisiert, auf national-
bibliographischem Niveau katalogisiert und zur Nachnutzung einem möglichen VD 18 zur Verfügung 
gestellt. Mit der nahezu kompletten Digitalisierung der Produktion eines der wichtigsten norddeutschen 
Universitätsdruckorte – Helmstedt findet sich unter den 10 am häufigsten nachgewiesenen Druckorten 
im VD 17 – wird nicht nur ein substantieller Beitrag zur Komplettdigitalisierung des deutschen gedruck-
ten Kulturerbes geleistet, sondern erstmals ein Überblick über die Druckproduktion einer bedeutenden 
frühneuzeitlichen Universität geschaffen. Das Projekt flankiert den programmatischen und auf mehrere 
Jahre angelegten Forschungsschwerpunkt der HAB zur Erforschung der Universitätsgeschichte Helm-
stedts und kommt unmittelbar mehreren Forschungsprojekten in diesem Feld zugute.

8.2  Bedeutung der Helmstedter Drucke 

Das Vorhaben der Digitalisierung der Helmstedter Drucke steht im Kontext der Erforschung der Univer-
sitäts- und Wissenschaftsgeschichte der Frühen Neuzeit.105 In ihrer Selbstbeschreibung formulierte jede 
frühneuzeitliche Universität einerseits ihre Ziele und Ansprüche, andererseits deren Einlösung. Da der 
Status universitären Wissens von spezifischen Geltungsgründen und der Einhaltung bestimmter Verfah-
ren abhing, war eine Hochschule zu intensiver Selbstbeobachtung gezwungen. Deren Ergebnisse bilden 
einen wichtigen zeitgenössischen Beurteilungsmaßstab für die Qualität und Leistung einer Universität 
und insofern einen geeigneten Ausgangspunkt für ein retrospektives reviewing, zumal sie aufgrund der 
kompetetiven Grundstruktur des Wissenschafts- und Universitätssystems im Rahmen der fürstenstaatli-
chen Ordnung und der gelehrten Welt kommuniziert werden mussten. Diese als universitäre Repräsen-
tation und Selbtvergewisserung zu bezeichnende Aufgabe bündelt sich wie in einem Brennglas in der  
gesamten Druckproduktion der privilegierten Universitätsbuchdruckerei. Das Spezifikum der Druck-
produktion einer Universitätsdruckerei106 ist, dass sie an einer fürstenstaatlich initiierten, finanzierten 
und kontrollierten Einrichtung stattfand und insofern politisch wie konfessionell autorisiert, legitimiert 
und funktionalisiert wurde.  Die Druckproduktion der Universität kann damit in besonderer Weise über 
universitäre und staatliche Autorisierungsmechanismen Aufschluss geben. Sie manifestiert die Paradig-
men akademischen Wissens in den verschiedenen Fakultäten ebenso wie die verfolgten Lehrpraktiken, 
denn frühneuzeitliche Universitäten waren noch weit bis ins 18. Jh. hinein in noch stärkerem Maße als 
heute Unterrichts- und Ausbildungsanstalten. 
 Wurden die Hochschulschriften, also die akademischen Dissertationen, Reden und Programme, lange 
Zeit als eine eher uninteressante Quellengruppe eingestuft, hat sich diese Wertung seit den 1980er Jah-
ren geradezu umgekehrt, wobei insbesondere die Dissertationen des 16. bis 18. Jahrhunderts mittlerwei-
le als „ungehobene Schätze“ betrachtet werden.107 Gerade an diesen universitären Gelegenheitsschriften 
lässt sich ablesen, wie die eigentliche „Wissensproduktion“ an den Universitäten aussah, womit ein 
wichtiger Beitrag zur Alltagsgeschichte der Bildung und Ausbildung in der Frühen Neuzeit geleistet 

105 Zur Universitäts- und Bildungsgeschichte der Frühen Neuzeit im Allgemeinen vgl. insb.: Paulsen, Friedrich: Geschichte des gelehrten Unterrichts auf den deut-
schen Schulen und Universitäten vom Ausgang des Mittelalters bis zur Gegenwart. Mit besonderer Rücksicht auf den klassischen Unterricht, 2 Bde., Leipzig / 
Berlin 1919 / 1921 (ND 1965); Hammerstein, Notker (Hg.): Handbuch der deutschen Bildungsgeschichte, Bd. I: 15. bis 17. Jahrhundert. Von der Renaissance bis 
zum Ende der Glaubenskämpfe, München 1996; Rüegg, Walter (Hg.): Geschichte der Universität in Europa, Bd. II: Von der Reformation bis zur Französischen 
Revolution (1500 – 1800), München 1996; Schindling, Anton: Bildung und Wissenschaft in der Frühen Neuzeit 1650 – 1800, 2. Aufl., München 1999; Hammer-
stein, Notker: Bildung und Wissenschaft vom 15. bis zum 17. Jahrhundert, München 2003; Bruning, Jens: Innovation in Forschung und Lehre : die Philosophi-
sche Fakultät der Universität Helmstedt in der Frühaufklärung 1680 – 1740. Wiesbaden 2012 (Wolfenbütteler Forschungen, 132).– Eine Auswahlbibliographie 
zum Standort Helmstedt steht über das Helmstedt-Portal zur Verfügung: http://uni-helmstedt.hab.de/docs/bibliographie_helmstedt.pdf [Stand: 02/2013]

106 Zu dieser: Eule, Wilhelm: Helmstedter Universitätsbuchdrucker. Helmstedt 1921. S.a. Benzing, Josef: Die Buchdrucker des 16. und 17. Jahrhunderts im deut-
schen Sprachgebiet. 2 verb. Aufl.  Wiesbaden 1982, S. 200-203 mit weiterer Literatur zu den einzelnen Druckern.

107 Eule (wie Anm. 2), S. 29ff.
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werden kann. Zu betonen ist dabei, dass den akademischen Druckerzeugnissen nicht nur als Einzelpu-
blikationen, sondern auch als „Massenquelle“ bzw. „serielle“ Quelle besondere Bedeutung zukommt 
und sie gerade in diesem Charakterzug einen einzigartigen Blick in die Entwicklung der verschiedenen 
Wissensdisziplinen ermöglichen.

8.3  umfang und Art der Helmstedter Druckproduktion

Die wichtigsten Drucker des 16. und 17. Jh. in Helmstedt waren Jakob Lucius I (1579-1597), Jakob 
Lucius II (1598-1616, Erben bis 1633 vermutlich unter der Leitung von Henning Müller d. Ä.), Georg 
Calixt (1629-1676 mit Pächtern, insb. Henning Müller d. J.), Jacob Lucius III (1634-1639), Henning 
Müller d. J. (1640-1674), Johann Heitmüller (1656-1677), Jakob Müller (1661-1681), Georg Wolfgang 
Hamm (1681-1714), Heinrich Hesse (1681-1715/16) und Salomon Schnorr (1690-1723). Für das 18. 
Jh. sind insbesondere Johann Drimborn und Johann Heinrich Kühnlin zu nennen. Bemerkenswert ist 
die Betätigung des berühmten Gelehrten und Theologen Georg Calixt als Druckherr. Hier zeigt sich 
die enge Verschränkung von Universität und Druckerei in besonders augenfälliger Weise.108 Besonders 
wichtig war für die Helmstedter Druckgeschichte Henning Müller d. J. Seine Produktion zeigt denn 
auch das Spektrum der Produktion auf exemplarische Weise. Von den 2.422 im VD 17 nachgewiesenen 
Drucken aus seiner Offizin entfallen mehr als die Hälfte, nämlich 1.342 auf Dissertationen und 276 auf 
Hochschulschriften eine bis dato vernachlässigte Quellengruppe.109 Dazu kommen 91 Leichenpredigten 
und 590 sonstige Gelegenheitsschriften, die in besonderer Weise dazu geeignet sind, biographische Hin-
tergründe des akademischen Personals aufzuhellen. Rund 500 Werke entfallen auf sonstige Werke und 
wissenschaftliche Abhandlungen, insbesondere von Professoren der Universität Georg Calixt, Johannes 
Caselius, Hermann Conring, Hermann v.d. Hardt, Heinrich Meibom d. Ä. und d. J., Johann Lorenz von 
Mosheim, Heinrich Rixner, Heinrich Julius Scheuerl, Valentin Heinrich Vogler und Giordano Bruno (ein 
Jahr in Helmstedt, nicht als Professor, hielt aber vermutlich Privatvorlesungen), deren Arbeiten von der 
hohen Qualität der Forschung in Helmstedt in der Frühen Neuzeit Zeugnis ablegen.
 Das im engeren Sinne akademische Schrifttum (Dissertationen, Abhandlungen) wurde, wie üblich in 
dieser Zeit, fast ausnahmslos in Latein verfasst. Allerdings finden sich in den Drucken  immer wieder 
deutsche Einsprengsel und Zitate. Daneben druckten die Universitätsdrucker vor allem Predigten oder 
Leichenpredigten in Deutsch. Lateinische Texte wurden in Antiqua, Deutsche in Fraktur gesetzt, wobei 
die Grenze mitunter im Wort selbst verlief. So finden sich Fälle, wo die Endung „e“ des Worts „Materie“ 
in Fraktur, der Rest „Materi“ in Antiqua gesetzt wurde, weil es sich um ein lateinisches Wort handelt, 
das eigentlich die Endung „a“ trägt. Typischerweise enthalten die Drucke Mischformen von Antiqua, 
Fraktur und Kursive als Brotschriften. Hinzu kommen barocke Auszeichnungsschriften, die die Drucker 
aber für das in der Masse wenig aufwendig gestaltete Universitätsschrifttum vergleichsweise zurückhal-
tend einsetzten. Die verwendeten Fonts weisen wenig Varianten auf und scheinen über die Jahre weit-
gehend stabil gewesen zu sein, da Fonts von Universitätsdrucker zu Universitätsdrucker vererbt und der 
Erwerb neuer Fonts aus ökonomischen Gründen vermieden wurde. 
 Obwohl es zur Frage des deutschen bzw. europäischen Schriftenhandels beklagenswert wenige wis-
senschaftliche Untersuchungen gibt, deutet doch das wenige, was wir haben, darauf hin, dass man auch 
unabhängig von diesem innerhelmstedtischen Befund von weitgehender Einheitlichkeit bei den Schrif-
ten ausgehen kann und dass gerade im 17. Jh. ein starker Zentralisierungsprozess im Handel mit Schrif-
ten eingetreten ist.110  Hervorzuheben ist hier vor allem die erfolgreiche Tätigkeit der Egenolffschen/
Lutherschen Schriftgießerei in Frankfurt. Insofern kann man von einem hohen Homogenitätsgrad aus-
gehen, was für die OCR-Konversion der Barockschriften nicht ohne Belang ist.

109 Vgl. Komorowski, Manfred: Die Hochschulschriften des 17. Jahrhunderts und ihre bibliographische Erfassung. In Wolfenbütteler Barock-Nachrichten 24 (1997) 
1, S. 19-42.

110 Vgl. hierzu Carter, Harry: A View of Early Typography up to about 1600. Reprinted. London 2002.
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8.4  Projektziele, Rahmenbedingungen

Ziel des Projekts ist die Image- und Volltextdigitalisierung sowie Erschließung der in Helmstedt ge-
druckten Ausgaben, die vom Beginn des Universitätsdrucks bis zur Schließung der Universität 1810 in 
Helmstedt gedruckt wurden und sich heute in der Herzog August Bibliothek befinden. 
 Die Wolfenbütteler Sammlung bietet optimale Ausgangsbedingungen für ein Digitalisierungsprojekt 
der Helmstedter Druckproduktion. Die Helmstedter Universitätsdrucker waren verpflichtet, Exemplare 
ihrer gesamten Produktion an die eigene Universitätsbibliothek und die fürstliche Bibliothek in Wolfen-
büttel zu überweisen.111 Da beide Sammlungen, die Wolfenbütteler und die Helmstedter nach Schlie-
ßung der Universität Helmstedt wieder in Wolfenbüttel vereint wurden, kann von einer sehr dichten 
Überlieferungslage vor Ort ausgegangen werden. Da diese mit Ausnahme der in Helmstedt verblie-
benen Drucke112 und der Drucke des 18. Jh. in den bereits abgeschlossenen nationalbibliographischen 
Verzeichnissen des VD 16113 und VD 17114 durch die HAB Wolfenbüttel katalogisiert wurden, liegen 
weitgehend alle erforderlichen Metadaten für die Digitalisierung vor. Im VD 16 sind 1.216, im VD 17 
sind 7.485 (Stand: 3.10.2009) Drucke für den Druckort Helmstedt nachgewiesen. Von diesen besitzt die 
HAB gerundet aus dem 16. 789, aus dem 17. 5.366 und aus dem 18./19. Jh.(-1810) 4.390 Ausgaben, also 
insgesamt rund 10.000 Ausgaben mit geschätzt 1 Mio. Seiten. 
 Ein Novum für ein Digitalisierungsprojekt zur Frühen Neuzeit war, neben der eigentlichen Image-
digitalisierung auch eine OCR-Konversion des Schriftguts in Angriff zu nehmen. Allerdings wurde die 
ursprünglich intendierte vollständige Bearbeitung des Korpus auf Wunsch der DFG auf ein kleineres 
Sample von 120.000 Seiten reduziert, um angesichts der erheblichen Kosten zunächst Erfahrungen mit 
dem Verfahren zu sammeln. 
 Bei der anvisierten Komplettdigitalisierung der Druckerzeugnisse mit dem Druckort Helmstedt 
mussten bereits laufende Digitalisierungsprojekte, insbesondere an der Bayerischen Staatsbibliothek 
München, aber auch anderorts berücksichtigt werden, um Doppeldigitalisierungen so weit wie möglich 
zu vermeiden. Gerade mit Blick auf die OCR-Bearbeitung schien das Google-Projekt der Bayerischen 
Staatsbibliothek zunächst von Interesse. Eine genauere Vorprüfung zeigte aber, dass die Google Digi-
talisate nicht für das Projekt nutzbar waren. Zum einen ist die von Google im Internet bereitgestellte 
Qualität zu schlecht für eine nachgeordnete OCR-Bearbeitung (Gerüchten zufolge besitzt Google intern 
bessere Scans, was aber für aktuell durchgeführte Projekte leider wenig nützt), zum anderen ist es nach 
den Geschäftsbedingungen von Google115 nicht gestattet, Volltexte außerhalb von Google zu benutzen, 
was eklatant Forschungsinteressen bezüglich der freien Nutzung der Volltexte widerspricht, z. B. in dem 
Wunsch nach unabhängiger Eigenindexierung und Bildung von reproduzierbaren Rankingmechanis-
men.116 Insofern scheint nach dem gegenwärtigen Stand ein auf Volltextgenerierung angelegtes wissen-
schaftliches Digitalisierungsprojekt grundsätzlich nur mit Digitalisaten aus öffentlicher Hand möglich 
zu sein, zumindest sofern entsprechende CC-Rechte am Volltext eingeräumt werden, was vor dem Hin-
tergrund einer DFG-Förderung typischerweise der Fall sein dürfte. 
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111 Vgl. Schneider, Heinrich: Beiträge zur Geschichte der Universitätsbibliothek Helmstedt. Helmstedt 1924, S. 75, Anm. 194.
112 Diese sind in einem eigenständigen Projekt „Katalogisierung der im Juleum Helmstedt verbliebenen Drucke der ehemaligen Universitätsbibliothek Helmstedt“ 

derzeit in Bearbeitung: http://www.hab.de/de/home/wissenschaft/projekte/katalogisierung-der-im-juleum-helmstedt-verbliebenen-drucke-der-ehemaligen-uni-
versitaetsbibliothek-helmstedt.html [Stand: 02/2013]

113 http://www.vd16.de [Stand: 02/2013]
114 http://www.vd17.de [Stand: 02/2013]
115 https://www.google.de/intl/de/policies/terms/regional.html; vgl. a. https://play.google.com/intl/de/about/books-terms.html [Stand: 02/2013]
116 Zum Problem der mangelnden Wissenschaftstauglichkeit von Googles Suchmaschine vgl. Elli Pariser: The filter bubble : what the Internet is hiding from you. 

London 2011.
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Die Volltexte sollten nach vorausgegangenen Tests mit der Software BIT-Alpha der Fa. B.I.T. Tomasi 
generiert werden. Wie oben geschildert, besteht das Charakteristikum der Software darin, dass sie eine 
effiziente Oberfläche zum schnellen Erlernen von Schriften bietet. Hierzu wurde eine Hilfskraft einge-
stellt, die Schriften von Helmstedter Druckern trainierte. Dabei handelte es sich überwiegend um An-
tiquaschriften inklusive Kursive, zu einem kleineren Teil um Fraktur. Anschließend sollten die Drucke 
bearbeitet und die Ergebnisse in ALTO117 exportiert und zur Nachnutzung in der Wolfenbütteler Digita-
len Bibliothek in ein TEI P 5 kompatibles Format konvertiert werden. Die Suche in den Texten erfolgte 
mit eXist, einer nativen XML-Datenbank. 

8.5 Ergebnisse, Erfahrungen

Nach der Digitalisierung von 4.800 Drucken (Stand 01.06.2012) hat sich ein Seitendurchschnitt von 
87 Seiten pro Ausgabe ergeben. Die gegenüber sonstigen Projekten118 eher geringe durchschnittliche 
Seitenzahl erklärt sich daraus, dass es sich bei Universitätsschriften meist um weniger umfangreiche 
Druckerzeugnisse wie Dissertationen und Gelegenheitsschriften handelt.  Für die Archivkopie fallen 
derzeit pro Image durchschnittlich 28,5 MB pro Seite (uncompressed TIFF) an. 
 Ziel der ersten Phase des Projekts war es, 120.000 Seiten per OCR zu bearbeiten. Die OCR-Kom-
ponente des Antrags war ein wichtiger neuer und innovativer Schritt im Prozess der Massendigitali-
sierung, weil bislang bei Materialien des 16.-18. Jh. fast ausschließlich die Imagedigitalisierung zum 
Einsatz kam. Wegen der dargelegten Schwierigkeiten der Vorlagen kam nach einigen Tests mit anderen 
Anbietern die OCR-Software der Firma B.I.T. Bureau Ingénieur Tomasi zum Einsatz. Das Spezifikum 
dieser Software liegt darin, dass sie nicht, wie z. B. Abbyy, auf weitgehend werkseitig vortrainierte Fonts 
angewiesen ist, so dass die typischen Mischtexte dieser Zeit (Antiqua, Fraktur, Kursive, Griechisch und 
andere Typen) nicht korrekt erkannt werden, sondern z. B. entweder nur der Antiqua- oder nur der Frak-
turanteil.  Einen typischen Fall solcher Mischung zeigt sich in Abb. 77.
 Die jeweiligen Typen mussten zunächst trainiert werden; dies konnte schriftübergreifend erfolgen. 
Effekte des „Übertrainierens”, wie man sie wohl bei anderen Produkten wie Abbyy beobachten kann, 
traten nicht auf. Das Training konzentrierte sich zunächst auf das 17. Jh. und den Helmstedter Großdru-
cker Henning Müller d. J., der allein für rund 3.000 Druckerzeugnisse verantwortlich ist. Damit verband 
sich die Absicht, im weiteren Verlauf auf der Basis eines weitgehend homogenen Schriftmaterials arbei-
ten zu können. Trainiert werden mussten Antiqua und Fraktur, ebenso Kursivschrift und altgriechische 
Schrift. Letztere wurde allerdings aus Kapazitätsgründen bisher nur in Ansätzen trainiert, weil dafür 
spezialisierte Kompetenzen erforderlich sind.  Sie soll im Laufe eines Fortsetzungsprojekts durch Mitar-
beiter der Bibliothek weiter trainiert und die Erkennungsgenauigkeiten für frühneuzeitliche griechische 
Fonts verbessert werden. Die Trainingsphase verlief weitgehend ohne Probleme; die Software erwies 
sich als sehr komfortabel in der Handhabung. Besonders effizient war der so genannte „Sequencer”, der 
es erlaubte typische Buchstabenkombinationen zu identifizieren (s. Kap. 4.4), typische Fälle sind etwa 
„n+i” Verbindungen, die als „m” zu lesen sind. Trainiert wurden von der studentischen Hilfskraft im 
Laufe der ersten Projektphase (24 Monate) 132.000 Zeichen mit einem Aufwand von durchschnittlich 
fünf Wochenstunden.

117 http://www.loc.gov/standards/alto/ [Stand: 02/2013]
118 Durchschnittszahlen auf dem Server der HAB: 140 Seiten bei 14.000 Werken. Bei Dünnhaupt Digital sind es im Schnitt 235 Seiten.
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77 Antiqua, Fraktur u. kursive aus Hermann Conring: Dissertatio De Praecipuis negotiis In Comitiis Imperii Germanici Olim Et Hodienum Tractari Solitis Helmstedt, 1666
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Die Konversionsphase gestaltete sich anders als die Trainingsphase steiniger, was im Wesentlichen auf 
zwei Gründe zurückzuführen war. Zum einen erwiesen sich Parametrierung und Einstellungen der Soft-
ware als zu komplex, zum anderen gab es zahlreiche Probleme mit den Vorlagen. Was Ersteres anlangte, 
so konnte in der fast zweijährigen Pilotphase trotz intensiver Bemühungen nicht nachvollzogen wer-
den, wie sich welche Einstellungen auf das Ergebnis auswirkten (vgl. Kap. 5 u. 6.3 sowie Anh. 7.3). 
Grund war einerseits das Fehlen einer Dokumentation, die im Detail verdeutlicht hätte, wie sich die 
vielfältigen Parametrierungsmöglichkeiten auswirken. Andererseits entwickelte die Firma die Software 
laufend fort, was zwar zu Verbesserungen in der Erkennungsqualität führte, jedoch auch Änderungen 
bei den Parametereinstellungen zur Folge hatte. Insgesamt war es so weitgehend unmöglich, empirisch 
reproduzierbare Effekte zu erzielen, da Änderungen an einem Parameter dazu führten, dass andere Ein-
stellungen unwirksam wurden, sich Einstellungen gegenseitig aufhoben oder Einstellungen in einer 
älteren Version sich nicht mehr so verhielten wie Einstellungen einer neueren Version. Bemühungen, 
die Software zu „verstehen“ wurden daher nach einer gewissen Zeit abgebrochen und es weitgehend der 
Firma überlassen, nach Maßgabe der jeweiligen Vorlagen die richtigen Einstellungen festzulegen. Die 
Zusammenarbeit in dieser Hinsicht verlief jedoch reibungslos und die Firma zeigte sich sehr kooperativ 
und entgegenkommend. Dass materialabhängig Anpassungen überhaupt sinnvoll sind, hängt mit den 
zugrundeliegenden Softwarealgorithmen zusammen. Marktübliche Software wie Abbyy oder Omni-
page gehen von „durchschnittlichen” Einstellungen aus, was zwar dazu führt, dass nicht das Optimum 
aus der Software herausgeholt wird, was es aber dem Nutzer erlaubt, ohne intime Kennisse der Einstel-
lungsmöglichkeiten doch noch befriedigende Ergebnisse zu erzielen. Letztlich führten diese Umstände 
im Projekt zu der Einsicht, dass die Software von B.I.T.  für den durchschnittlichen bzw. selbst für den 
erfahrenen Anwender mit Ausnahme des hervorragenden Trainingsinterfaces eigentlich nicht geeignet 
ist und legte für das geplante Folgeprojekt einen Wechsel im Vorgehen nahe. Abgesehen vom Training 
einiger Sonderschriften (vor allem Griechisch), das mangels entsprechender Kompentenzen der Firma 
in der Bibliothek erfolgen muss, soll die OCR-Wandlung künftig vollständig durch die Firma in einem 
Dienstleistungsverhältnis durchgeführt werden. 
 Trotz dieser Einschränkungen konnten aber Stärken und Schwächen der Software zumindest im All-
gemeinen bewertet werden. Gemäß den Prozessschritten Binarisierung, Segmentierung bzw. Layoutana-
lyse, pattern matching und intelligent character recognition (Wörterbuch) kann man hervorheben, dass 
die Stärken der Software gerade im Bereich der Binarisierung und des pattern matching hervorstechen; 
einzelne Probleme, wie stark gekrümmte Seiten und die damit verbundene problematische Grundlinien-
findung, konnten mittels neuprogrammierter Algorithmen gelöst werden. Bei der Segmentierung gab es 
verschiedentlich noch Probleme, die teils im Laufe des Projekts behoben werden konnten (z. B. bei der 
Identifizierung von Initialen), teils noch bestehen, wie bei der Erkennung von Marginalien oder Zeilen-
zählungen, die zu dicht am Text gedruckt sind. Hier scheinen weitere Verbesserungen möglich, zumal 
Abbyy bessere Segmentierungsergebnisse zu erzielen vermag. Auch bei der Wörterbuchunterstützung 
sind noch Verbesserungen möglich. Dies liegt allerdings vor allem daran, dass geeignete Wörterbücher 
für das Frühneuhochdeutsche oder auch Lateinische fehlen, die das typische universitäre Vokabular der 
frühen Neuzeit abzubilden vermöchten. Die Ergebnisse der durch Wörterbuch unterstützten Konversion 
wirkten sich in der ersten Phase des Projekts noch nicht aus bzw. es können dazu noch keine verallge-
meinerbaren Aussagen getroffen werden. Die noch nicht repräsentativen Ergebnisse waren einerseits 
besser, führten andererseits aber auch zu neuen Fehlern durch falsche Korrekturen. Andererseits gibt es 
eine Reihe von Phänomenen im Text, die nur mit Hilfe von Wörterbüchern gelöst werden können und 
bei denen reines pattern matching nicht weiterführt. Dies ist z. B. der Fall, wenn kleines „c” und „e”, da 
unsauber gedruckt, nicht visuell unterschieden oder wo innerhalb eines Worts „i+n” im Sequencer nur 
durch ein Wörterbuch disambiguiert werden können, weil beides „in“ und „m“ möglich ist. Der Weg, 
ein effizientes pattern matching mit einem Wörterbuch zu kombinieren, ist daher zwingend, weil eine 
rein „visuelle“ Erkennung bestimmte Grenzen nicht zu überschreiten vermag.
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Neben den Schwierigkeiten mit der Parametrierung der Software bestanden aber auch Probleme, die aus 
der Qualität der Vorlagen resultierten. Die ursprüngliche Ansicht, man müsse die Software nur einen be-
stimmten Schrifttyp lernen lassen, um zu guten Ergebnissen zu gelangen, ist zwar im Grundsatz richtig, 
doch zeigte sich, dass die Schriftvarianten, auf die man bei verschiedenen Druckern trifft, sich weniger 
negativ auswirkten als mindere Papier- und Druckqualität, Widerdruck oder sonstige Verschmutzungen. 
Unterstreichungen, die oft als Durchstreichungen ausgeführt sind, machten eine Texterkennung so gut 
wie unmöglich.
 Trotz dieser Probleme sind aber die bisherigen Ergebnisse so gut, dass eine Fortsetzung mit größeren 
Margen und Komplettkonversion dieses Korpus und anderer Korpora sinnvoll scheint, zumal im Fall 
der Helmstedter Drucke, bei denen es sich überwiegend um serielles Material handelt und der eigentli-
che Nutzen sich unstreitig erst aus dem Volltext ergibt. 
 Um aber hierzu nachvollziehbare Aussagen machen zu können, müssen zunächst zwei Gesichtspunk-
te näher erörtert werden. Zum einen die Frage, welche Genauigkeit der Texterkennung erforderlich ist, 
zum anderen wie man diese Genauigkeiten misst (8.7) . Erst aus der Beantwortung dieser Fragen lässt 
sich auch eine Vorstellung über den nötigen und angemessenen ökonomischen Aufwand für ein OCR-
Projekt gewinnen (8.8). 

8.6   überlegungen zu Textgenauigkeiten und deren Messung 

Im allgemeinen herrschen durchaus disparate Vorstellungen davon, was ein qualitativ ausreichender 
Text ist. An der Bayerischen Staatsbibliothek (BSB) z. B. teilt man Texte in vier Klassen ein: sehr gut 
(99,6-99,95% Genauigkeit), gut (97-99,5%), durchschnittlich (90-96%) und schlecht (unter 90%).119 
Gewöhnlich wird argumentiert – so auch in den bisherigen DFG-Praxisregeln (gültig bis Ende 2012) –, 
dass eine in diesem Sinne sehr gute Qualität Voraussetzung für eine wissenschaftliche Nutzung sei. 
Dem ist nach traditionellem Verständnis durchaus zuzustimmen. Gleichwohl stehen dem Überlegungen 
entgegen, wie sie von Thaller120 und anderen angestellt werden, dass auch eine weniger exakte, nach den 
bisherigen Vorstellungen eher unzulängliche OCR-Konversion noch wissenschaftlichen Nutzen bringt, 
selbst wenn argumenta ex silentio nicht mehr möglich sein sollten. Die heutige Technik erlaubt Mengen 
von Texten automatisch zu bearbeiten, die im Laufe eines Gelehrtenlebens nicht hätten gelesen werden 
können, so dass man mit geeigneten Recherchewerkzeugen ein neues, wenn auch nicht ganz zuverläs-
siges Bild, über Inhalte gewinnt, zu denen man früher ohne dieses Hilfsmittel keinen Zugang gehabt 
hätte. Angesichts dessen relativiert sich die Frage des zuverlässigen Texts zumindest für Fragestellun-
gen, bei denen ein anderer, meint traditionell „lesender” Zugang121 ohnehin verwehrt wäre. Die inten-
sive Nutzung von Google durch die Wissenschaft scheint diese Behauptung zu stützen, ebenso wie der 
verstärkte Rückgriff auf quantitative Methoden in den digital humanities. Dennoch darf man sich nicht 
täuschen, dass diese Nutzungsszenarien von der Forschung als „provisorisch” empfunden werden und 
dass z. B. strategische Großvorhaben wie das EU-Projekt CLARIN122, in denen vor allem linguistische 
Verfahren zum Tragen kommen, großen Wert auf „gute” Texte legen, weil „schmutziges OCR” wissen-
schaftliche Fragestellungen verfälschen und vor allem dann kritisch gesehen werden müssen, wenn die 
Herstellungsbedingungen solcher Texte, also die eingesetzten Algorithmen der OCR-Konversion und 
Qualitätsstufe unbekannt sind. Was also für eine wissenschaftliche Nutzung hinreichende Qualität ist 
und wie sie bewertet oder gemessen wird, ist daher von mehreren Faktoren abhängig, von denen die 
innere Textqualität, also die höchstmögliche Übereinstimmung einer Kopie mit dem Original, nur einen 
Faktor darstellt. Wichtige weitere Faktoren sind u. a. die Kosten (Machbarkeit) oder die Forschungsfra-
ge, die sich mit der Textkonversion verbindet. Gerade die Kostenfrage dürfte ein Schlüsselelement in 
der Bewertung von OCR-Verfahren bilden, denn offenbar gibt es in diesem Bereich einen Pareto-Effekt, 
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119 http://www.digitale-sammlungen.de/~mdz/mdz/content/service/docs/2011-10-19_Brantl_Digitization_Lifecycle.pdf [Stand: 02/2013]
120 http://www.slideshare.net/mdz-bsb/digitalisierungspraxis-thaller-volltextdigitalisierung?ref=http://mdzblog.wordpress.com/2011/10/page/2/
121 Gemeint ist das Intensivlesen. Neuere Konzepte wie hyperreading, machine reading oder distant reading versuchen genau diesem Problem zu begegnen. Vgl. 

Stäcker, Thomas: Wie schreibt man Digital Humanities richtig? - Überlegungen zum wissenschaftlichen Publizieren im digitalen Zeitalter. In: Bibliotheksdienst 
47 (2013) 1, S. 24-50. 

122 http://www.clarin.eu [Stand: 02/2013]
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der dazu führt, dass der Wunsch nach hoher Textgenauigkeit die Kosten gerade für den Schritt zu sehr 
guten Texten sprunghaft ansteigen lässt. Um die Kosten und Qualität in eine angemessene Relation zu 
bringen, bedürfte es jedoch einerseits klarerer Vorstellungen darüber, was unter Qualität zu verstehen, 
andererseits Verfahren, wie diese Qualität zu messen ist. Beides ist derzeit nicht oder nur mit Einschrän-
kung gegeben. So legen die genannten Zahlen aus der BSB zwar Genauigkeitsgrenzen fest, sagen aber 
weder, wie diese zu begründen sind, noch, wie sie gemessen werden. Obwohl es nicht Aufgabe des 
Wolfenbütteler Pilotprojekts Helmstedter Drucke Online I war, diese Aspekte systematisch zu untersu-
chen, sondern nur ein Praktikabilitätsszenario für die massenhafte OCR-Konversionen frühneuzeitlicher 
Drucke zu entwickeln, ergaben sich einige Beobachtungen, die es erlauben, sich der Frage anzunähern. 
 Die Bezifferung von Textgenauigkeiten, also der Übereinstimmung von Original und Kopie, ist der 
entscheidende Faktor in der Bewertung von OCR bzw. Konversionsverfahren. So simpel diese Aussage 
ist, so schwierig ist ihre Umsetzung und damit Ermittlung des „Werts” in der Praxis möglich. Haupt-
probleme sind a) die Möglichkeit der Überprüfung (exakter Referenztext, so genannte „ground truth”), 
b) die Festlegung der Art der Genauigkeitsfeststellung (Buchstaben, Worte, Layout) und c) Normierung 
des Gegenstands (Digitalisierungsvorlage, Digitalisat) der Messung. 
 Zu a) Bei der hier bearbeiteten Materie, also universitäres Schrifttum vor allem des 17. und 18. 
Jahrhunderts liegen keine Referenztexte vor, von denen eine Differenzmenge gebildet und die absolute 
Genauigkeit des Konversionsergebnisses festgestellt werden könnte. Gleichwohl wurde versucht, die 
Genauigkeit der OCR zumindest näherungsweise zu ermitteln, indem im Laufe der ersten zwei Jahre 
des Projekts immer wieder Stichproben genommen wurden. Die Projektmitarbeiterin überprüfte jeweils 
einzelne Zeilen an definierten Stellen des Buchs, die bei kleineren Drucken den Seiten 4, 5 und 6, bei 
umfangreicheren den Seiten 10,15 und 20 entnommen wurden. Auf diese Weise wertete sie 35 Drucke 
aus. Gezählt wurde, wie gesagt, die korrekte Erkennung einzelner Buchstaben, nicht die von Wörtern. 
Die Genauigkeit lag im Schnitt bei diesen Werken bei 96%. Die Schwankungsbreite war vorlagenbe-
dingt erheblich, die Genauigkeit fiel jedoch nie unter 90%. Bei optimaler Erkennung wurden 99%, in 
Einzelfällen sogar mehr erreicht. Angesichts des Umstands, dass das Projekt es mit ausserordentlich 
anspruchsvollen Materialien zu tun hatte (schlechte Druckvorlagen der Handpressenzeit, Mischung von 
Antiqua, Kursive und Fraktur), kann man das erzielte Ergebnis als durchaus bemerkenswert betrachten, 
da andere Softwarelösungen ein solches Ergebnis kaum erzielt hätten (vgl. hierzu die obigen Ergebnisse 
des Berliner Projekts). Allerdings ist ein Vergleich von BIT-Alpha mit  Abbyy oder Omnipage, also ei-
nem lernenden mit einem statischen System, nur bedingt möglich, weil ein Versuchsaufbau „unter glei-
chen Bedingungen” implizit das statische System privilegiert, denn ein lernendes System setzt voraus, 
dass die Erkennungssoftware individuell für das jeweilige Objekt optimiert wird. Der eigentliche Vorteil 
des lernenden Systems wird damit relativiert, ist aber in einem solchen Vergleich unvermeidbar. Umge-
kehrt kann in Massenprojekten nur ein begrenzter Aufwand getrieben werden, um Software anzupassen, 
so dass die Frage nach der besseren Software auch ökonomisch entschieden werden muss (vgl. unten).
 Ad b) ist festzulegen, was man als Fehler interpretiert. Sind z. B. nicht erkannte Layoutinformationen 
wie Marginalien, wenn sie zwar richtig erkannt, aber an der falschen Stelle in den Haupttext einsortiert 
wurden, ein Fehler? Bei den Stichproben wurden lediglich Buchstabengenauigkeiten, also das engere 
pattern matching, gewertet. Worttrennungen hingegen, die oft auch in der Vorlage nur „intellektuell” zu 
erkennen waren, blieben unberücksichtigt. Der Einsatz von Wörterbüchern  wirkte sich bei der Wort-
trennung positiv aus, wie sie auch die Eregbnisse nachvollziehbar verbesserten, allerdings nur in Texten, 
wo es keine Mischung von deutscher Fraktur und lateinischer Antiqua gab.123

 Systematisch untersucht werden konnte der Einsatz nicht, jedoch scheint es eine Art absolute Grenze 
zu geben (bei ca. 99%), jenseits der reines pattern matching bzw. Training keine signifikante Verbes-
serung mehr zeitigt. Dies liegt vor allem daran, dass bestimmte Buchstaben nicht mehr visuell, son-
dern nur intellektuell differenziert werden können (wie bereits erwähnt ist dies u. a. bei c und schlecht 
gedrucktem e häufig der Fall). Verbesserungen jenseits dieser Grenze sind demzufolge nur noch mit 
Werkzeugen der intelligent character recognition – vor allem durch den Einsatz von Wörterbüchern – 
möglich. 

123 Hier besteht sicher Verbesserungsbedarf und dem Vernehmen nach versucht die Firma über den Ansatz der Fontserkennung auch die Wörterbuchanwendung zu 
optimieren. In einem ersten Schritt hatte die Mischung von Wörterbüchern positive Effekte, jedoch konnte das noch nicht systematisch untersucht werden.
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Ad c) waren die Grundlage entweder hochwertige TIFFs oder hochauflösende JPEGs auf der Basis der 
DFG-Praxisregeln. Der Binarisierungsprozess fand also auf der Basis von guten bis sehr guten Digi-
talisierungsvorlagen statt (es wurden keine Vorlagen vom Film oder in bitonaler Qualität verwendet). 
Dennoch konnte man auch hier nicht von gleichbleibenden bzw. Normbedingungen ausgehen, denn im 
Digitalisierungsprozess der HAB wird Rücksicht auf die Materialität der Bücher genommen. Wenn das 
Buch eine starke Wölbung im Papier aufweist, so wird nicht versucht, diese durch mechanische Maß-
nahmen (Anpressen) zu nivellieren. Gelegentlich vorkommende leichte Schräglagen des Buchblocks 
werden nicht ausgeglichen, so dass die Software auf heterogene Fälle trifft, die softwareseitig ausgerich-
tet werden müssen und negative Einflüsse auf die Erkennungsergebnisse haben. 
 Noch stärker kommt dieser Effekt mit Blick auf die Materialität der Objekte selbst zum Tragen (in-
trinsische Effekte). Die schon erwähnten Schattenbilder durch Widerdruck oder auch Unterstreichungen 
im Text beeinflussen die Konversionsergebnisse massiv. Gleiches gilt für Faktoren wie die Schrifttype, 
Satz und Papiergüte (Bräunung, Verschmutzung, etc.). 
 Nach knapp zwei Jahren Erfahrung in diesem Bereich kann man zwar sagen, welche Faktoren das 
Ergebnis beeinflussen, nicht jedoch wie diese im Schnitt gemessen werden sollen. Je nach Scanbe-
schaffenheit und Vorlage erreicht man bei einem Buch 99%, bei nächsten nur noch 95%, selbst wenn 
alle Software-, Trainings- und Wörterbuchparameter optimiert wurden. Nötig wäre hier eine Art Qua-
litätsindex für das Digitalisat und die Vorlage. Dabei ist nicht nur von Interesse, ob die Software „gut” 
oder „schlecht” arbeitet, sondern auch, mit welchen Genauigkeiten man bei welcher Art von Material 
rechnen kann. Mit anderen Worten, um eine bessere Vorhersage zu möglichen Qualitäten zu machen und 
Ergebnisse überhaupt bewerten zu können, wäre auch eine Typisierung der Vorlagen bzw. eine differen-
zierte Herangehensweise erforderlich. 
 Trägt man alle diese Faktoren zusammen, so wird deutlich, dass Genauigkeit nur über eine sehr 
komplexe Formel, wenn überhaupt präzise zu ermitteln ist. Selbst wenn man einen Referenztext hätte, 
könnte man nicht zuverlässig davon ausgehen, dass die Genauigkeit, die bei diesem Text erzielt wurde, 
auch auf alle anderen Texte übertragbar ist. Die Daten zur Genauigkeit, die im Laufe von Helmstedt I 
erhoben wurden, sind daher als Tendenz, nicht als absolute Größe zu verstehen und variieren, je nach-
dem, welchen Aspekt man hervorhebt. In diesem Sinne kann man aus den Erfahrungen davon ausgehen, 
dass das Ergebnis nach der Münchner Einteilung tendenziell befriedigend bis gut ist. 
 Dennoch war den Projeknehmern nach dieser ersten Phase klar, dass, obwohl Erfahrungen sich mit 
zunehmender Menge der Stichproben zwar nach dem Gesetz der großen Zahl konsolidieren lassen, 
eine zuverlässige Einschätzung erst auf der Grundlage methodisch zuverlässiger statistischer Verfahren 
möglich ist. Daher wurden die in der Folge beschriebenen statistischen Verfahren entwickelt, die, was 
die Überprüfung der gelieferten Genauigkeiten anlangt, im Folgeprojekt zum Einsatz kommen sollen.

8.7  Messung der Textgenauigkeit124

Die Frage der Messung der Textgenauigkeit ist von entscheidender Bedeutung für eine wissenschaft-
liche und ökonomische Bewertung der Textgüte und Textproduktion. Da wegen der Heterogenität des 
Materials eine Messung an Hand vorgegebener Muster und eine vollständige Überprüfung der Tex-
te nicht möglich ist, bedarf es statistischer Verfahren, um mittels einer Stichprobe Genauigkeitswahr-
scheinlichkeiten bzw. Irrtumswahrscheinlichkeiten zu ermitteln.
 Bei der Ermittlung von Genauigkeiten sind in Abhängigkeit von der Fragestellung zwei Verfahren in 
Betracht zu ziehen. Das erste Verfahren dient dazu, grundsätzlich die Güte einer Software zu testen, das 
zweite erlaubt die behauptete Genauigkeit eines Texts zu überprüfen. 
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124 Die folgenden Überlegungen entstanden im Gespräch mit Herrn Burkard Rosenberger (Münster), der den Autor in den mathematischen Aspekten der Messung 
beraten und auch die genannten Verfahren entwickelt hat, wofür ihm herzlich gedankt sei.
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8.7.1  Testen der Güte einer Software

Das hier beschriebene Verfahren kann dann zum Einsatz kommen, wenn es darum geht, die unbekannte 
Erkennungsquote einer Software abzuschätzen und dann die Güte dieser Schätzung zu bestimmen. Es 
wäre darin für Projektnehmer von Interesse, die den Einsatz einer bestimmten Software erwägen, oder 
aber auch für Hersteller von OCR-Software, um eine Erkennungsquote ihrer Software zu bestimmen. 
 Gegeben ist eine Grundgesamtheit von allen gescannten und OCR-erkannten Seiten aus mehreren 
Büchern. Die Zufallsvariable ist die Quote der pro Seite richtig erkannten Zeichen, wobei unterstellt 
wird, dass die Quote normalverteilt ist. Das ist realiter bei sehr heterogenen Materialien aus der Frühen 
Neuzeit zwar nicht immer der Fall, aber man kann von „typischen” Materialen ausgehen und sollte für 
die Stichprobe nicht Seiten wählen, die durch einen ungewöhnlich hohen Grad von Verschmutzung oder 
Annotationen bzw. Durchstreichungen das OCR-Ergebnis massiv verfälschen würden. Das Ziel der Er-
mittlung ist die Quote der Erkennungsgenauigkeit durch den Mittelwert einer Stichprobe abzuschätzen 
und die Güte der Schätzung zu bestimmen. Die Güte der Schätzung hängt von der Stichprobengröße und 
der Standardabweichung der Stichprobe ab.

1. Schritt: Wahl einer Konfidenzzahl. Diese bestimmt die gewünschte Wahrscheinlichkeit der Aussage.

Bsp. Konfidenzzahl γ = 0.99, d. h. mit einer Wahrscheinlichkeit von 99% liegt die wirkliche Erken-
nungquote im Intervall [x,y]. Die Konfidenzzahl gibt die Güte der Schätzung an.

2. Schritt: Erhebung einer Stichprobe, z. B. 10 Seiten aus einem Korpus druck- und zeittypischer Seiten. 
Die Auszählung der zehn Stichprobenseiten ergibt z. B. folgende Genauigkeitswerte: 0,93/0,87/0,99/0,
95/0,95/0,94/0,9/0,8/0,87/0,92.

3. Schritt: Berechne Mittelwert und Standardabweichung dieser Stichprobe. Mittelwert hier 0,912 
(Schätzgröße für die Erkennungsquote). Die Standardabweichung s beträgt 0,05411921 (je geringer, 
umso besser ist die Schätzung).

4. Schritt: Man ermittle c aus der Tabelle für die so genannte Stundentsche t-Verteilung.125 Dies erfolgt 
mittels des Stichprobenumfangs minus 1 (n-1) und der Formel 0.5*(1+ γ), indem n-1 die Zeile, das Er-
gebnis aus der Berechnung von 0.5*(1+ γ) die Spalte der Tabelle der Studentschen t-Verteilung bilden. 
Aus der Spalte (hier 0.5*(1+ 0.99)=0.995) und der Zeile (hier n=10-1 =9) ist also der Wert für c zu 
entnehmen (hier c= 3,25). 

5. Schritt: Berechnung des Konfidenzintervalls a: Zusammen mit den Angaben zur Stichprobe (n) und 
der Standardabweichung (s) kann nun mit Hilfe der Formel a = c*s / √n das Konfidenzintervall berech-
net werden (a= 3,25*0,05411921/√10 = 0,05562049)

Als Ergebnis der Berechnung kann festgestellt werden, dass mit einer 99%igen Wahrscheinlichkeit das 
Ergebnis im Intervall [Mittelwert-a, Mittelwert+a], (hier [0,912-0,05562049;0,912+0,05562049]) also 
im Bereich zwischen 0,85637951 und 0,96762049 liegt. Wir haben hier also noch eine recht große 
Schwankungsbreite, was vor allem an der relativ geringen Stichprobengröße liegt. Mit anderen Worten, 
je größer die Stichprobe und je  geringer die Standardabweichung, umso schmaler wird dieser Schwan-
kungsbereich werden. Natürlich kann man auch mit einer abweichenden Konfidenzzahl, z. B. 80%, rech-
nen, doch scheint dies für eine möglichst genaue Bewertung des OCR-Ergebnisses nicht zielführend.

125 http://de.wikipedia.org/wiki/Studentsche_t-Verteilung [Stand: 02/2013]
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8.7.2  überprüfen der Güte eines Texts

Neben der Frage nach der unbekannten Güte der Erkennungsquote der Software ist vor allem die Frage 
nach der behaupteten Güte des Texts von Bedeutung, wenn Arbeitsergebnisse von Dienstleistern über-
prüft werden müssen. Auch hier verbietet die Textmenge aus pragmatischen Gründen eine Auszählung 
bzw. Überprüfung und erfordert ein statistisches Verfahren zur Ermittlung der Genauigkeit. Es geht da-
bei darum, anhand einer Stichprobe zu überprüfen, ob die vom Dienstleister behauptete Erkennungsquo-
te stimmt, wobei man die Wahrscheinlichkeit für einen eigenen Irrtum möglichst gering halten möchte. 
Das ist ein sog. Bernoulli-Experiment, und die zugehörige diskrete Verteilung ist die Binominalvertei-
lung. Dafür gibt es einige markante „Grenzen“ in Abhängigkeit von Stichprobengröße und akzeptierter 
Irrtumswahrscheinlichkeit. 
 Beispiel: Ein Anbieter behauptet, dass seine Software mindestens 90% der Zeichen korrekt erkennt. 
Wenn man nun eine Stichprobe erhebt und darin exakt 90% der Zeichen korrekt erkannt werden, kann 
man nicht ohne weiteres davon ausgehen, dass die Aussage des Anbieters auch wirklich stimmt, denn 
jedes Ergebnis einer Stichprobe streut um den errechenbaren Mittelwert. Es könnte also durchaus sein, 
dass die Erkennungsquote bei 85% liegt und nur zufällig in der Stichprobe ein Ausreißer nach oben 
vorlag. Tatsächlich liegt die Wahrscheinlichkeit, dass diese Aussage zutrifft, bei lediglich 50%.
 Es erhebt sich nun die Frage, wie selten solche Ausreißer in Abhängigkeit von der Stichprobengröße 
sind, d. h. welche Irrtumswahrscheinlichkeit man bereit ist zu akzeptieren und welche Stichprobengrö-
ße mindestens einzuplanen ist, um ein akzeptables Ergebnis zu erlangen. Es leuchtet unmittelbar ein, 
dass die Irrtumswahrscheinlichkeit abnimmt, je größer die Stichprobe wird, jedoch möchte man die 
Stichprobe so klein wie möglich und nötig halten, um den Aufwand des Auszählens zu optimieren bzw. 
überhaupt einen pragmatischen Zugang zu einer soliden Abschätzung zu eröffnen. Dabei muss man eine 
plausible Balance finden zwischen akzeptierter Irrtumswahrscheinlichkeit und Größe der Stichprobe. 
 Da die Berechnung mathematisch kompliziert ist,126 seien im Folgenden mehrere Tabellen mit fest 
vorgegebenen Werten aufgeführt, die typische Angaben enthalten. Vorgeschlagen wird eine Stichpro-
bengröße von 500 beliebigen Zeichen, die idealerweise durch Benutzung eines Zufallsgenerators ausge-
wählt werden. Unter dieser Voraussetzung gilt folgende Tabelle. In der linken Spalte ist die behauptete 
Erkennungsquote angegeben, in der rechten die Zahl der in der Stichprobe mindestens korrekt erkannten 
Zeichen, die vorliegen muss, um die Behauptung des Dienstleisters bei einer Irrtumswahrscheinlichkeit 
von 2,5% als korrekt einstufen zu können. Wenn also ein Dienstleister behauptet, dass ein Text eine 
Genauigkeit von 96% hat, müssen in der Stichprobe von 500 Zeichen mindestens 489 Zeichen korrekt 
erkannt werden, damit bei einer Irrtumswahrscheinlichkeit von 2,5% die Behauptung des Dienstleisters 
akzeptiert werden kann. 
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126 Zur Binominalverteilung vgl. das Skript von Albers/Yanik: http://www.math.uni-bremen.de/didaktik/ma/ralbers/Veranstaltungen/Stochastik11/Material/
ScriptK7_110703.pdf [Stand: 02/2013]
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Behauptete Erkennungsquote Mindestzahl der korrekt erkannten Zeichen 
(Stichprobengröße = 500)

95% 485 (96,9%)
96% 489 (97,8%)
97% 493 (98,5%)
98% 496 (99,3%)
99% 499 (99,9%)

>99% 500 (100%)

Zum Vergleich eine Tabelle mit einer Stichprobengröße von 2.000 Zeichen:

Behauptete Erkennungsquote Mindestzahl der korrekt erkannten Zeichen 
(Stichprobengröße = 2000)

95% 1920 (96%)
96% 1938 (96,9%)
97% 1956 (97,8%)
98% 1972 (98,6%)
99% 1988 (99,4%)

>99% 2000 (100%)

Bei einer behaupteten Erkennungsquote von über 99% scheint es sinnvoll, ggf. die Stichprobengröße 
zu erhöhen. Nachstehend zwei Tabellen, die beispielhaft zeigen, wie hoch die ermittelte Erkennungs-
quote in Abhängigkeit von einer bestimmten Stichprobengröße sein muss, wenn Texte eine behauptete 
Erkennungsquote von 99,5% bzw. 99,7% haben. Die Irrtumswahrscheinlichkeit liegt jeweils bei 2,5%:

Behauptete Genauigkeit: 99,5%
Stichprobengröße Mindestzahl der korrekt erkannten Zeichen

500 500
1000 999
2000 1996
5000 4985
10000 9960

Behauptete Genauigkeit: 99,7%
Stichprobengröße Mindestzahl der korrekt erkannten Zeichen

500 500
1000 1000
2000 1998
5000 4995
10000 9990
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Abschließend eine Tabelle mit einer höheren Irrtumswahrscheinlichkeit von 5% statt 2,5%:

Behauptete Erkennungsquote Mindestzahl der korrekt erkannten Zeichen 
(Stichprobengröße = 2000)

95% 1916 (95,8%)
96% 1934 (96,7%)
97% 1952 (97,6%)
98% 1970 (98,5%)
99% 1988 (99,4%)
>99% 2000 (100%)

Die Frage, welche Irrtumswahrscheinlichkeit man sinnvollerweise zugrunde legt, kann nicht verbindlich 
beantwortet werden. Erfahrungswerte zeigen, dass 5% eine sinnvolle Größe darstellt, die nicht überschrit-
ten werden sollte. Da der Mehraufwand der Abschätzung bei 2,5% gegenüber 5% gering ist, sollte eine 
Irrtumswahrscheinlichkeit von  2,5% zugrunde gelegt werden, um ein verlässliches Ergebnis zu erhalten.
  Ein Excelsheet, mit dem man weitere Angaben durch Eingabe alternativer Parameter berechnen kann, 
findet sich auf der Projektseite der Herzog August Bibliothek.127 Eine Schwierigkeit besteht darin, ein 
pragmatisches Verfahren zur Auszählung zu finden. Zunächst muss die Stichprobe per Zufallsprinzip 
erhoben werden. Nutzen kann man dafür die in Programmiersprachen meist vorhandenen Zufallsge-
neratoren. Um echte Zufallszahlen128 zu generieren, lassen sich geeignete Webservices nutzen.129 Um 
die Auszählung zu erleichtern, entwickelt die Herzog August Bibliothek derzeit für die Messung von 
Genauigkeiten einen Webservice, der im zweiten Teil des Projekts, Helmstedter Drucke online II, zum 
Einsatz kommen soll.

8.8  ökonomische Betrachtungen

Die Kosten für die Konversion einer Seite können beträchtlich schwanken. Bei der Nutzung von Stan-
dard-OCR-Software liegen die sächlichen Kosten nur in der Beschaffung der Software. Die Personal-
kosten für die Auswahl, Vorbereitung und Prozessverwaltung müssen jedoch berücksichtigt werden. 
Gerade bei Massenkonversionsprozessen ist die Etablierung fester Workflows wichtig und der Einsatz 
von leistungsfähiger Hardware, denn der OCR-Prozess ist sehr rechenintensiv und daher bei schlechter 
Hardwareausstattung sehr zeitaufwendig und mit Kosten verbunden. Insofern ist es eine irrige Annah-
me, man könne mit Standardsoftware nahezu kostenneutral arbeiten. 
 Dies vorangeschickt, ist an dieser Stelle die grundsätzliche Frage zu stellen, welche Qualität erforder-
lich ist und wie viel sie kosten darf. Denn ohne eine Qualitätsanforderung zu stellen, sind auch differen-
zierte ökonomische Betrachtungen wertlos; die Entscheidung wäre dann einfach und müsste immer für 
die günstigste Variante ausfallen. Wenn aber die günstigste Variante nicht die Qualität zu liefern vermag, 
die mindestens erforderlich ist, dann ist das hier aufgewendete Geld schlicht verschwendet und selbst 
die günstigste Variante noch zu teuer. Sich diese wirtschaftlichen Gemeinplätze immer wieder zu ver-
gegenwärtigen und Aspekte von Effektivität und Effizienz in die Diskussion um die Qualität von OCR-
Software einzubringen, ist dringend erforderlich, wenn man realistische Szenarien für eine massenhafte 
Konversion von Drucken der Frühen Neuzeit in maschinenlesbare Texte entwickeln will.
 Den Ausgang für solche Überlegungen sollte man bei einer Festlegung der Zwecke nehmen, für die 
maschinenlesbare Texte verwendet werden sollen und für die bestimmte Qualitäten notwendig sind. 

127 Siehe: http://www.hab.de/de/home/wissenschaft/projekte/helmstedter-drucke-online.html [Stand: 02/2013]
128 http://de.wikipedia.org/wiki/Zufallszahl [Stand: 02/2013]
129 Z. B. https://www.random.org/ [Stand: 02/2013]
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Leider gibt es bislang hierzu in der wissenschaftlichen community keine normativen Aussagen. Sicher 
kann man davon ausgehen, dass ein wissenschaftlich brauchbarer Text, also ein Text der sowohl als 
Lesefassung als auch für zuverlässige Recherchen ex silentio130  taugt, eine Genauigkeit von mindestens 
99,95%131 besitzen muss, d. h. man nimmt pro Seite im Schnitt etwa 1-2 Buchstabenfehler in Kauf. Texte 
dieser Güte lassen sich für Materialien der Handpressenzeit (15. Jh. bis 18. Jh.) derzeit nur durch Ab-
schreiben (double keying) erreichen. Die Kosten schwanken zwischen 1,20 und 2,20 € pro Seite, wobei 
ggf. weitere Dienstleistungen wie die XML-Grundkodierungen der Dokumente hinzukommen. Ginge 
man davon aus, dass z. B. im 17. Jh. etwa 200.000 Drucke konvertiert werden sollten und legte man eine 
Durchschnittszahl von 140 Seiten zugrunde,132 müssten für die 28 Mio Seiten mindestens 33,6 Mio Euro 
aufgewendet werden. Selbst wenn eine solche Qualität wünschbar wäre, scheint sie doch angesichts der 
hohen Kosten unrealistisch, ja nicht einmal nötig, da man bei ausgewählten Materalien auch mit einer 
geringeren Qualität arbeiten könnte. Doch welche Qualität ist ausreichend?
 Standard-OCR-Software führt, wie man weiss, bei Materialien der Frühen Neuzeit zu hohen Fehler-
quoten und die Qualität sinkt bei den hier betrachteten Materialien deutlich unter den Wert, den man 
nach der Münchner Skala als „schlecht” bezeichnen könnte. Da es im Bereich des „Schlechten” aber 
durchaus noch einen Bereich des „Nützlichen” gibt, bleibt diese Qualifizierung abhängig von der Frage, 
welchen Gebrauch man von dieserart Texten machen möchte. Auch Aspekte der nachträglichen Verbes-
serungen (semantische Analyse, Wörtbücher, crowdsourcing) stehen unter diesem Vorbehalt.133 Darauf 
nach dem derzeitigen Stand des Wissens eine angemessene und für alle wissenschaftlichen Felder glei-
chermaßen zufriedenstellende Antwort zu finden, dürfte schwer fallen. Dennoch kann man Tendenzen 
feststellen, die zumindest eine grobe Orientierung bieten.
 Klammert man editorische Ansprüche aus, die eigene Anforderungen mitbringen,134 dürfte der maß-
gebliche Gebrauch, der von Volltexten in wissenschaftlichem Kontext gemacht wird, die Suche sein. 
Demgegenüber scheint die Lesbarkeit eines Texts minder wichtig, zumindest dann, wenn die Alignie-
rung des digitalen Faksimiles mit dem Volltext gewährleistet ist. Das digitale Faksimile übernimmt 
hierbei die Funktion der Lesefassung. Ein in den Geisteswissenschaften noch wenig wahrgenommener 
Nutzen liegt in quantitativen Analyseverfahren und der semantischen Verarbeitung maschinenlesbarer 
Texte, die innerhalb der voranschreitenden digital humanities entwickelt werden. Auch diese bringen 
einen eigenen Qualitätsanspruch mit. 
 Wenn man die Suche als das derzeit wichtigste Instrument herausgreift und fragt, welche Textgüte 
einer wissenschaftlichen Anforderung genügt, lassen sich zwei Typen von hauptsächlichen Suchver-
fahren unterscheiden, nämlich phraseologische und Suchen nach Entitäten oder Stichwörtern. Phra-
seologische Suchen nach bestimmten sprachlichen, aus mehreren Wörtern bzw. aus längeren Phrasen 
bestehenden Textteilen können bei einer Qualität, die nicht bei 99,95% liegt, vermutlich nicht sinnvoll 
durchgeführt werden oder die Ergebnisse sind stark zufallsbehaftet. Anders liegt der Fall bei Suchen 
nach Entitäten oder einzelnen Stichwörtern. Das ist auch typischerweise das, was Forscher bei Google 
und ähnlichen Suchmaschinen suchen. Entitäten- oder in einem weiteren Sinn Einwortsuchen – sind 
auch in Texten möglich, die man als „schlecht” bezeichnen könnte, indem das gesuchte Wort „zufällig” 
richtig erkannt wurde. Allerdings lauern hier Gefahren der Fehleinschätzung des Suchergebnisses. Die 
Wahrscheinlichkeit bei Texten der Frühen Neuzeit einen Treffer zu erzielen, ist bei handelsüblicher 
Software stark eingeschränkt, denn eine Erkennungsgüte von unter 90%, die hier nicht untypisch ist, 
bedeutet, dass ca. jedes vierte Wort falsch ist. Das klingt zunächst nicht dramatisch, weil es ja auch be-
deutet, dass drei Wörter richtig sind und man z. B. einen Namen sehr wohl finden könnte, jedoch muss 
man in Betracht ziehen, dass diese Fehler sich nicht statistisch antizipieren lassen und möglicherweise 
nur „uninteressante” Wörter korrekt sind. Problematisch in Texten der Frühen Neuzeit sind Mischtexte, 
in denen bei dieserart Software nur Antiqua oder nur Fraktur korrekt erkannt werden, so dass gerade die 

130 D. h. dass man ein negatives Rechercheergebnis so werten kann, dass ein bestimmter Begriff nicht vorkommt.
131 Hier und im Folgenden ist von Buchstabengenauigkeit die Rede.
132 Vgl. Anm. 118
133 Vgl. dazu die Ergebnisse des IMPACT Projekts (http://www.digitisation.eu/) [Stand: 02/2013]
134 Zu den Wünschen von Nutzern, die an eine elektronische Edition gestellt werden, vgl. Sören A. Steding, Computer-based scholarly editions : context, concept, 

creation, clientele. Berlin 2002, S. 234.
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interessierenden deutschen oder lateinischen Namensformen nicht gefunden werden. Beide Umstände 
lassen die Wahrscheinlichkeit eines Treffers mit handelsüblicher Software weiter sinken. Die Gefahr der 
Fehleinschätzung des Suchergebnisses besteht darin, dass der Suchende entweder glaubt, dass ein Text 
einen Namen nur singulär nennt, wo er in Wahrheit allgegenwärtig ist, oder er meint, dass bei einem 
negativen Resultat der Name, wenn er vorkommt, doch nur selten vorkommt, denn andernfalls hätte 
man ihn doch wenigstens einmal finden müssen. Um diese Effekte abzufedern, hilft die Forderung der 
Praxisregeln der DFG, schmutziges OCR nicht zu verbergen, weil sichtbar wird, wie gut oder schlecht 
der Text tatsächlich ist, doch kann sie dieserart Fehleinschätzungen nicht grundsätzlich verhindern bzw. 
der Suchende kann eigentlich nie zuverlässig davon ausgehen, dass das, was ihm als Ergebnis vorliegt, 
tatsächlich so zu interpretieren ist, wie es sich zeigt. Mit anderen Worten, der Fund ist eigentlich nutzlos 
oder nur in einem sehr oberflächlichen Sinne hilfreich, indem man argumentiert, dass es immer besser 
ist, etwas zu haben, als nichts. 

Zusammenfassend scheint daher, dass der Nutzen einer wissenschaftlich motivierten Volltextsuche mit 
schmutzigem OCR oder „schlechtem Text” (< 90% nach der Münchner Skala) gering bzw. sogar frag-
würdig ist, weil es nahezu unmöglich ist, Treffer zu kontextualisieren und korrekt zu bewerten, – wenn 
man sich nicht die Mühe macht oder aus zeitlichen Gründen machen kann, das Dokument, aus dem der 
Fund stammt, zu lesen. Positive Treffer bleiben zufällig und das Risiko der Fehlinterpretation ist hoch, 
auch wenn natürlich ein Tauchgang die eine oder andere Perle zutage zu fördern vermag. Angesichts 
dieser Grundüberlegungen scheint die Bereitstellung von Volltext frühneuzeitlicher Texte unterhalb ei-
nes bestimmten Qualitätsniveaus als nicht sinnvoll, zumindest für den Bereich der direkten Suche.  Sta-
tistische oder probabilistische Verfahren, wie sie sich mit Konzepten aus den digital humanities verbin-
den (z. B. Google ngram Viewer), folgen dabei anderen Gesetzmäßigkeiten, weil hier Mängel im Detail 
durch statistische Masse ausgeglichen werden. Welche Qualität in dieserart quantitativen Projekten 
ausreichend ist, liesse sich mit Hilfe statistischer Verfahren sicher ermitteln, möglicherweise wäre ein 
Nutzen auch noch bei „schlechten” Texten gegeben. Erfahrungen geschweige denn Studien dazu gibt es 
bisher kaum, so dass an dieser Stelle nicht näher darauf eingegangen werden kann.

Obzwar deutlich scheint, dass eine Qualität unterhalb von 90% für die Suche unzureichend ist, bleibt 
schwer zu entscheiden, welche Qualität für welche Zwecke zwischen 90% und 99,95% benötigt wird 
und welche Kosten angemessen sind. Mit den von B.I.T. Tomasi nach händischen Ermittlungsmetho-
den erhobenen 96% ist sicher ein sinnvolles Mittelmaß zwischen Qualitätsanspruch und bereitgestellter 
Menge für wissenschaftliche Zwecke erreicht, die preislich etwa in der Mitte zwischen einer Standard-
OCR-Lösung135 und einer händischen Transkription liegt. In der Projektplanung kommt es also darauf 
an zu entscheiden, ob man Texte im Umfang mit einer Qualität von 96% oder alternativ weniger Texte 
im Umfang von ca. 1/3 auf einem sehr hohen Niveau per händischer Abschrift zur Verfügung stellt. 
Im Falle der Helmstedter Drucke, bei denen es sich überwiegend um serielles Material (serielles Uni-
versitätsschrifttum mit rekursiven Phänomenen) handelt, wäre eine solche Umfangsreduktion nicht zu 
rechtfertigen, mag es auch in anderen Fällen, z. B. herausragende Lexika, literaturwissenschaftlich oder 
historisch zentrale Werke u.ä., unabweislich erforderlich sein. Hier muss gelten, das richtige, meint effi-
zienteste Werkzeug zu gebrauchen, wo also Kosten und Nutzen miteinander in Einklang stehen. Dieser 
Mittelweg scheint mit der formulierten Qualitätsanforderung und dem hier verfolgten Konversionsver-
fahren gefunden worden zu sein, auch wenn perspektivisch die Kosten für das Verfahren noch sinken 
müssen, wenn es in noch größerem Maße wirtschaftlich eingesetzt werden soll.

135 Vgl. z. B. das Angebot der VZG in Göttingen: http://www.gbv.de/Verbundzentrale/serviceangebote/ocr-service-der-vzg [Stand: 02/2013]
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